Conversion Guide for SAP S/4HANA, on-premise edition 1511
Feature Package Stack 01
## Document History

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>2016-07-19</td>
<td>Minor corrections</td>
</tr>
<tr>
<td>1.0</td>
<td>2016-02-03</td>
<td>First published version</td>
</tr>
</tbody>
</table>
Content

1  Conversion Guide for SAP S/4HANA, on-premise edition 1511 ........................................ 5

2  Getting Started .................................................. 6
2.1  SAP S/4HANA, on-premise edition ...................................................... 6
2.2  Overview of the Conversion Process .................................................. 6
2.3  Documentation and SAP Notes for the Conversion ................................. 7

3  PlanningReview the Simplification List ....................................................... 9
3.1  Check the Start Releases ................................................................. 14
3.2  System Requirements ................................................................. 14
3.3  What’s the Impact on Your System Landscape? ................................ 14
3.4  Data Volume Reduction ............................................................... 15

4  Conversion Process .................................................................................. 17
4.1  Maintenance Planner ................................................................. 18
      Handling of Business Functions, Industry Solutions, and Add-Ons .......... 18
4.2  Pre-Checks .................................................................................... 19
4.3  Custom Code Check ................................................................. 20
4.4  Software Update Manager (SUM) .................................................. 21

5  Preparing the Conversion ........................................................................ 22
5.1  Cross-Application Preparations ......................................................... 22
      Prepare Use of Maintenance Planner .................................................. 22
      Remove Client O66 ....................................................................... 23
      Uninstall SAP Fiori Apps .............................................................. 23
5.2  Enterprise Technology ....................................................................... 24
      Application Lifecycle Management .................................................. 24
      Information Governance ............................................................... 24
5.3  Finance ............................................................................................ 32
      Migration to SAP S/4 HANA Finance ........................................... 32
5.4  Sales ............................................................................................... 62
      Order and Contract Management .................................................... 62
5.5  Supply Chain .................................................................................... 69
      Efficient Logistics and Order Fulfillment .......................................... 69
5.6  Environment, Health, and Safety ....................................................... 70
      Conversion from Component Extension for SAP EHS Management ...... 70
      Conversion from EHS Management as part of SAP ERP .................. 70
5.7  Product Safety and Stewardship for Process Industries ........................ 71
5.8  Business Network Integration .......................................................... 72
      Conversion from Ariba Network Integration for SAP Business Suite ..... 72

6  Performing Follow-Up Activities ............................................................... 73
6.1  Cross-Application Follow-Up Activities .............................................. 73
      Adapting Database Extensions to SAP S/4HANA .............................. 73
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.2 Finance</td>
<td>74</td>
</tr>
<tr>
<td>Data Migration</td>
<td>74</td>
</tr>
<tr>
<td>Activities to be Executed After the Migration</td>
<td>114</td>
</tr>
<tr>
<td>SAP Credit Management: Migrate Data</td>
<td>116</td>
</tr>
<tr>
<td>SAP Cash Management: Migrate Data</td>
<td>117</td>
</tr>
<tr>
<td>6.3 Sales</td>
<td>125</td>
</tr>
<tr>
<td>Order and Contract Management</td>
<td>125</td>
</tr>
<tr>
<td>6.4 Sourcing and Procurement</td>
<td>128</td>
</tr>
<tr>
<td>Activities in Purchasing</td>
<td>128</td>
</tr>
<tr>
<td>6.5 Environment, Health, and Safety</td>
<td>129</td>
</tr>
<tr>
<td>Activities After Converting to Incident Management</td>
<td>129</td>
</tr>
<tr>
<td>Activities After Converting to Health and Safety Management</td>
<td>134</td>
</tr>
<tr>
<td>6.6 Product Safety and Stewardship</td>
<td>140</td>
</tr>
<tr>
<td>Activities After Converting Product Compliance</td>
<td>140</td>
</tr>
<tr>
<td>Activities After Converting Product Safety and Stewardship for Process Industries</td>
<td>144</td>
</tr>
<tr>
<td>6.7 Business Network Integration</td>
<td>145</td>
</tr>
<tr>
<td>Activities After Converting Ariba Network Integration</td>
<td>145</td>
</tr>
</tbody>
</table>
1 Conversion Guide for SAP S/4HANA, on-premise edition 1511

As an SAP Business Suite customer you can move from different start releases to SAP S/4HANA, on-premise edition. For certain start releases, a one-step procedure is available, which includes the installation of the SAP S/4HANA Core and, if necessary, the migration of the database to SAP HANA.

As part of the move to SAP S/4HANA, on-premise edition, you have to adapt your implemented solution to comply with the scope and data structures of SAP S/4HANA. For example, you have to adapt your custom code, or you have to migrate data to comply with new data models.

What is this guide about?

This document guides you through the conversion to SAP Business Suite 4 SAP HANA, on-premise edition (SAP S/4HANA). You will find information about the overall conversion process, the tools that support you, and the main manual activities.

What other documents do you need?

Other relevant documentation includes the Software Update Manager (SUM) guide and the Maintenance Planner guide. Please see Required Documentation [page 7] for a list of guides and SAP Notes relevant for the conversion.

Note

2 Getting Started

2.1 SAP S/4 HANA, on-premise edition

SAP S/4HANA, on-premise edition is a new product and builds the next-generation business suite. It is fully built on the most advanced in-memory platform today – SAP HANA – and modern design principles with the SAP Fiori user experience (UX) and a new role based user experience concept. With the move to SAP S/4HANA, the customer is on a road to continuous application innovation like:

- Re-architecting for SAP HANA in-memory platform
  With SAP S/4HANA we optimized the application to leverage the capabilities of SAP HANA database, we removed aggregates, and reduced the data footprint.
- Responsive user experience design
  With SAP S/4HANA, we designed the application with the most modern role-based user experience (UX).
- Unifying functionality in core
  With SAP S/4HANA we follow the principle of one. The basic design principle for SAP S/4HANA is to provide one functionality for one objective and thus preventing any redundant functionality.
- Platform for innovations
  With SAP S/4HANA we help businesses run simple in the digital economy (Internet of Things, Big Data, business networks, and mobile-first).

SAP S/4HANA, on-premise edition delivers the core functionality across end-to-end processes such as order to cash, plan to product, procure to pay, as well as the transformational simplifications delivered with SAP S/4HANA Finance (SAP Accounting). You can refer to it as an enterprise resource planning solution.

To allow customers to plan and estimate their way to SAP S/4HANA, we have created the Simplification List for SAP S/4HANA, on-premise edition 1511. In this list, we are describing in detail on a functional level what happens in SAP S/4HANA to individual transactions and solution capabilities.

More Information

Review the Simplification List [page 0 ]

2.2 Overview of the Conversion Process

Planning

Before deciding to convert your system to SAP S/4HANA, there are steps you can take to ensure you know what the conversion entails.

System Requirements

You need to be aware of system requirements. For more information, see System Requirements [page 14].
System Landscape
You need to be aware of system landscape adaptations. For more information, see What’s the Impact on Your System Landscape? [page 14]

Start Releases and Conversion Paths
You also need to know if your current SAP system is suitable for conversion. To see which start releases are suitable, see Start Releases and Conversion Paths [page 14].

Conversion Process
Once you have completed your high-level planning, you are aware of the various system requirements and adaptations. SAP also provides other tools to help quantify the effort required to convert to SAP S/4HANA. These tools are described in the Conversion Process [page 17] chapter.

Maintenance Planner
You need to run the maintenance planner tool as a first step in the conversion process. For more information, see Maintenance Planner [page 18].

Pre-Checks
You need to ensure your system is compatible with S/4HANA. SAP provides a series of pre-checks to help identify the steps you need to take. For more information, see Pre-Checks [page 19].

Custom Code Check
You need to check your custom code to ensure it works with S/4HANA. SAP has provided the simplification list concept to check your custom code against a set of SAP S/4HANA simplifications. For more information about this, see Custom Code Check [page 20].

Software Update Manager (SUM)
When you have completed the above steps and implemented all the adaptations required to ensure your system and your custom code is suited to SAP S/4HANA, you then run the SUM. For more information, see Software Update Manager (SUM) [page 21].

There are other manual activities that may be required too. These and other application-specific preparations and post-conversion activities are described at the end of this guide.

2.3 Documentation and SAP Notes for the Conversion

Required Documents and SAP Notes
You require at least the following documents and SAP Notes.

Table 2

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversion of SAP Systems to SAP S/4HANA, on-premise edition Using Software Update Manager 1.0 SP15</td>
<td>service.sap.com/sitoolset</td>
<td>Describes how to prepare the system for running the Software Update Manager, how to use it, and what general follow-up steps are required.</td>
</tr>
</tbody>
</table>
### Additional Documents and SAP Notes

The following table lists important additional documents and SAP Notes. Further documents and SAP Notes are referenced in the sections of this guide where needed.

**Table 3**

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyzing Custom Code Related to SAP Changes Specified in The Simplification Database</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td>Describes how you can check your custom code for required adaptations.</td>
</tr>
<tr>
<td><strong>SAP S/4HANA Simplification List</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
<tr>
<td><strong>SAP S/4HANA, on-premise edition 1511: Compatible Add-ons</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
</tbody>
</table>

**Additional Documents and SAP Notes**

The following table lists important additional documents and SAP Notes. Further documents and SAP Notes are referenced in the sections of this guide where needed.

**Table 3**

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyzing Custom Code Related to SAP Changes Specified in The Simplification Database</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td>Describes how you can check your custom code for required adaptations.</td>
</tr>
<tr>
<td><strong>SAP S/4HANA Simplification List</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
<tr>
<td><strong>SAP S/4HANA, on-premise edition 1511: Compatible Add-ons</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
</tbody>
</table>

**Additional Documents and SAP Notes**

The following table lists important additional documents and SAP Notes. Further documents and SAP Notes are referenced in the sections of this guide where needed.

**Table 3**

<table>
<thead>
<tr>
<th>Document</th>
<th>Available at</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analyzing Custom Code Related to SAP Changes Specified in The Simplification Database</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td>Describes how you can check your custom code for required adaptations.</td>
</tr>
<tr>
<td><strong>SAP S/4HANA Simplification List</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
<tr>
<td><strong>SAP S/4HANA, on-premise edition 1511: Compatible Add-ons</strong></td>
<td>help.sap.com/s4hana_op_1511_001</td>
<td></td>
</tr>
</tbody>
</table>
3 Planning

Review the Simplification List

For the conversion to SAP S/4HANA you have to prepare an overall project plan and schedule the tasks. The following planning activities give you an idea of what is involved.

In addition, review the planning section of the Software Update Manager guide Conversion of SAP Systems to SAP S/4HANA, on-premise edition, Using Software Update Manager 1.0 SP15.

Note

For the conversion to SAP S/4HANA you have to prepare an overall project plan and schedule the tasks. The following planning activities give you an idea of what is involved.

In addition, review the planning section of the Software Update Manager guide Conversion of SAP Systems to SAP S/4HANA, on-premise edition, Using Software Update Manager 1.0 SP15.

The simplification list is a collection of single simplification items. It provides the key information by application or functional area about the simplifications in SAP S/4HANA, on-premise edition. Each simplification item details the steps that need to be taken from a business and a technical point of view.

The simplification list is integrated with the custom code check tool. This tool provides a detailed report about where the custom code on your SAP Business Suite system does not comply with the scope and data structures of SAP S/4HANA.

Review the simplification list to identify the areas for which you have to take actions and to create an overall conversion project plan.

You can access the simplification list at help.sap.com/s4hana_op_1511_001.

The following tables provides an overview of the most significant simplification items which have a huge impact for customers converting to SAP S/4HANA. Of course, depending on the scenarios you use, other simplification items might be of larger importance for your system.

Table 4

<table>
<thead>
<tr>
<th>Application Area</th>
<th>Simplification Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financials</td>
<td>Simplified Data Model in SAP S/4HANA Financials</td>
<td>With SAP S/4HANA, on-premise edition identically-named DDL SQL views (compatibility views) replace totals and application index tables in Finance. These views are generated from DDL sources. The replacement takes place during the conversion using SUM. Related data is saved to backup tables. The compatibility views ensure that database SELECTs still work. However, write access (INSERT, UPDATE, DELETE, MODIFY) was removed from SAP standard, or has to be removed</td>
</tr>
<tr>
<td>Application Area</td>
<td>Simplification Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from custom code. For more information, see SAP Note 1976487.</td>
</tr>
<tr>
<td>Asset Accounting</td>
<td>Asset Accounting</td>
<td>Asset Accounting is based on the universal journal entry. General Ledger Accounting and Asset Accounting are therefore reconciled per se. Data structures in Asset Accounting have been adapted accordingly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Controlling</td>
<td>Profit and Loss Planning and Profit Center Planning</td>
<td>CO-OM planning, profit and loss planning, and profit center planning are now covered by Integrated Business Planning. For more information, see SAP Note 2081400.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Controlling</td>
<td>Transfer Prices/ Parallel Delta Versions</td>
<td>With the merge of FI and CO into the Universal Journal a new approach for parallel valuations has been implemented. Existing solutions based on parallel delta versions for actuals in Controlling have to be adapted.</td>
</tr>
<tr>
<td>Cash Management</td>
<td>Cash Management</td>
<td>Classic Cash Management is replaced by the new SAP Cash Management powered by SAP HANA. If you used the classical Cash Management and convert to SAP S/4HANA, on-premise edition, you need to activate the new SAP Cash Management. For a more information, see SAP Note 2149337.</td>
</tr>
<tr>
<td>Master Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business Partner</td>
<td>Business Partner</td>
<td>The Business Partner approach is mandatory in SAP S/4HANA. The Business Partner is now capable of centrally managing master data for business partners, customers, and vendors. With current development, the Business Partner is the single point of entry to create, edit, and display master data for business partners, customers, and vendors.</td>
</tr>
<tr>
<td>Product Master</td>
<td>MRP in Material Master</td>
<td>The MRP functionality has been optimized for Material Master in SAP S/4HANA for simplification purposes. For more information, see SAP Note 2224371.</td>
</tr>
<tr>
<td>Application Area</td>
<td>Simplification Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Logistics</strong></td>
<td><strong>MM-IM - Inventory Management</strong></td>
<td><strong>Simplified inventory management data model</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Significant changes of the data model. The new de-normalized table MATDOC has been introduced which contains the former header and item data of a material document as well as a range of other attributes. Material document data is stored in MATDOC only. Actual stock quantity data will be calculated on-the-fly from the new material document table MATDOC for which some of those additional special fields are used. Adoption effort on DDIC level for customer appends and coding adjustments for performance critical parts may be required.</strong></td>
</tr>
<tr>
<td><strong>MM-IM - Inventory Management</strong></td>
<td><strong>Material Valuation</strong></td>
<td><strong>To achieve a significant increase of transactional data throughput for goods movements, we recommend to deactivate the statistical moving average.</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>⚠️ Caution</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>The deactivation is not reversible.</strong> <strong>The deactivation of the statistical moving average is the consequence of a new lock behavior for materials with price control “Standard”</strong></td>
</tr>
<tr>
<td><strong>PLM - Product Lifecycle Management</strong></td>
<td><strong>BOM, Routing, and Production Version</strong></td>
<td><strong>Only BOMs with valid production version are considered during BOM explosion. Therefore, it is mandatory for manufacturing BOMs to maintain the product version for correct BOM explosion. For all BOMs in the system, we recommend to maintain product versions using the report Product Version Migration for BOM (transaction code CS_BOM_PRODVER_MIGRATION).</strong></td>
</tr>
<tr>
<td><strong>QM - Quality Management</strong></td>
<td><strong>ITS services for results recording, quality notifications, and quality certificates</strong></td>
<td><strong>The ITS services for the Internet Application Components (IAC) in QM are not available SAP S/4HANA, on-premise edition 1511. Instead, use the corresponding QM transactions in</strong></td>
</tr>
<tr>
<td>Application Area</td>
<td>Simplification Item</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SAP GUI for HTML, or use the Web Dynpro applications, which are part of the PFCG role for NWBC Quality Inspector (SAP_SR_QUALITY_INSPECT_5).</td>
</tr>
<tr>
<td>PP - Production Planning</td>
<td>Process Control Messages</td>
<td>These functions will be consolidated. Once the successor functions are available, these transaction codes will be replaced in a future release.</td>
</tr>
<tr>
<td>Procurement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Co-Deployment with SAP Supplier Relationship Management</td>
<td>If you run SAP SRM and SAP Business Suite on one server, you cannot convert your system to SAP S/4HANA. It is not possible to install the SAP SRM software components within the SAP S/4HANA stack. Accordingly, the related conversion pre-check prevents such systems from being converted. If you run SAP SRM and SAP Business Suite on separate servers, you can continue to integrate SAP SRM with the converted SAP S/4HANA system. For more information, see SAP Notes 2241931 and 2229738.</td>
</tr>
<tr>
<td>DIMP</td>
<td>Long Material Number</td>
<td>The industry solution for long material numbers has been replaced by a native long material number in SAP S/4HANA. That replacement has a technical impact, no business impact.</td>
</tr>
<tr>
<td>General</td>
<td>DIMP added to the core</td>
<td>Migration of software component ECC-DIMP to S/4 HANA</td>
</tr>
<tr>
<td>Sales and Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analytics</td>
<td>Logistics Information System (LO-LIS) for Analytics</td>
<td>Simplification in SD analytics follows the overall analytics strategy in SAP S/4 HANA. Instead of prebuilt aggregates and redundant data for analytical purposes, the SAP S/4HANA Analytics approach is based on ODATA and Open CDS (ABAP-managed CDS = Core Data Services) directly on top of the original database. Corresponding analytics</td>
</tr>
<tr>
<td>Application Area</td>
<td>Simplification Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>content will be provided within SAP S/4HANA.</td>
</tr>
<tr>
<td>Foreign Trade</td>
<td>Foreign Trade process covered by SAP GTS</td>
<td>With SAP S/4HANA on-premise edition 1511, the business requirements for foreign trade are covered by SAP Global Trade Services (GTS). SAP GTS can be natively integrated with S/4HANA.</td>
</tr>
<tr>
<td>Commodity Management</td>
<td>Commodity Management Sales</td>
<td>If Commodity Business Functions are active in your system, you cannot convert the system to SAP S/4HANA. A conversion pre-check will check the use of these Business Functions and prevent the conversion if they are active.</td>
</tr>
<tr>
<td>Billing Output Management</td>
<td>Simplified output management in SD Billing</td>
<td>With SAP S/4HANA a new output management approach is in place. The target architecture is based on Adobe Document Server and Adobe Forms only. Billing documents that are migrated from legacy systems and for which NAST based output have been determined, can be processed with this technology. For all new billing documents the new output management is used. Therefore, in the area billing / customer invoice you need to adapt the configuration settings related to output management.</td>
</tr>
<tr>
<td>Contract Billing</td>
<td>Contract Billing</td>
<td>Contract Billing is not available in SAP S/4HANA, on-premise edition 1511. If you used Contract Billing in SAP ERP and plan to move to SAP S/4HANA, you have to remodel your business processes.</td>
</tr>
</tbody>
</table>

**More Information**

Custom Code Check [page 20]
3.1 Check the Start Releases

For a one-step conversion, your system needs to have a minimum release level. The following start releases are supported:

- SAP ERP 6.0, EHP 0-7
- SAP Business Suite powered by SAP HANA
- SAP Simple Finance, on-premise edition 1503
- SAP Simple Finance Add-On 1.0 for SAP Business Suite powered by SAP HANA

Not all start releases might be initially supported. See SAP Note 2233962 for an up-to-date list of supported start releases.

3.2 System Requirements

Unicode

As a prerequisite for the conversion, your system needs to be a Unicode system. If your system is still non-Unicode, you can follow a two-step conversion approach: First, perform a combined upgrade and Unicode conversion with one of the supported start releases as target, then perform the S/4HANA conversion.

AS ABAP only

Your system has to be an AS ABAP only system. Dual-stack systems (AS ABAP and AS Java combined in one system) are not supported for the conversion. If your system is as dual-stack system, you have to split it prior to the conversion.

For information on how to perform a dual-stack split, see the following:

- SAP Note 1686144
- SAP Note 1655335

3.3 What's the Impact on Your System Landscape?

When you convert your system to SAP S/4 HANA, you might have to adapt further systems or components in your system landscape.

SAP ERP Java Components

SAP ERP Java components are obsolete with SAP S/4HANA. You have to remove the technical Java system from the respective product system in the Landscape Management Database (LMDB).
SAP NetWeaver Java Instances

The following SAP NetWeaver Java instances are relevant for SAP S/4HANA, on-premise edition 1511:

- Adobe Document Services
- Enterprise Services Repository
- Advanced Adapter Engine Extended

These instances need to run on SAP NetWeaver 7.3 EHP1, or higher.

ESR Content: You have to apply the ESR content XI CONTENT S4CORE 100.

SAP Fiori Front-End Server

S/4HANA 1511 requires SAP NetWeaver 7.5 as front-end server.

You can use an existing front-end server (hub) for the SAP Fiori for S/4HANA 1511 installation. Existing apps continue to run against the old back-end systems while the newly installed applications of SAP Fiori for S/4HANA 1511 need to be configured to run against the S/4HANA on-premise system. As a prerequisite, you have to migrate the database of the central hub system (supported databases are SAP HANA, SAP MaxDB, or SAP ASE) and upgrade the system.

For more information, see the section Using an Existing Front-End Server (Hub Deployment) of the SAP S/4HANA UI Technology Guide available on SAP Help Portal at help.sap.com/s4hana_op_1511_001.

3.4 Data Volume Reduction

SAP Data Volume Management is designed to reduce the data footprint in order to benefit from shorter conversion duration due to reduced load size. Data Volume Management (DVM) offers various capabilities supporting the pre- and post SAP HANA conversion phases. One central tool is the SAP DVM Work Center (DVM WoC) in SAP Solution Manager offering tools with special focus on SAP HANA.

- Guided Self Service: Generate a best practice document to determine data that can be reduced most efficiently in an SAP system before the conversion. The same tool can be used after the conversion to develop a blueprint for DVM strategy.
- Reorganization & Compression: This tool can be used without a SAP HANA context in order to simulate the savings gained by reorganizing tables or databases or compressing the database.
- Furthermore the future system size of your system can be simulated. This is very beneficial to get a forecast of impact for the planned measures.

Beside the DVM Work Center, Data Volume Management offers services to provide transparency of your data distribution and quality as well as services helping you to develop a DVM road map for your system landscape or a set of systems. All services offer a huge level of flexibility for customers to decide about the content.

More Information

For general information about Data Volume Management, see SAP Community Network at wiki.scn.sap.com/wiki/display/TechOps/Data+Volume+Management.
4 Conversion Process

SAP provides a process for converting to SAP S/4 HANA, on-premise edition. There are several components and tools to help with this process. These are described below.

The following graphic gives an overview of the tools and the process.

**Figure 1: Conversion Process**

<table>
<thead>
<tr>
<th>Step</th>
<th>Name/Link</th>
<th>Description</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Maintenance Planner [page 18]</td>
<td>Checks your add-ons and business functions to ensure compatibility with S/4HANA. Also creates the stack file used for the actual conversion process</td>
<td>Yes</td>
</tr>
<tr>
<td>2.</td>
<td>Pre-Checks [page 19]</td>
<td>Identifies the steps you need to take to ensure your system is compatible with the conversion process</td>
<td>Yes</td>
</tr>
<tr>
<td>3.</td>
<td>Custom Code Check Tool [page 20]</td>
<td>Checks your custom code against a list of simplifications developed for S/4HANA. Ideally you perform these checks at the same time as your pre-checks</td>
<td>No - but highly recommended</td>
</tr>
<tr>
<td>4.</td>
<td>General [page 22] and Application-Specific Preparations [page 22]</td>
<td>Manual activities to prepare your system and applications</td>
<td>If required</td>
</tr>
<tr>
<td>5.</td>
<td>Software Update Manager (SUM) [page 21]</td>
<td>Automates the conversion process and deploys the S/4HANA software</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### 4.1 Maintenance Planner

#### Overview

Use of Maintenance Planner is mandatory for conversion to S/4 Hana. This step creates the download files (addons, packages, DBDs, Stack File – the input for SUM) that the Software Update Manager (SUM) uses to install SAP S/4HANA. Specifically, the Maintenance Planner checks the following:

- If the add-ons in the system are accepted for the conversion
- If Business Functions active in the system are accepted for conversion

It then creates the stack configuration file, which is used by SUM to convert to S/4HANA.

Also, the Maintenance Planner needs to performed before the pre-checks, because the pre-check report also requires the stack.xml file as an input.


#### 4.1.1 Handling of Business Functions, Industry Solutions, and Add-Ons

The Maintenance Planner checks the system with regards to business functions, industry solutions, and add-ons. If there is no valid path for the conversion (for example, the add-on is not released yet), the Maintenance Planner prevents the conversion.

### Business Functions

Business functions can have the following status: `always_on`, `customer_switchable`, and `always_off`. This results in the following behavior during the conversion:

- If a business function was switched on in the start release system, but defined as `always_off` in the SAP S/4HANA target release, then a system conversion is not possible with this release.
- If a business function was switched off in the start release system, but defined as `always_on` in the SAP S/4HANA target release, then the business function will be activated during the conversion.
- If a business function is defined as `customer_switchable` in the SAP S/4HANA target release, then it will keep the state defined in the target release during the conversion.

Industry Solutions

For information about supported industry solutions, see SAP Note 2214213.

Add-Ons

During the conversion, add-ons are either merged into SAP S/4Hana, or deleted if no successor is available. Some add-ons might be included but will not be fully functional.

For a list of supported add-ons, see SAP Note 2214409.

4.2 Pre-Checks

SAP supports the customer by providing pre-checks. These identify the steps you need to take to ensure your system is compatible with the conversion process.

Note

Perform these checks before starting the Software Update Manager (SUM).

Pre-checks are shipped as SAP Notes to customers that want to convert to S/4HANA. Customers can use these pre-checks to find out what mandatory steps they have to carry out before converting to S/4HANA. The results list the instances that need addressing before attempting the conversion process. The checks are run twice again during the conversion process: both times in the Software Update Manager (SUM). The conversion is stopped if errors persist.

Note

Some of the pre-check reports can have a long execution time.

Prerequisites

You must run the Maintenance Planner before running the pre-checks, because the pre-check report requires the stack.xml as an input.

How to Perform the Pre-Checks

SAP Note 2182725 and Related Notes

Implement SAP Note 2182725, and all the related notes attached to it.

Make sure to use latest version of this note and regularly check for updates of all attached notes.

Implement and run these reports on every system (Sandbox, DEV, QA, PROD) you want to convert to S/4HANA.

Report R_S4_PRE_TRANSITION_CHECKS
Run Report R_S4_PRE_TRANSITION_CHECKS with transaction SE38 or SA38 in client 000

- Perform the report using the option **Check Class Consistency Check**
  
  In case of missing check classes, open a ticket on the corresponding component for the check class mentioned in the error message. Otherwise, contact the add-on vendor.

- If all check classes exist, run the report with the option **S/4 Pre-Trans. Check Results** and provide the path to the stack.xml file. This has to be copied to the ABAP system, for example, to /usr/sap/<SID>/Download. Also, make sure to activate the Simulation Mode. You may create a variant to make starting subsequent checks easier.

  The overall check result return code must not be higher than 4. Otherwise the Software Update Manager (SUM) will not be able to perform the conversion of your system.

  In case of errors, follow the instructions in the messages. The instructions reference SAP Notes. In this way, resolve the issues until the check report results in a return code of 4 or less.

### 4.3 Custom Code Check

These checks are based on the Simplification list concept. S/4HANA simplifies business processes. Before converting to S/4HANA, you need to check your custom code against the S/4HANA simplifications in a SAP NetWeaver 7.5 system.

These simplifications are loaded into the Custom Code Check Tool. After you run the tool, you obtain a list of instances where your custom code does not comply with the scope and data structure of SAP S/4HANA 1511, on-premise edition.

**Note**

- Although it is not mandatory, it is highly recommended that you perform this check prior to beginning the conversion process.

- The current application content of the simplification database will grow and improve over time. In addition to the custom code analysis and adaptations based on the Custom Code Check Tool, you also need to test the custom code within SAP S/4HANA, on-premise edition 1511.

  As of SAP S/4HANA, on-premise edition 1511 SP00, there is simplification database content for the following application areas: Master Data, Sales & Distribution, Procurement, Logistics, Financials (limited), and Industry specific (Beverage, Automotive, Mill, and Public Sector).

4.4 Software Update Manager (SUM)

Overview

The Software Update Manager (SUM) is the SAP tool that is used to update software. It is the main tool used to convert your system to SAP S/4HANA, on-premise edition.

If your source system is not yet running on SAP HANA database, use the database migration option (DMO) of the Software Update Manager to migrate your database to SAP HANA during the conversion.

Prerequisites

You must run the Maintenance Planner before the SUM, because the SUM requires the stack.xml as an input.

More Information

For all information about using the SUM, please see the document Conversion of SAP Systems to SAP S/4HANA,, on-premise edition Using Software Update Manager 1.0 SP15 available at service.sap.com/sltoolset \n \n Software Logistics Toolset 1.0 \n Section "Documentation" \n System Maintenance \n
5 Preparing the Conversion

Prepare the conversion as described in the following sections. In addition, review the preparation section of the Software Update Manager guide Conversion of SAP Systems to SAP S/4HANA, on-premise edition. Using Software Update Manager 1.0 SP15 and perform the required steps described there.

You might need to do further preparations depending on the results of the pre-checks.

More Information

Pre-Checks [page 19]

5.1 Cross-Application Preparations

5.1.1 Prepare Use of Maintenance Planner

Context

Besides the general preparations described in the Maintenance Planner User Guide, you have to make the some preparations specific to the S/4HANA conversion.

Steps

2. Check the SPAM/ SAINT version in your source release system.
   SPAM/SAINT patch 59 is required.
3. Apply SAP Note 2186164 to your SAP Solution Manager system.
4. Create and RFC connection between your source release system and SAP Solution Manager:
   1. In SAP Solution Manager, choose SOLMAN_WORKCENTER Solution Manager Administration Landscape (Technical Systems).
   2. Click RFC connections Start New Window.
   3. Select client 000 and choose Advanced Mode.
   4. Under Export Options, fill in the field SAP Solution Manager Host Name.
   5. Under Communication RFCs, select Create SM_<SID>CLNT<CLNT>_READ.
   7. Enter a password.
8. Enter a user and password under **Managed System Setup Administrator**, and choose **Test Login** in the group **Administration Users** to check that it works.

**More Information**

Maintenance Planner [page 18]

### 5.1.2 Remove Client 066

**Context**

Client 066 is the Early Watch client which was set up during the installation of your system. This client is not used in SAP S/4HANA. To prevent issues, for example, with job scheduling, you have to remove it before you start the conversion.

**Steps**

1. To remove client 066, proceed as described in SAP Note 1749142.

### 5.1.3 Uninstall SAP Fiori Apps

**Context**

If you have SAP Fiori apps locally installed on your source system, you need to uninstall them if they are not released for USER INTERFACE TECHNOLOGY 7.50 (SAP_UI 7.5.0). If you do not uninstall these apps, Maintenance Planer will not allow a conversion for your system.

**Steps**

1. Check SAP Note 2034588 for a list of apps that you need to uninstall and the required steps. SAP Note 2200415 provides a list of all apps which are supported to run on SAP_UI 7.5.0.
2. Uninstall the apps using SAINT. For more information, see SAP Note 2011192.
5.2 Enterprise Technology

5.2.1 Application Lifecycle Management

5.2.1.1 Run Check Program for Material Number Extension

Context

This check is relevant for the extended material number handling. It is mandatory to run this check program in your existing SAP system before starting the conversion. Your data will be analyzed to make sure that all framework data is converted to the new structure. Customer defined tables and customer defined BOR types are also checked. The data in your system will not be changed. You will get a structured and classified result list which indicates whether you need to take action.

Steps

1. Run the check program as described in SAP Note 2216958 Check Program for Upgrade to S/4HANA for Material Number Extension: Find BOR Usage and Material Number Usage.

5.2.2 Information Governance

5.2.2.1 Pre-conversion Check for Material Master

Section Title, or delete.

The pre-conversion check class, CLS4H_CHECKS_MM_MD, performs the necessary checks to ensure that the setting are maintained correctly to ensure a smooth conversion to S/4HANA for material master data. In SAP S/4 HANA, on-premise edition 1511, the field KZEFF in table MARA is not available anymore. The current setting KZEFF is such that the field will be hidden only from the UI, but still continue to be available in the database. However, Assign effectivity parameter values/override change numbers (KZEFF) impacts the parameter effectivity in BOM maintenance. Hence, the value of this field needs to be reset from X to space to avoid adverse side effects.

For more information about pre conversion checks, see SAPNote 2207188 and SAPNote 2206932.

5.2.2.2 Introduce Business Partner Approach (Customer/Vendor Integration)

Only customers with customer/vendor integration in place can move to SAP S/4HANA, on-premise edition.
To ensure a successful conversion all customers and vendors should first convert into business partner. This is also true for the business partners, which are already in use. When the customer/vendor transformation process is triggered, the system posts all required fields into the business partner.

The customer/vendor transformation is bidirectional. You can process both customer/vendor master records from business partner maintenance, as well as maintain data from customer/vendor processing to the business partner.

Master data for vendor and customer is widely used within ERP and therefore, it is critical to ensure that customizing settings are maintained correctly to transform data completely during conversion without additional settings.

Related SAP Notes

Refer to the following main SAP Notes for information about Master Data for Business Partner:

- 2211312
- 2216176
- 1623677

To find more SAP Notes about Master Data for Business Partner searching for SAP Notes with the key words BP*CVI*.

5.2.2.2.1 Prepare Customizing and Mapping Tables for Business Partner Conversion

Context

Before the conversion to S/4HANA, ensure that the following settings are maintained correctly in the relevant Customizing and that the mapping tables are maintained.

Steps

1. Use report CVI_FS_CHECK_CUSTOMIZING to check the Customizing or use transaction SPRO to check the customizing manually (see below). For information about the report, see SAP Note 1623677. In addition, run the PRECHECK_UPGRADATION_REPORT which determines the mapping entries that are missing between CVI data and BP data, and missing Customizing entries. For information about this report, see SAP Note 2211312. For the customer transformation to business partner one number range has to be set as “Internal Standard Group”, otherwise the business partner is not created.

Manual Customizing in transaction SPRO:

2. Active Synchronization between Customer/Vendor and BP is active
   - Source Object Customer and Target Object BP must be active (Act.Ind equal true)
   - Source Object Vendor and Target Object BP must be active (Act.Ind equal true)
3. Active Creation of Postprocessing Orders for component AP-MD

1. Activate the Business Process CVI_01, Customer Business Partner
2. Activate the Business Process CVI_02, Vendor Business Partner

After the successful synchronization of data, you can also activate the Postprocess Orders for CVI_03 and CVI_04 for direction Business Partner Customer /Vendor.

4. Customer/Vendor number range and numeric numbers

- If the Customer/Vendor number range is already disjoint, we recommend that as a mirror image of the customer/vendor number range the business partner number range should be defined.
- If Customer/Vendor number range is not disjoint, we recommend that you maintain the business partner number range in such a way that the most numbers from customer/vendor can be reused.
- Customer/Vendor numeric numbers should be taken over to business partner

**Recommendation**

To allow the customer/vendor numeric numbers to be taken over to the business partner, the numeric intervals of the business partner number ranges must be set to external.

After the successful synchronization of data, the numeric intervals of the business partner must be changed back to internal. Additionally, the customer/vendor numeric number range must be set to external to allow identical numbers for customer/vendor and business partner.

Access and check the customer number range transaction by under the following customizing path:

<table>
<thead>
<tr>
<th>Customizing Path</th>
<th>Cross-Application Components &gt; General &gt; Business Partner &gt; Customers &gt; Control &gt; Define and Assign Customer Number Ranges</th>
</tr>
</thead>
</table>

Access and check the vendor number range transaction under the following customizing path:

<table>
<thead>
<tr>
<th>Customizing Path</th>
<th>Cross-Application Components &gt; Logistics &gt; General &gt; Vendor &gt; Customers &gt; Control &gt; Define Number Ranges for Vendor Master Records</th>
</tr>
</thead>
</table>

Access the business partner number range transaction under the following customizing path:

<table>
<thead>
<tr>
<th>Customizing Path</th>
<th>Cross-Application Components &gt; SAP &gt; BusinessPartner &gt; Business Partner &gt; Basic</th>
</tr>
</thead>
</table>
SAP recommends that you allocate for new business partners identical numbers when assigning numbers to customer/vendor and business partners. However, this is not possible in every case, for example, if SAP business partners already existed in the system prior to conversion and the number ranges overlap. For more information and an example, see Number Assignments.

Access the number range transaction under the following customizing path and the set the indicator **Same Numbers**:

**Table 11**

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components  &gt;  Master Data Synchronization  &gt;  Customer/Vendor Integration  &gt;  Business Partner Settings  &gt;  Settings for Customer Integration  &gt;  Assign Keys  &gt;  Define Number Assignment for Direction BP to Customer/Vendor</td>
</tr>
</tbody>
</table>

5. **Business Add-Ins (BAdIs)**

You can implement customer-specific mappings like Form of Address from Customer/Vendor to Business Partner using the available BAdIs. Here it would also be possible to create a Business Partner in a different category, for example, person instead of organization. In this case, you have to deactivate the enhancement CVI_MAP_TITLE_DIRECT and activate the enhancement implementation CVI_MAP_BP_CATEGORY in the IMG. The implementation is already available.

**Table 12**

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components  &gt;  Master Data Synchronization  &gt;  Customer/Vendor Integration  &gt;  Business Partner Settings  &gt;  Business Add-Ins (BAdIs)</td>
</tr>
<tr>
<td>- BAdI: Data Assignment BP  &gt;  Customer/Vendor/Contact Person</td>
</tr>
<tr>
<td>- BAdI: Data Assignment of Bank Details BP  &gt;  Customer/Vendor</td>
</tr>
<tr>
<td>- BAdI: Data Assignment of Payment Cards BP  &gt;  Customer</td>
</tr>
<tr>
<td>- BAdI: Data Assignment of Form of Address from Customer/Vendor to BP</td>
</tr>
<tr>
<td>- BAdI: Defaults for Creating Data from BP to Customer/Vendor</td>
</tr>
</tbody>
</table>

6. **BP roles are assigned to account groups**

**Table 13**

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components  &gt;  Master Data Synchronization  &gt;  Customer/Vendor Integration  &gt;  Business Partner Settings  &gt;  Settings for Vendor Integration  &gt;  Define BP Role for Direction Customer to BP</td>
</tr>
</tbody>
</table>
7. For every account group BP Grouping must be available

Table 14

<table>
<thead>
<tr>
<th>Customizing Path</th>
<th>For customer: [Cross-Application Components &gt; Master Data Synchronization &gt; Customer/Vendor Integration &gt; Business Partner Settings &gt; Settings for Customer Integration &gt; Field Assignment for Customer Integration &gt; Assign Keys &gt; Define Number Assignment for Direction Customer to BP]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For vendor: [Cross-Application Components &gt; Master Data Synchronization &gt; Customer/Vendor Integration &gt; Business Partner Settings &gt; Settings for Vendor Integration &gt; Field Assignment for Vendor Integration &gt; Assign Keys &gt; Define Number Assignment for Direction Vendor to BP]</td>
</tr>
</tbody>
</table>

8. For Customer Value Mapping

Table 15

<table>
<thead>
<tr>
<th>Customizing Path</th>
<th>[Cross-Application Components &gt; Master Data Synchronization &gt; Customer/Vendor Integration &gt; Business Partner Settings &gt; Settings for Customer Integration &gt; Field Assignment for Customer Integration &gt; Assign Attributes &gt; Contact Person]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Activate Assignment of Contact Persons</td>
</tr>
<tr>
<td></td>
<td>• Assign Department Numbers for Contact Person</td>
</tr>
<tr>
<td></td>
<td>• Assign Functions of Contact Person</td>
</tr>
<tr>
<td></td>
<td>• Assign Authority of Contact Person</td>
</tr>
<tr>
<td></td>
<td>• Assign Authority of Contact Person</td>
</tr>
<tr>
<td></td>
<td>[Cross-Application Components &gt; Master Data Synchronization &gt; Customer/Vendor Integration &gt; Business Partner Settings &gt; Settings for Customer Integration &gt; Field Assignment for Customer Integration &gt; Assign Attributes]</td>
</tr>
<tr>
<td></td>
<td>• Assign Marital Statuses</td>
</tr>
<tr>
<td></td>
<td>• Assign Legal Form to Legal Status</td>
</tr>
<tr>
<td></td>
<td>• Assign Payment Cards</td>
</tr>
<tr>
<td></td>
<td>• Assign Industries</td>
</tr>
</tbody>
</table>

9. For Vendor Value Mapping
Table 16

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components</td>
</tr>
<tr>
<td>Customer/Vendor Integration</td>
</tr>
<tr>
<td>Business Partner Settings</td>
</tr>
<tr>
<td>Field Assignment for Vendor Integration</td>
</tr>
<tr>
<td>Assign Attributes</td>
</tr>
</tbody>
</table>

10. For Checking Direction from Customer to BP

Table 17

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components</td>
</tr>
<tr>
<td>Customer/Vendor Integration</td>
</tr>
<tr>
<td>Business Partner Settings</td>
</tr>
<tr>
<td>Define BP Role for Direction Customer to BP</td>
</tr>
</tbody>
</table>

11. For Checking Direction from Vendor to BP

Table 18

<table>
<thead>
<tr>
<th>Customizing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Application Components</td>
</tr>
<tr>
<td>Customer/Vendor Integration</td>
</tr>
<tr>
<td>Business Partner Settings</td>
</tr>
<tr>
<td>Define BP Role for Direction Vendor to BP</td>
</tr>
</tbody>
</table>

Mapping tables

12. For CVI Mapping

In transaction **SE 11**, ensure that you maintain in mapping tables, **CVI_CUST_LINK** and **CVI_VEND_LINK**, the same number of entries as in customer table **KNA1** and vendor table **LFA1**.

13. For Contact Person Mapping

In transaction **SE 11**, ensure that you maintain in mapping tables, **CVI_CUST_CT_LINK** and **CVI_VEND_CT_LINK**, the same number of entries as in customer table **KNVK** with the condition **KNVK** with where condition **KUNNR <> SPACE** and **KNVK** with where condition **LIFNR <> SPACE**.

5.2.2.2.1.1 Number Assignment

If you assign identical numbers, this avoids confusion at the application level (when two different numbers appear for the business partner within a transaction). In order to use identical number you need some background information on the customer/vendor and business partner number range. The business partner in table **BUT000**, the customer in table **KNA1** and the vendor in table **LFA1** have independent number ranges.

For the sake of simplification we are focusing in this example on the business partner and customer. You create each business partner in a particular business partner group. The account group defines the number range of the customer master record. Both groups determine the number range in which a business partner and a customer are created. The link between the three objects has to be configured in the Customer/Vendor Integration (CVI).

Before you can assign identical numbers you have to make sure that the number ranges fit into each other.

The following example shows existing business partners created with internal numbers and customer created with internal numbers with overlapping number range 01.
Table 19: BP Groupings

<table>
<thead>
<tr>
<th>Grouping</th>
<th>Short Name</th>
<th>Description</th>
<th>Number range</th>
<th>External</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>Int.No.Assgnmnt</td>
<td>Internal Number Assignment</td>
<td>01</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 20: Intervals Business Partner

<table>
<thead>
<tr>
<th>NR</th>
<th>From No.</th>
<th>To Number</th>
<th>Nr Status</th>
<th>Ext</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>0000000001</td>
<td>0999999999</td>
<td>5000</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 21: Account Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Name</th>
<th>Number Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEBI</td>
<td>Customer (general)</td>
<td>01</td>
</tr>
</tbody>
</table>

Table 22: Intervals Customer

<table>
<thead>
<tr>
<th>NR</th>
<th>From No.</th>
<th>To Number</th>
<th>Nr Status</th>
<th>Ext</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>0000100000</td>
<td>0000199999</td>
<td>100010</td>
<td>-</td>
</tr>
</tbody>
</table>

Since only **To Number** can be changed for an internal number range you have to do the following:

1. Change the **To Number** for the business partner interval to 00000999999, for example.
2. Create a new range 02 and mark for external.

Table 23: Intervals Business Partner

<table>
<thead>
<tr>
<th>NR</th>
<th>From No.</th>
<th>To Number</th>
<th>Nr Status</th>
<th>Ext</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>0000000001</td>
<td>0000099999</td>
<td>5000</td>
<td>-</td>
</tr>
<tr>
<td>02</td>
<td>0000100000</td>
<td>0000199999</td>
<td>-</td>
<td>x</td>
</tr>
</tbody>
</table>

3. Change the BP Groupings Number Range to 02.

Table 24: BP Groupings

<table>
<thead>
<tr>
<th>Grouping</th>
<th>Short Name</th>
<th>Description</th>
<th>Number range</th>
<th>External</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>Int.No.Assgnmnt</td>
<td>Internal Number Assignment</td>
<td>02</td>
<td>X</td>
</tr>
</tbody>
</table>

During the transformation the new business partners are now created out of the customer with the same numbers.

After the initial load you should change the number range again in such a way that new identical numbers are created for business partner and customers by defining a new range for business partner and customer.

1. Create a new intervals business partner range 03.

Table 25: Intervals Business Partner

<table>
<thead>
<tr>
<th>NR</th>
<th>From No.</th>
<th>To Number</th>
<th>Nr Status</th>
<th>Ext</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>0000000001</td>
<td>0000099999</td>
<td>5000</td>
<td>-</td>
</tr>
<tr>
<td>02</td>
<td>0000100000</td>
<td>0000199999</td>
<td>-</td>
<td>x</td>
</tr>
<tr>
<td>03</td>
<td>0000200000</td>
<td>0000300000</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

2. Change the BP groupings number range to 03
3. Change the account groups range to 02

Table 27

<table>
<thead>
<tr>
<th>Group</th>
<th>Name</th>
<th>Number Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEBI</td>
<td>Customer (general)</td>
<td>02</td>
</tr>
</tbody>
</table>

5.2.2.2.2 Convert Customer/Vendor Data Into Business Partner

**Context**

Execute the transformation process in the defined sequence and repeat it in case of errors

**Prerequisites**

You have checked and adapted the customizing and created the CVI and contact person mapping as described in section Prepare Customizing and Mapping Tables for Business Partner Conversion [page 25].

**Steps**

1. Synchronize the data using transaction MDS_LOAD_COCKPIT.
   
   You use the cockpit to convert the customer/vendor data into a SAP business partner. It creates a corresponding SAP business partner for the customer and vendor data for general data, addresses, role data, bank details. You will find detailed information about this in the Customizing under [Cross Application Components > Master Data Synchronization > Synchronization Cockpit].
   
   In case of an error during the synchronization process due to data/customizing mismatch you will find the errors in the monitor tab button Call PPO.
   
   2. Adjust the customizing in case of errors.
      
      In case of a missing BP event (missing function module) please deactivate the event using transaction BUS7.

   **Note**
   
   In case you determine inconsistencies in data between the CVI Link tables (CVI_CUST_LINK, CVI_VEND_LINK und CVI_CUST_CT_LINK) and the Business Partner tables, for example, BUT000, or vice versa you should search for an SAP Note with the key word BP_CVI.
   
   For example, if customer and vendor exist with the same number representing the same legal entity the migration fails with the message “BP already exists”. SAP Note 954816 explains how you can solve this problem.
5.3  Finance

5.3.1  Migration to SAP S/4 HANA Finance

SAP S/4 HANA Finance, On-Premise Edition contains the product SAP Accounting powered by SAP HANA. SAP Accounting powered by SAP HANA contains General Ledger Accounting, Controlling, and Asset Accounting.

Purpose and Target Groups

If you want to implement and use SAP Accounting powered by SAP HANA, you have to migrate the existing user data from the G/L Accounting (FI-GL), Asset Accounting (FI-AA), Controlling (CO) and Material Ledger areas. Such a migration of data is necessary because SAP Accounting powered by SAP HANA rests on a uniform data model for all accounting areas. The comprehensive ACDOCA data table contains all line item documents from FI, FI-AA, and CO. After installation and migration, all postings of the named applications are written in the new tables.

The following tables were replaced by SAP HANA views with the same names:

- The line item, totals tables and application index tables of General Ledger Accounting (GLT0, BSIS, BSAS and FAGLFLLEXA, FAGLFLLEX, FAGLBSIS, FAGLBSAS)
- The totals tables and application index tables of Accounts Receivable and Accounts Payable (KNC1, KNC3, LFC1, LFC3, BSID, BSIK, BSDA, BSAD, BSAK)
- The line item and totals tables of Controlling (COEP for certain value types, COSP and COSS)
- The material ledger tables for parallel valuations (MLIT, MLPP, MLPF, MLCR, MLCD, CKMII, BSIM)
- The Asset Accounting tables (ANEK, ANEP, ANEA, ANLP, ANLC)

Replacing these tables with views with the same names ensures the continuation of all read accesses to the tables mentioned.

With SAP S/4HANA Finance, you are provided with universal data table ACDOCA, which contains all of the line item documents from FI, FI-AA, and CO. All postings of these applications are written to the new table after the installation and migration are complete.

Notes About Migration

SAP Accounting powered by SAP HANA is based on new General Ledger Accounting (FI-GL (New)) and uses functions such as ledgers to update a particular valuation, and the document splitting function. If you want to use SAP Accounting powered by SAP HANA, but were still using classic General Ledger Accounting until now, migrate the application data for General Ledger Accounting and the necessary settings for the new Customizing, for example ledgers and integration for Controlling.

However, none of the functions of new General Ledger Accounting, such as parallel ledgers and document splitting, are implemented.

For Asset Accounting purposes you use new Asset Accounting in SAP Accounting powered by SAP HANA. During the migration from classic Asset Accounting to new Asset Accounting in SAP Accounting powered by SAP HANA, you migrate Customizing settings and transaction data.

The Migration Process

The migration of existing system configurations, master data, and application data is closely connected to the process for installing SAP S/4HANA Finance. You cannot consider the installation and migration in isolation from each other.
You have to perform preparatory steps before you install SAP S/4HANA Finance. These include the following application-specific preparations:

- Making a preliminary check that ascertains whether SAP S/4HANA Finance can be installed with the current system settings, or whether additional activities are required
- Making consistency checks that check the correctness of the accounting data from a technical point of view, and list any inconsistencies
- Performing reconciliation between the accounting applications, to enable the data to be merged correctly in the universal journal entry
- Carrying out period-end closing including the storage of reporting key figures and closing the posting periods

Once you have carried out the preparatory steps, and have met the prerequisites for implementing SAP S/4HANA Finance, you can proceed to install it.

In the course of installing SAP S/4HANA Finance, the following steps to prepare for the migration are automatically executed by the system:

- Creating backup tables for the totals tables and index tables in the Data Dictionary that are being done away with (_BCK in FI and _BAK in CO)
- Saving the totals tables and index tables in backup tables
- Deleting the original totals tables and index tables
- Creating SAP HANA views (with the same names) for the totals, index, and line item tables
- Creating the new table for the universal journal entry

You have to migrate the accounting and Controlling data immediately following the installation. To be able to undertake this data migration, specific configuration steps are necessary that have been summarized in the implementation guide. There are specific migration and check programs for the migration that have been included in the SAP Reference IMG in their correct order. All of the migration steps are described in the relevant sections included there.

After the migration, you nonetheless have to reconcile the data and perform tests manually.

**Constraints**

If you want to use new Asset Accounting in SAP Accounting powered by SAP HANA, you are **not** allowed to use some components and functions at the same time. For more information, see Migration to New Asset Accounting (FI-AA (New)) [page 44].

### 5.3.1.1 Migration from Classic General Ledger Accounting to SAP Accounting

**Note**

The following information is only relevant to customers who are using classic General Ledger Accounting.

SAP Accounting uses functions and technical dimensions of new General Ledger Accounting, such as the ledger concept. If you migrate from classic General Ledger Accounting to SAP Accounting powered by SAP HANA, changes result that you ought to familiarize yourself with before the installation and migration.
Constraints

Unlike a migration to the new General Ledger Accounting using the SAP General Ledger Migration Service, migration to SAP Accounting powered by SAP HANA does not support the following scenarios:

- Implementation of document splitting
- Balance sheets at the profit center level
- As document splitting is not supported, complete balance sheets at the profit center level are not possible.
- Migration from special purpose ledger to new General Ledger Accounting
  After the migration, you can continue to use any special purpose ledgers that existed prior to the migration as usual.
- New implementation of parallel valuation
- New implementation of segment reporting
- Implementation of the ledger approach for parallel accounting (replacement of parallel accounts)
- Change in chart of accounts and conversion of chart of accounts

More Information

For more information on new General Ledger Accounting, see the documentation on the SAP Help Portal under help.sap.com/erp > SAP ERP Central Component > Accounting > Financial Accounting (FI) > General Ledger Accounting (FI-GL) (New).

5.3.1.1.1 Analysis of Use: General Ledger Accounting and Profit Center Accounting

Note

The following information is only relevant to customers who are using classic General Ledger Accounting.

Before you implement SAP Accounting powered by SAP HANA, you analyze your starting situation regarding the use of Profit Center Accounting (EC-PCA) in connection with classic General Ledger Accounting.

- In the universal journal entry, the profit center is defined as a characteristic in line item table ACDOCA. If you use Profit Center Accounting in classic General Ledger Accounting for profit and loss accounts, you can convert Profit Center Accounting completely to the universal journal entry.

Note

After the migration, you can continue to use classic Profit Center Accounting in parallel. However, this entails investing time and effort in reconciliation, and additional data volume. Please take the following aspects into consideration:

- If the currencies that you use in Profit Center Accounting differ from those used in General Ledger Accounting, you need to add the differing currency for Profit Center Accounting as local or parallel currency in FI before you migrate to new General Ledger Accounting. For this, see SAP Note 39919.
- In classic Profit Center Accounting, there can be local documents; these are documents that are entered using special posting transactions in classic Profit Center Accounting. As such documents are
● If you also use the profit center in classic General Ledger Accounting on balance sheet items (such as fixed assets or receivables and payables) to create a balance sheet on the profit center level, a complete conversion to new General Ledger Accounting is not possible as part of the migration to SAP Accounting powered by SAP HANA.

5.3.1.1.2 Changes in Function Compared to Classic G/L Accounting

With the introduction of SAP Accounting powered by SAP HANA, various processes and functions are changing when compared to classic General Ledger Accounting - corresponding to the introduction of new General Ledger Accounting. Furthermore, some of the functions in classic General Ledger Accounting are no longer available and are replaced by new functions from new General Ledger Accounting.

Features

Changes to Functions

The following processes and functions are being changed in SAP Accounting (on the same basis as new General Ledger Accounting) compared to classic General Ledger Accounting.

● Foreign Currency Valuation
  The way foreign currency is valuated in the universal journal entry corresponds to the foreign currency valuation in new General Ledger Accounting. It differs from the how foreign currency was valuated in classic General Ledger Accounting.

● Cost of Sales (COS) Accounting
  You can store the data from the COS ledger in the leading ledger.

● Preparations for Consolidation
  The characteristics company ID and consolidation transaction type are in the line item table of SAP Accounting powered by SAP HANA by default, and can be updated.
  Please note that, in this case, you also specify the consolidation staging ledger as the source ledger for the transfer of data. To ensure data consistency in the general ledger, you still need to fully reconcile the consolidation staging ledger with the ledger in classic General Ledger Accounting (ledger 00, table GLT0).

● Parallel Valuation
  If you use the accounts approach in classic General Ledger Accounting for parallel valuation using different accounting principles, you can retain this valuation approach. In this way, you portray all valuations using parallel accounts in the leading ledger.

Program Changes

The following programs in classic General Ledger Accounting are replaced by other programs in new General Ledger Accounting:
### Table 28

<table>
<thead>
<tr>
<th>Function</th>
<th>Transaction or program in classic General Ledger Accounting</th>
<th>Transaction in General Ledger Accounting in SAP Accounting powered by SAP HANA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreign Currency Valuation</td>
<td>Transactions F04N, F05N, F06N</td>
<td>Transaction FAGL_FCV</td>
</tr>
<tr>
<td>Currency Translation for Balances</td>
<td>Program SAPF100 (FASB52)</td>
<td>Transaction FAGL_FC_TRANS</td>
</tr>
<tr>
<td>Balance Carryforward</td>
<td>Transaction F.16</td>
<td>Transaction FAGLGVTR</td>
</tr>
<tr>
<td>Balance Display</td>
<td>Transaction FS10N</td>
<td>Transaction FAGLB03</td>
</tr>
<tr>
<td>Line Item Display</td>
<td>Transaction FBL3N</td>
<td>Transaction FAGLL03</td>
</tr>
<tr>
<td>B/S Supplement OI Analysis</td>
<td>Transaction F101</td>
<td>Transaction FAGLFI01</td>
</tr>
</tbody>
</table>

The drilldown reports in new General Ledger Accounting differ from those in classic General Ledger Accounting. For more information on the drilldown reports in new General Ledger Accounting, see the documentation in new General Ledger Accounting on the SAP Help Portal under [help.sap.com/erp](http://help.sap.com/erp) > SAP ERP Central Component > Accounting > Financial Accounting (FI) > General Ledger Accounting (FI-GL) (New) > Reporting > Drilldown Reports.

#### 5.3.1.1.2.1 Preparations for classic General Ledger Accounting

To ensure that the data in classic General Ledger Accounting will be transferred correctly to the new SAP Accounting powered by SAP HANA and can correspondingly be correctly reproduced there, you need to perform a number of preparatory steps.

**Process**

To prepare for the migration, complete the following steps:

- If you have used interfaces to connect your system to external systems that make postings to General Ledger Accounting (in real time or subsequently), check whether adjustments need to be made to the interfaces:
  - Check whether the interfaces use the entities for new General Ledger Accounting. If this is not the case, enhance the interfaces accordingly.
  - Check whether you can adjust the processing logic used by the interfaces so that the document volume is reduced.
  - You can no longer use the previous ALE distribution scenarios for Financial Accounting. By activating the business function FIN-GL_DISTR_SCEN_1, you can replace the old ALE distribution scenarios with a new one. For more information, see the documentation for the business function.

- If you use foreign currency valuation, reset the valuations for all periods in the current fiscal year so that the valuation differences in the open items are set to zero. Reset the valuations using program SAPF100.

  This step is necessary because foreign currency valuation in new General Ledger Accounting does not consider the results of the Valuation for Balance Sheet Preparation function in classic General Ledger Accounting; consequently, incorrect values might be the result of not initializing the valuation differences.
If you do not yet use any valuation areas, switch to using valuation areas and accounts dependent on valuation areas to ensure the correct application of fully automatic foreign currency valuation with parallel accounts. You make the necessary settings in Customizing (transaction SPRO) for General Ledger Accounting (New) under Periodic Processing > Valuate.

If you replace Profit Center Accounting within the implementation of SAP Accounting powered by SAP HANA and have to date been using the function Select Additional Balance Sheet and Profit and Loss Accounts (transaction 3KEH) in Customizing, you need to convert the definition of the default profit center. As is already the case in new General Ledger Accounting, the Customizing function Assign Default Profit Center to Accounts is used for this. Make the necessary settings in Customizing of General Ledger Accounting (New) under Master Data > Profit Center > Assign Default Profit Center to Accounts.

Close all previous periods and fiscal years.

To ensure the consistency of data ahead of the migration, perform reconciliations in classic General Ledger Accounting with other application components, in particular reconciliation of the subledgers with classic General Ledger Accounting. You are recommended to perform the following checks only for fiscal years with a complete dataset (that is, fiscal years in which no data has yet been archived):

- Financial Accounting Comparative Analysis (program SAPF190)
- Reconciliation of Financial Accounting with Preparations for Consolidation (ledger comparison, transaction GCAC)
- Reconciliation of Financial Accounting with Cost of Sales Accounting (ledger comparison, transaction GCAC)

Create and save a balance sheet as well as an income statement in classic General Ledger Accounting. You can use these financial statements after the migration to check the consistency of the migrated data.

Configure the SAP Accounting powered by SAP HANA that continues to use configurations for the new General Ledger Accounting.

**Recommendation**

We recommend that you first acquaint yourself fully with the functions in new General Ledger Accounting before the migration and test the functions in a separate system or client.

### 5.3.1.1.2.2 Foreign Currency Valuation

In new General Ledger Accounting as well as SAP Accounting powered by SAP HANA, you need to specify a valuation area when posting a foreign currency valuation. These postings are then updated using a ledger group that, by its accounting principle, is assigned to the relevant valuation area.

The Valuation for Balance Sheet Preparation function (program SAPF100) is no longer supported in new General Ledger Accounting. This means that, during foreign currency valuation in new General Ledger Accounting, the system does not consider the valuation differences determined with this function. For this reason, you need to initialize the valuation differences in the open items before the migration to ensure that the results of foreign currency valuation are correct in new General Ledger Accounting.
5.3.1.1.2.3 Cost of Sales Accounting

Since the functional area is updated in new General Ledger Accounting as well as SAP Accounting powered by SAP HANA, you no longer need to use a special purpose ledger to portray cost of sales accounting. When you activate new General Ledger Accounting, the following functions are changed automatically:

- Derivation of the Functional Area

  Unlike in classic General Ledger Accounting, the system determines the functional area in new General Ledger Accounting as soon as documents are entered. This changes the timing of the substitution of the functional area, from event 0005 to event 0006. For more information about the derivation of the functional area, see SAP Note 740519. In the case of processes for which no entry screen is used for individual documents (for example, periodic processing), you additionally need to activate derivation of the functional area.

  **Note**
  
  You can deactivate the automatic change to how functional areas are derived. You do this in Customizing for Financial Accounting (New). For this, choose Financial Accounting Global Settings (New) > Tools > Enhance Determination of Functional Area.

- The update of the functional area in CO totals records is activated.

  Activation of the update of the functional area in CO totals records offers the advantage that, for totals-based CO allocations in actual data (during assessments, distributions, revaluations, and order settlements), the sender objects in CO are credited according to their functional area. For more information, see SAP Note 764485. However, changing how the system derives the functional area as described above forms the prerequisite for using this function.

  **Note**
  
  The activation of the update of the functional area in the CO totals records is optional and can be deactivated under Controlling > General Controlling > Include Characteristics in CO Totals Records.

5.3.1.2 Prior to Installing

Before you install SAP S/4HANA Finance, On-Premise-Edition, you must execute the following checks and activities to discover errors and system states that do not allow the installation of SAP S/4HANA Finance, On-Premise-Edition and the migration of data.

**Activities**

You perform the following activities in your test system and if you are using classic Asset Accounting, new Asset Accounting or the Simple Finance add-on 1.0.

- Make sure that you have either posted or deleted all held documents.

- From SAP Note 1939592, implement report RASFIN_MIGR_PRECHECK and test whether the necessary prerequisites for new Asset Accounting have been fulfilled using report RASFIN_MIGR_PRECHECK (Check on Prerequisites Before FI-AA Migration).
• If you discover when executing report RASFIN_MIGR_PRECHECK that currency areas are missing, you have to create these first in a separate project and have the system determine the values.

• You need the new depreciation calculation from the Enterprise Extension Financials Extension (EA-FIN). Check if the new depreciation calculation is active (SAP Note 965032). If necessary, implement the new depreciation calculation as part of a separate project.

• Make sure that you have carried forward all of the balances in all applications to the current fiscal year. This also applies to the subledgers. Use the following transactions:
  ○ FAGLGVTR, if you are using new General Ledger Accounting
  ○ F.16, if you are using classic General Ledger Accounting
  ○ AJRW, if you are using Asset Accounting
  ○ F.07, if you are using Accounts Receivable and Accounts Payable

You perform the following activities in your test system and if you are using classic General Ledger Accounting, new General Ledger Accounting or the Simple Finance add-on 1.0.

• Check whether the currency settings and the CO configuration in your system allow you to upgrade to SAP S/4HANA Finance. To do this, run report ZFINS_MIG_PRECHECK_CUST_SETTINGS. This report is found in SAP Note 2129306.

The following contain all further steps and activities that you have to perform before installation can take place.

• Consistency Checks Before Installation and Migration [page 40]
• Check Customer-Defined Coding [page 40]
• Handling Customer-Defined Fields and Interfaces [page 41]
• Period-End Closing Activities [page 42]

Note
If you do not want to use Asset Accounting and are also not planning on using it in future, then note the following: You are not allowed to activate Asset Accounting during the migration. You must deactivate Asset Accounting instead by deactivating the component RAIN (Asset Accounting) in your system/clients in table TRNCA.

Note
Migration to SAP Accounting powered by SAP HANA leads to changes compared to classic General Ledger Accounting. You need to be aware of these changes before you perform the installation and migration. For more information, see:

• Analysis of Use: General Ledger Accounting and Profit Center Accounting [page 34]
• Changes in Function Compared to Classic G/L Accounting [page 35]
• Preparations for classic General Ledger Accounting [page 36]
5.3.1.2.1 Consistency Checks Before Installation and Migration

Procedure

Before installing, you check the consistency of your FI data.

Perform the following consistency checks in your test system and production system:

- Execute report RFINDEX_NACC with the option \textit{Indexes vs Documents}. You perform this activity if you are using classic General Ledger Accounting, new General Ledger Accounting, or the SAP Simple Finance add-on 1.0.

- Check documents against transaction figures for all fiscal years, in which archiving has not yet taken place.

\begin{tcolorbox}[title=Caution]
If you can’t perform consistency checks of documents against transaction figures using report RFINDEX_NACC due to runtime issues, perform the consistency checks after the installation instead. To do this, in Customizing, choose \textit{Migration to SAP S/4HANA Finance} \textit{Migration} \textit{Start and Monitor Data Migration}. In the \textit{Start and Monitor Data Migration} activity, central steps for migration are executed. Here, the system also reconciles the transaction data, enhances it, and checks the enhancement of the transaction data. This activity is available to you after installation of SAP S/4HANA Finance on your test system.
\end{tcolorbox}

- If you are using classic General Ledger Accounting, execute the reconciliation for the general ledger and the AP/AR subledgers. Use report SAPF190 to do this.

- If you are using new General Ledger Accounting, execute the reconciliation for the general ledger and the subledgers. Use report TFC_COMPARE_VZ to do this or choose transaction FAGLF03.

- Reconcile the general ledger with Asset Accounting for the leading valuation and parallel valuation. Use the following reports in sequence:
     You use this report if you are using classic and new Asset Accounting.
  2. \textit{Consistency Check for FI-AA (New) and FI-GL (New)} (Report RAABST01).
     You use this report if you are using classic Asset Accounting.

- Compare the ledgers if you are using new General Ledger Accounting. Use report RGUCOMP4 to do this or choose transaction GCAC.

- Reconcile Materials Management (MM) with GL. Choose report RM07MBST/ RM07MMFI to do this.

5.3.1.2.2 Check Customer-Defined Coding

The migration to SAP Accounting powered by SAP HANA generates new data structures in Accounting and replaces existing tables with same-named views. You must therefore perform the following checks and activities in the test system:
• Check if you have write accesses to the tables in your own customer objects in your customer namespace. You have to replace these accesses, since the views with same names allow only read access.

• Check if you have your own customer-specific views in your own objects in your customer namespace for the tables that no longer exist. You have to replace these views with an open-SQL SELECT or the call of a read module, since the Data Dictionary does not support database views that are based on other views.

Note

For more information about dealing with customer-specific coding, see SAP Note 1976487 Simple Finance add-on 1.0: Information about adjusting customer-specific programs to the simplified data model in SAP Simple Finance.

• If you are migrating from classic Asset Accounting, note the following:

  Batch input programs for AB01 are no longer supported in new Asset Accounting. If you are using customer-defined programs, you must convert these to BAPIs.

5.3.1.2.3 Handling Customer-Defined Fields and Interfaces

Procedure

• If you are using new General Ledger Accounting and also using customer-defined fields, these fields are generated to the appropriate compatibility views.

• For customer fields in BSEG and the index tables, note the following for the creation of the views with the same names:

  If a customer field exists in both the BSEG and in the indexes, it is automatically generated into the view with the same name. It is not transferred into a view with the same name if the customer field only exists in the index. In this case the field must first be included in the BSEG and filled using a customer program.

• If you transferred data from your Z tables to new General Ledger Accounting during the migration to the Financial Accounting Add-On 1.0, you have to delete the data of these Z tables before the migration to SAP S/4HANA Finance, on-premise-Edition. If you do not delete the data, the data of the Z tables is migrated again and transferred to the new table structure. The values would then be duplicated.

• If you have used interfaces to connect your system to external systems that make postings to General Ledger Accounting (in real time or subsequently), check whether adjustments need to be made to the interfaces.

• In SAP S/4HANA Finance, there is only partial support for ALE scenarios. An SAP S/4HANA Finance system cannot serve as an ALE receiver for CO line items. The reason is that FI and CO line items use the same persistence table in SAP S/4HANA Finance. Therefore, the CO line items cannot be posted alone without the FI line items they belong to. SAP does not provide a check to determine if this scenario is used in the system. You have to check this manually. ALE scenarios for the distribution of CO master data, such as cost centers, continue to be supported.
5.3.1.2.4 Period-End Closing Activities

Procedure

Unless directed otherwise, perform the following activities in your test system and production system, and document the results.

1. Lock the current and previous periods in Materials Management (program RMMMPERI).
2. Perform closing for periodic asset postings (with program RAPERB2000).
   You perform this step if you are using Asset Accounting.
3. Execute the periodic depreciation posting run (with program RAPOST2000).
   You perform this activity if you are using classic Asset Accounting, new Asset Accounting, or the SAP Simple Finance add-on 1.0.
4. Check for update terminations in your system and correct any you find.
5. Make sure that all held documents have either been posted or deleted.
   ○ To post held documents, use transaction FB50, for example. In the menu for the transaction, choose Edit > Select Held Document.
   ○ To delete held documents, you can use program RFTMPBLD. You can delete individual held documents in transaction FB50. In the menu for the transaction, choose Edit > Delete Held Document.
6. If you are already using account-based profitability analysis, perform a delta upload to SAP BW for all account-based CO-PA DataSources for which you use the delta method.
   You perform this activity if you are using classic General Ledger Accounting, new General Ledger Accounting, or the SAP Simple Finance add-on 1.0.
7. Make sure that you have carried forward all of the balances in all applications to the current fiscal year. This also applies to the subledgers. Use the following transactions:
   ○ FAGLGVTR, if you are using new General Ledger Accounting
   ○ F.16, if you are using classic General Ledger Accounting
   ○ AJRW, if you are using Asset Accounting
   ○ F.07, if you are using Accounts Receivable and Accounts Payable
8. The following applies for Asset Accounting: Close all fiscal years except the current fiscal year. Use program RAJABSO0 to do this.
9. You perform this step if you have been using classic General Ledger Accounting, and used the foreign currency valuation with function Valuation for Balance Sheet Preparation there.
   In this case, you have to set the valuation differences in the open items to zero; this means you reset the valuations for all periods in the current fiscal year. Reset the valuations using program SAPF100.
   This step is required because the foreign currency valuation in new General Ledger Accounting does not take into account the results of the function Valuation for Balance Sheet Preparation in classic General Ledger Accounting. If you do not reset the valuations, this could result in incorrect values.
10. Execute all scheduled jobs and do not schedule any new jobs.
11. Lock the periods in Financial Accounting (program SAPLOF00) and Controlling (Plan/Actual) (program SAPMKCSP).
12. Execute program RASFIN_MIGR_PRECHECK again to make sure that the prerequisites for Asset Accounting have been met.
13. Lock all users in the system that do not have any tasks associated with the installation or the migration.

Note
Do not lock the users in the test system.

Caution
You can start the installation only after you have performed all activities and steps outlined in the following sections, and corrected all errors and removed all inconsistencies.

- Prior to Installing [page 38]
- Consistency Checks Before Installation and Migration [page 40]
- Check Customer-Defined Coding [page 40]
- Handling Customer-Defined Fields and Interfaces [page 41]

Wait until after you have completed all steps before installing SAP S/4HANA Finance, On-Premise-Edition.

5.3.1.2.5 Documentation for Dataset Before Installation und Migration

Procedure

You perform the following activities in your test system and production system.

You always perform the following activities unless directed otherwise.

1. Make sure that all balance carryforwards are complete and consistent. To ensure this, carry forward the balances for all currencies and all ledgers again.

2. Create the documentation for the closing to compare the data with data after the migration.

SAP recommends the following reports for this:

- The financial statements (program RFBILA00)
- The totals report for cost centers (transaction S_ALR_87013611)
- Order: Actual/Plan/Variance (transaction S_ALR_87012993)
- The G/L account balance list (program RFSSLD00)
- The general ledger line items list (program RFSOPO00)
- The compact document journal (program RFBELJ00)
- The asset history sheet (program RAGITT_ALV01)
- The depreciation run for planned depreciation (RAHAFA_ALV01)
- The vendor sales (program RFKUML00)
- The vendor open item list (program RFKEPL00)
- The customer sales (program RFDUML00)
- The customer open item list (program RFDEPL00)
- The customer recurring entry original documents (program RFDAUB00)
5.3.1.2.6 Migration to New Asset Management: General Information

5.3.1.2.6.1 Migrating from Classic to New Asset Accounting

Purpose and Target Groups

Table 29

<table>
<thead>
<tr>
<th>Application Component</th>
<th>FI-AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Groups (Roles)</td>
<td>Asset accountant</td>
</tr>
</tbody>
</table>

Availability

Table 30

<table>
<thead>
<tr>
<th>Source Release</th>
<th>SAP ERP with classic Asset Accounting; See also the Administrator’s Guide for SAP Simple Finance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Release</td>
<td>SAP Simple Finance, On-Premise Edition 1503 and higher</td>
</tr>
</tbody>
</table>

Note


Overview of the Migration Process

SAP Simple Finance is based on new General Ledger Accounting (FI-GL (new)). If you were using classic General Ledger Accounting until now, the application data for General Ledger Accounting are migrated with the migration. You cannot perform the migration of Customizing data for Asset Accounting until after you have installed SAP Simple Finance and activated the new general ledger. The latter is prerequisite for the subsequent migration of documents.

Caution

As soon as you have installed SAP Simple Finance, you can no longer post in Asset Accounting. To ensure that migration is successful, it is essential that you make sure that the prerequisites are met and a complete period-end closing was performed before you install SAP Simple Finance. Posting for new Asset Accounting is only possible again after you have completed the migration fully and successfully.

For Asset Accounting, you have to execute the steps set out in the table for preparation, installation and migration. (More steps are necessary for other applications; however, these are not part of this migration guide for Asset Accounting.)
Table 31

<table>
<thead>
<tr>
<th>Step</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Check Prerequisites for the Migration (Manual)</td>
<td>See the “Prerequisites” section below.</td>
</tr>
<tr>
<td>2. Perform period-end closing for Asset Accounting.</td>
<td>See Preparation [page 57].</td>
</tr>
<tr>
<td>3. In all relevant systems: Start the program for the preliminary check for Asset Accounting (SAP Note 1939592).</td>
<td>See Preparation [page 57].</td>
</tr>
<tr>
<td>5. Preparatory Steps for Migrating to the Universal Journal Entry</td>
<td>See the corresponding migration guide.</td>
</tr>
<tr>
<td>6. Migrate to new Asset Accounting.</td>
<td>See the following sections of the Migration Guide for new Asset Accounting.</td>
</tr>
<tr>
<td>7. Migrating Transaction Data (Documents) As a sub-step of the balance migration: Calculate initial depreciation values</td>
<td>See the section Transaction Data (Documents) [page 93].</td>
</tr>
</tbody>
</table>

Initial Situation

You want to use SAP Accounting powered by SAP HANA with new Asset Accounting. This Migration Guide for new Asset Accounting is relevant for the following starting scenarios:

- Until now you have been using classic Asset Accounting.
- Until now you have only been using (new or classic) General Ledger Accounting that has to be migrated. However, you are using neither classic Asset Accounting nor new Asset Accounting and are planning to implement new Asset Accounting in the future. In this case, you do not have to perform any of the steps mentioned in the Migration Guide for Asset Accounting. After successful completion of the migration, you can define the necessary Customizing settings for new Asset Accounting.

Before you import SAP Simple Finance into your system, you have to ensure that the prerequisites for new Asset Accounting are met.

Prerequisites

Incompatible Components, Business Functions, and Functions

If you want to use new Asset Accounting, you are not allowed to use any of the following components, business functions, or functions:

- From the Financials Extension (EA-FIN): Lease Accounting Engine (LAE)
The LAE controls postings for the lessor scenario; this scenario consists of the components CRM Leasing (CRM-LAM) and Leasing Accounting (FI-LA).

- **Real Estate (RE),** that is, classic Real Estate Management
  You can use Flexible Real Estate Management (RE-FX) instead.
- **From Funds Management (PSM-FM) or Industry-Specific Component Public Sector (IS-PS):** Requests with Reference to Asset
  See the instructions in the Administrators Guide and the SAP Notes mentioned there when using industry solutions in **SAP Accounting powered by SAP HANA.**

**Prerequisites**

- **General Ledger Accounting:**
  - You are currently using new General Ledger Accounting with the ledger approach or accounts approach.
  - Or you are currently using classic General Ledger Accounting. In this case, your system is converted to new General Ledger Accounting with the migration to **SAP Accounting powered by SAP HANA.**
  - You need the new depreciation calculation from the Enterprise Extension **Financials Extension (EA-FIN).**
  To be able to use new Asset Accounting (and, if necessary, also **Flexible Real Estate Management (RE-FX),**) you must activate - if not yet happened the Enterprise Extension **EA-FIN;** this must take place **before** you install SAP Simple Finance.
  You must implement the new depreciation calculation in a separate sub-project.
- **Check whether you can completely archive documents from non-active company codes (this means company codes that only allow subsequent reporting).** If you do not archive the documents of the company code, you must do the following:
  - You must migrate the assigned chart of depreciation; and
  - You must migrate the documents to the universal journal entry.

**Periodic Asset Postings, Currencies**

The following prerequisites must be met with regard to periodic asset postings and currencies:

- **Make sure that the periodic asset postings (with program **RAPERB2000**)** are completed without errors. After SAP Simple Finance is installed, it is **no longer** possible to catch up these postings. The program is **no longer** necessary after the migration and is **no longer** available.
- **For the leading valuation of the ledger approach and accounts approach and for parallel valuations of the ledger approach, the following is valid:** The parallel currencies in the leading ledger in General Ledger Accounting and in the depreciation areas in Asset Accounting must be the same.
  If until now you have been using parallel currencies in General Ledger Accounting, but you have not implemented the corresponding parallel currency areas in Asset Accounting for all depreciation areas, you must implement these areas in a separate project **before** you install SAP Simple Finance. In such a project, you must first perform the preparatory steps for creating depreciation areas in Customizing; you must then determine the new values for each fixed asset for a newly created depreciation area. Contact your consultant for such a project.
- **For company codes that are assigned to the same chart of depreciation, the following applies:** These company codes are **not** allowed to differ in number and type from the parallel currencies used in General Ledger Accounting.

**More Prerequisites, at the Time of Migration**

The following prerequisites also have to be met:
• Ensure that there are no update terminations from direct postings in the system.

• The following applies for the Call-Up Point of the Migration:
  From the viewpoint of Asset Accounting, it is not necessary that you install SAP Simple Finance at the end of the year. You must perform the following activities before installing SAP Simple Finance:
  ○ Perform a complete period-end closing in Asset Accounting for the previous period to be closed. This includes the following activities:
    ○ Execute the periodic depreciation posting run (RAPOST2000).
    ○ Reconcile your general ledger with the Asset Accounting subsidiary ledger, both for your leading valuation and for parallel valuations.
  ○ Execute the periodic APC postings (RAPERB2000) completely and without errors; a current time stamp must be set. You should post the periodic APC postings one last time immediately before the installation.
  ○ Run the program for recalculating depreciation (transaction AFAR).

The migration must take place at a time when only one fiscal year is open in Asset Accounting.

You can check which fiscal year is closed in your company code in Customizing for Asset Accounting (New) under Preparations for Going Live Tools Reset Year-End Closing.

• If until now you updated transactions in parallel valuations with different fiscal year variants and want to continue using this update, then you must implement a new representative ledger using the SAP General Ledger Migration Service before you install SAP Simple Finance. For more information about alternative fiscal year variants with parallel valuation, see SAP Note 2220152.

• Ensure that no further postings are made in your system.

> **Recommendation**

We recommend that you lock the users.

**Program for Preliminary Checks of Prerequisites**

To check if the prerequisites outlined are met, you have to check using the newest version of the program for preliminary checks RASFIN_MIGR_PRECHECK. You import this program using SAP Note 1939592 before you install SAP Simple Finance in your system. Perform this check in all of your systems - in the Customizing system as well as in the downstream systems (test system and production system).

For more information, see Preparation [page 57].

**Constraints**

The following restriction applies for the migration:

Using the migration program available under Tools [page 47], you can automatically migrate your charts of depreciation. If error messages appear stating that an automatic migration is not possible, you have to migrate the charts of depreciation manually.

### 5.3.1.2.6.1.1 Tools

When you have installed SAP Simple Finance, you can use the new structure Asset Accounting (New) in Customizing. Under Migration: Asset Accounting (new) Migration of Classic to New Asset Accounting you can find activities (with the corresponding programs) for migrating Customizing data.
You also find the activities for migrating the Customizing data at the following location in Customizing:

\[ Migration \text{ of SAP ERP to SAP Accounting powered by SAP HANA} \rightarrow \text{Preparations and Migration} \rightarrow \text{Customizing for Asset Accounting: Preparations and Migration} \rightarrow \text{Migrating from Classic to New Asset Accounting} \]\n
### Table 32

<table>
<thead>
<tr>
<th>Event</th>
<th>IMG path</th>
<th>Program (Technical Name)</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before You Install SAP Simple Finance</td>
<td>(Not in the IMG)</td>
<td>RASFIN_MIGR_PRECHECK</td>
<td>Before installing SAP Simple Finance, you use this program to check whether the prerequisites for using new Asset Accounting in SAP Accounting powered by SAP HANA have been met.</td>
</tr>
<tr>
<td>Migration of Customizing Data</td>
<td>RASFIN_MIGR_PRECHECK</td>
<td>FAA_CHECK_MIG2SFIN</td>
<td>You use this program to migrate your charts of depreciation automatically. The program creates an application log, from which you can see if your charts of depreciation were migrated successfully. It also provides a list containing any error messages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FAA_SHOWLOG_MIG2SFIN</td>
<td>You use this program to display the application log for the charts of depreciation that you have migrated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RACHECK_ACTIVATION_PARVAL</td>
<td>You use this program to check whether the prerequisites for activating new Asset Accounting are met.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>With this activity you activate the new Asset Accounting.</td>
</tr>
<tr>
<td>Migrating Transaction Data (Documents)</td>
<td>FINS_MIG_AFA</td>
<td></td>
<td>For the migration of balances, you initially build plan values.</td>
</tr>
<tr>
<td>Event</td>
<td>IMG path</td>
<td>Program (Technical Name)</td>
<td>Use</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>--------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>SAP HANA &gt; Migration &gt; Migration: Calculation of Depreciation and Total Values &gt;</td>
<td></td>
<td></td>
<td>for the depreciation. You also check these depreciation values and the total values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FINS_MIG_MONITOR_AFA</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FINS_RECON_RC5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FINS_MIG_MONITOR_RC5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Calculate initial depreciation values</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Display status of &quot;Calculate Initial Depreciation Values&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Check initial depreciation and total values</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Display status of &quot;Check initial depreciation and total values&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5.3.1.2.6.1.2 Process Flow for the Migration

You have to migrate the Customizing for fixed assets in order to then be able to migrate documents. You transport the Customizing settings to the downstream systems:

![Figure 2: Figure: Transporting Customizing Settings](image)

It is NOT possible to post during the migration. You can only post again when the migration of Customizing for fixed assets and the document migration, as well as other steps within the scope of the migration have been successfully completed.

**Recommendation**

We recommend that you lock your users during the entire migration process.

**Process**

**Customizing System**

In the Customizing system, the installation of SAP Simple Finance and the migration of Customizing for new Asset Accounting consists of the following steps:

1. You have checked manually if the prerequisites for the migration to new Asset Accounting are met.
2. Perform period-end closing:
   1. You perform a complete period-end closing in Asset Accounting; in addition, you reconcile the general ledger with the Asset Accounting subsidiary ledger.
   2. You lock the system and users to posting.

3. Check prerequisites automatically:
   You check the prerequisites for the migration automatically using program RASFIN_MIGR_PRECHECK (SAP Note 1939592).)

4. You back up your data and the system.

5. You install SAP Simple Finance.

6. You perform the relevant (preparatory) steps for the migration; your system is hereby migrated automatically to new General Ledger Accounting provided you have been using classic General Ledger Accounting until now.
   For more information, see Prior to Installing [page 38], under Preparing for Migration [page 59] and under Preparations and Customizing Migration in the General Ledger [page 60].

7. Migration to new Asset Accounting in SAP Accounting powered by SAP HANA:
   1. You migrate the Customizing settings for your charts of depreciation automatically (or manually).
   2. You make additional Customizing settings manually.
   3. You check if all the prerequisites for activating new Asset Accounting are met.
   4. You activate new Asset Accounting.

**Downstream Systems**

In the downstream system (test system or production system), the installation of SAP Simple Finance and the migration to new Asset Accounting consists of the following steps:

1. You have checked manually if the prerequisites for the migration to new Asset Accounting are met.

2. Perform period-end closing:
   1. You perform a complete period-end closing in Asset Accounting; in addition, you reconcile the general ledger with the Asset Accounting subsidiary ledger.
   2. You lock the system and users to posting.

3. Check prerequisites automatically:
   You check the prerequisites for the migration automatically using program RASFIN_MIGR_PRECHECK (SAP Note 1939592).

4. You back up your data and the system.

5. You install SAP Simple Finance.

6. You import the relevant preparatory settings that are necessary to be able to migrate the Customizing for fixed assets.

7. Migration to new Asset Accounting in SAP Accounting powered by SAP HANA:
   1. Manual tasks: You create G/L account master data if this data is not transported; you create number ranges, if necessary.
   2. You import all settings to the system.
   3. You check whether the transport successfully imported the activated Customizing switch.
5.3.1.2.6.2 Adjustments in New Asset Accounting

Purpose and Target Groups

Table 33

<table>
<thead>
<tr>
<th>Application Component</th>
<th>FI-AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Groups (Roles)</td>
<td>Asset accountant</td>
</tr>
</tbody>
</table>

Availability

Table 34

| Source Release | • SAP ERP 6.0, enhancement package 7, SPS 02 or higher:  
with activated business function **FI-AA, Parallel Valuation** (**FIN_AA_PARALLEL_VAL**) and with the Customizing switch activated for new Asset Accounting, or  
• SAP Simple Finance add-on 1.0 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Release</td>
<td>SAP Simple Finance, On-Premise Edition 1503 or higher</td>
</tr>
</tbody>
</table>

Note

*SAP Simple Finance, On-Premise Edition* (short: “SAP Simple Finance”) contains the product **SAP Accounting powered by SAP HANA**. New Asset Accounting is part of **SAP Accounting powered by SAP HANA**.

Overview of the Migration Process

SAP Simple Finance is based on new General Ledger Accounting (FI-GL (new)) and new Asset Accounting. The migration process entails adjustments to Customizing settings and the migration of documents. The extent to which your Customizing settings need to be adjusted depends on your source release:

- **SAP ERP 6.0, enhancement package 7, SPS 02, with activated business function **FI-AA, Parallel Valuation** (**FIN_AA_PARALLEL_VAL**) and with the Customizing switch activated for new Asset Accounting:**
  - If you have activated Asset Accounting in enhancement package 7, you need to install SAP Simple Finance. In Customizing, you need to adjust a few settings, in particular the parameters in the charts of depreciation.

- **SAP Simple Finance add-on 1.0:**
  - If you have already installed the SAP-Simple-Finance add-on in Release 1.0, a release upgrade is required. In Customizing, you need to adjust a few settings, in particular the parameters in the charts of depreciation.

Caution

As soon as you have installed SAP Simple Finance or performed a release upgrade, you can no longer post in Asset Accounting. To ensure that migration is successful, it is essential that you make sure that the prerequisites are met and a complete period-end closing was performed before you install SAP Simple Finance. Posting for new Asset Accounting is only possible again after you have completed the migration fully and successfully.

For Asset Accounting, you have to execute the steps set out in the table for preparation, installation and migration. (More steps are necessary for other applications; however, these are not part of this migration guide for Asset Accounting.)
Table 35

<table>
<thead>
<tr>
<th>Step</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Check Prerequisites for the Migration (Manual)</td>
<td>See the “Prerequisites” section below.</td>
</tr>
<tr>
<td>2. Perform period-end closing for Asset Accounting.</td>
<td>See Preparation [page 58].</td>
</tr>
<tr>
<td>3. In all relevant systems: Start the program for the preliminary check for Asset Accounting (SAP Note 1939592).</td>
<td>See Preparation [page 58].</td>
</tr>
<tr>
<td>5. Preparatory Steps for Migrating to the Universal Journal Entry</td>
<td>See the corresponding migration guide.</td>
</tr>
<tr>
<td>6. Migrate to new Asset Accounting.</td>
<td>See the following sections of the Migration Guide for new Asset Accounting.</td>
</tr>
<tr>
<td>7. Migration of the documents</td>
<td>See the section Transaction Data (Documents) [page 93]</td>
</tr>
</tbody>
</table>

Initial Situation

You want to use SAP Accounting powered by SAP HANA with new Asset Accounting. This Migration Guide for new Asset Accounting is relevant for the following starting scenarios: You have been using new Asset Accounting up to now:

- Either in SAP ERP 6.0, enhancement package 7, SPS 02 or higher, with activated business function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL) and with the Customizing switch activated for new Asset Accounting
  - Before you import SAP Simple Finance into your system, you have to ensure that the prerequisites for new Asset Accounting are met.
- Or in SAP Simple Finance add-on 1.0

Prerequisites

Incompatible Components, Business Functions, and Functions

If you use new Asset Accounting, you are not allowed to use certain components, business functions, or functions. The details in the release note for SAP Accounting 1.0 powered by SAP HANA apply: "New Asset Accounting: Ledger Approach and Accounts Approach".
The restriction concerning Joint Venture Accounting (JVA) no longer applies as of SAP Accounting 2.0, SP03 powered by SAP HANA, this means you can use JVA together with new Asset Accounting.

See the instructions in the Administrators Guide and the SAP Notes mentioned there when using industry solutions in SAP Accounting powered by SAP HANA.

Other Prerequisites

- **Imperative prerequisite: Archiving or migrating non-active company codes**
  Check whether you can completely archive documents from non-active company codes (that is, from company codes that only allow subsequent reporting). If you do **not** archive the documents of the company code, you must do the following:
  - You must migrate the documents to the universal journal entry; and
  - You must migrate the assigned chart of depreciation.

- **Periodic asset postings**
  The following prerequisites must be met with regard to periodic asset postings:
  Make sure that the periodic asset postings (with program RAPERB2000) are completed. After SAP Simple Finance is installed, it is **no longer** possible to catch up these postings. The program is **no longer** necessary after the migration and is **no longer** available.

Timing of the Migration, Locking Users

- From the viewpoint of Asset Accounting, it is **not** necessary that you install SAP Simple Finance at the end of the year or period. However, it is required that you perform a complete period-end closing directly before you install SAP Simple Finance. This includes, but is not limited to:
  - You must have performed periodic APC posting (RAPERB2000) completely; the timestamp must be current.
  - Execute the periodic depreciation posting run (RAPOST2000).
  - Reconcile your general ledger with the Asset Accounting subsidiary ledger, both for your leading valuation and for parallel valuations.

**Caution**
The migration must take place at a time when only one fiscal year is open in Asset Accounting.
You can check which fiscal year is closed in your company code in Customizing for Asset Accounting (New) under | Preparations for Going Live | Tools | Reset Year-End Closing |

- If until now you updated transactions in parallel valuations with different fiscal year variants and want to continue using this update, then you must implement a new representative ledger using the SAP General Ledger Migration Service **before** you install SAP Simple Finance. For more information about alternative fiscal year variants with parallel valuation, see SAP Note 2220152.
- **Ensure that no** further postings are made in your system.

**Recommendation**
We recommend that you lock the users.

Program for Preliminary Checks of Prerequisites

To check if the prerequisites outlined are met, you have to check using the program for preliminary checks RASFIN_MIGR_PRECHECK. You import the current version of this program using SAP Note 1939592 before you...
install SAP Simple Finance in your system. Perform this check in all of your systems - in the Customizing system as well as in the downstream systems (test system and production system).

For more information, see Preparation [page 58].

**Constraints**

Using the migration program available under Tools [page 54], you can automatically adjust the parameters in your charts of depreciation. If error messages appear stating that automatic adjustment is not possible, you have to adjust the charts of depreciation manually.

**SAP Notes**

The following SAP Note contains the program for preliminary checks of the prerequisites (RASFIN_MIGR_PRECHECK):

SAP Note 1939592

### 5.3.1.2.6.2.1 Tools

When you have installed SAP Simple Finance, you can use the new structure Asset Accounting (New) in Customizing. Under Migration: Asset Accounting (New) ➔ Adjustments in Asset Accounting (New) ➔ Adjust Parameters in Chart of Depreciation, you find the activities (with the corresponding programs) for adjusting the Customizing settings.

**Note**

You also find the activities for adjusting the Customizing data at the following location:

Migration of SAP ERP to SAP Accounting powered by SAP HANA ➔ Preparations and Migration ➔ Customizing for Asset Accounting: Preparations and Migration ➔ Adjustments in Asset Accounting (New)

#### Table 36

<table>
<thead>
<tr>
<th>Timing</th>
<th>IMG path</th>
<th>Program (Technical Name)</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before You Install SAP</td>
<td>(Not in the IMG)</td>
<td>RASFIN_MIGR_PRECHECK</td>
<td>Before installing SAP Simple Finance, you use this program to check whether the prerequisites for using new Asset Accounting in SAP Accounting powered by SAP HANA have been met.</td>
</tr>
<tr>
<td>Simple Finance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Migration of Customizing Data</td>
<td>Migration: Asset</td>
<td>FAA_MIG2SF12_BUHBKT_RLV</td>
<td>You use this program to adjust your charts of depreciation automatically. The program creates an application log, from which you can see if your charts of depreciation were migrated successfully. It also provides a list containing any error messages.</td>
</tr>
<tr>
<td>Data</td>
<td>Accounting (New) ➔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adjustments in Asset</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accounting (New) ➔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Adjust Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>in Chart of</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Depreciation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Timing

<table>
<thead>
<tr>
<th>Timing</th>
<th>IMG path</th>
<th>Program (Technical Name)</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶ <strong>Migration: Asset Accounting (New)</strong> ▶ Adjustments in Asset Accounting (New) ▶ Display Migration Log</td>
<td>FAA_SHOWLOG_MIG2SFIN</td>
<td>You use this program to display the application log for the charts of depreciation that you have adjusted.</td>
<td></td>
</tr>
</tbody>
</table>

### Migrating Transaction Data (Documents)

| Migrating Transaction Data (Documents) | ▶ **Migration of SAP ERP to SAP Accounting powered by SAP HANA** ▶ **Migration** ▶ **Migration: Calculation of Depreciation and Total Values** |  ▶ FINS_MIG_AFA  
▶ FINS_MIG_MONITOR_AFA  
▶ FINS_RECON_RC5  
▶ FINS_MIG_MONITOR_RC5 | For the migration of balances, you initially build plan values for the depreciation. You also check these depreciation values and the total values. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▪ Calculate initial depreciation values</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Display status of “Calculate Initial Depreciation Values”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Check initial depreciation and total values</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Display status of “Check initial depreciation and total values”</td>
<td></td>
</tr>
</tbody>
</table>

### 5.3.1.2.6.2.2 Process Flow for the Migration

You have to adjust the Customizing settings for fixed assets in order to then be able to migrate documents. You transport the Customizing settings to the downstream systems:

![Figure 3: Transporting Customizing Settings](image)

The adjustments to the Customizing settings for fixed assets are described in the following sections. **It is NOT possible to post during the migration.** You cannot post until the adjustments to the Customizing settings for fixed assets and the document migration - as well as other steps within the scope of the migration - have been successfully completed.

> **Recommendation**

We recommend that you lock your users during the entire migration process.
Process

Customizing System

In the Customizing system, the installation of SAP Simple Finance or the upgrade in release and the migration to new Asset Accounting entail the following steps:

1. Perform period-end closing:
   1. You lock the system and users to posting.
   2. You perform a complete period-end closing in Asset Accounting; in addition, you reconcile the general ledger with the Asset Accounting subsidiary ledger.

2. Check prerequisites automatically:
   You check the prerequisites for the migration automatically using program RASFIN_MIGR_PRECHECK (SAP Note 1939592).

3. You back up your data and the system.

4. Install SAP Simple Finance or upgrade your release.

5. You perform the relevant (preparatory) steps for the migration.

6. Migration to new Asset Accounting in SAP Accounting powered by SAP HANA:
   1. You adjust the Customizing settings for your charts of depreciation automatically (or manually).
   2. You check the transaction types manually.

Downstream Systems

In the downstream system (be it the test system or production system), the installation of SAP Simple Finance or the upgrade in release and the migration to new Asset Accounting entail the following steps:

1. Perform period-end closing:
   1. You lock the system and users to posting.
   2. You perform a complete period-end closing in Asset Accounting; in addition, you reconcile the general ledger with the Asset Accounting subsidiary ledger.

2. Check prerequisites automatically:
   You check the prerequisites for the migration automatically using program RASFIN_MIGR_PRECHECK (SAP Note 1939592).

3. You back up your data and the system.

4. Install SAP Simple Finance or upgrade your release.

5. You import the relevant preparatory settings that are necessary to be able to migrate the Customizing for fixed assets.

6. Migration to new Asset Accounting in SAP Accounting powered by SAP HANA:
   1. You import all Customizing settings to the system.
   2. You check whether the import was successful.
5.3.1.2.7 Migration to Asset Management: Preparations and Planning

5.3.1.2.7.1 Migration of Classic to New Asset Management: Preparations and Planning

5.3.1.2.7.1.1 Planning

Schedule the period-end close for Asset Accounting. After the period-end close, no further postings are allowed in the Asset Accounting you were using up to now. In your planning, also take into account the migration for other application components.

5.3.1.2.7.1.2 Preparation

You have to perform the following preparatory steps before you install SAP Simple Finance. You have to perform these steps both in your Customizing system and in any downstream systems. You cannot perform the migration for Asset Accounting until after you have installed SAP Simple Finance and migrated to new General Ledger Accounting.

Process

1. Check prerequisite for using SAP Accounting powered by SAP HANA with new Asset Accounting
   
   Import the \texttt{RASFIN\_MIGR\_PRECHECK} program that is provided with SAP Note \texttt{1939592} to your system and execute the program. For more information, see the program documentation.  
   Make sure that the new depreciation calculation from the Enterprise Extension Financials Extension (EA-FIN) is active.  
   Check whether you can completely archive documents from non-active company codes (this means company codes that only allow subsequent reporting).

2. Lock users.
   
   Lock the users in your system. Make sure that additional postings cannot be generated in the system (except those postings necessary for a period-end closing).

3. Perform period-end closing.
   
   Perform a complete period-end closing in Asset Accounting in your system. Ensure that there are no update terminations from direct postings in the system. You can also check this using program \texttt{RASFIN\_MIGR\_PRECHECK}.

Example

You are migrating your system during the current month.

○ We recommend you recalculate depreciation (transaction \texttt{AFAR}).
Perform a complete period-end closing - if you have not yet done so - for the previous month. You must successfully execute the following activities for this:

- periodic APC postings
- the periodic depreciation run (RAPOST2000)
- the reconciliation of your general ledger with the Asset Accounting subsidiary ledger, both for your leading valuation and for parallel valuations.
- APC-relevant postings may have occurred in the current month in the meantime. You must therefore execute periodic APC postings again immediately before the installation. Make sure that these were successful.

Note:
If you perform the periodic depreciation run before the migration for the current month, it is not possible to post the depreciation run again in the previous month after you have installed SAP Simple Finance. If adjustment postings with consequences for the previous month are posted in the previous month after the installation, then these depreciation values are posted with the posting period that corresponds to the current month.

4. **Perform a backup.**
   Create a backup of your data.

5. **Install SAP Simple Finance**
   Install SAP Simple Finance.

6. **Migrate to New General Ledger Accounting.**
   If you were using the classic General Ledger Accounting until now, your system will be migrated automatically to the new General Ledger Accounting.

### 5.3.1.2.7.2 Adjustments in New Asset Management: Preparations and Planning

#### 5.3.1.2.7.2.1 Planning

Schedule the period-end close for Asset Accounting. After the period-end close, no further postings are allowed in the Asset Accounting you were using up to now. In your planning, also take into account the migration for other application components.

#### 5.3.1.2.7.2.2 Preparation

You have to perform the following preparatory steps before you install SAP Simple Finance or upgrade your release. You have to perform these steps both in your Customizing system and in any downstream systems.
Process

1. **Check prerequisite for using SAP Accounting powered by SAP HANA with new Asset Accounting**

   Import the newest version of the program `RASFIN_MIGR_PRECHECK` that is provided with SAP Note 1939592 to your system and execute the program. If errors occur, correct them and run the program again. For more information, see the program documentation.

   Check whether you can completely archive documents from non-active company codes (this means company codes that only allow subsequent reporting).

2. **Lock users.**

   Lock the users in your system. Make sure that additional postings cannot be generated in the system (except those postings necessary for a period-end closing).

3. **Perform period-end closing.**

   Perform a complete period-end closing in Asset Accounting in your system. Make sure that the periodical APC postings have been performed completely. You can check this using program `RASFIN_MIGR_PRECHECK`.

4. **Perform a backup.**

   Create a backup of your data.

5. **Install SAP Simple Finance**

   Install SAP Simple Finance or upgrade your release.

### 5.3.1.3 Preparing for Migration

To prepare the data of Financial Accounting, Controlling, and Asset Accounting for migration, immediately after installing SAP Simple Finance, execute the Customizing activities under [Migration to SAP S/4HANA Finance > Preparations and Migration of Customizing](https://example.com).

You should perform the activities contained in the following sections of the SAP Reference IMG:

- **Check Customizing Settings Prior to Migration**
- **Define Message Types for Posting Before and During Migration**
- **Set Number of Jobs for Activities in Mass Data Framework**
- **Preparations and Migration of Customizing for General Ledger**
- **Preparations and Migration of Asset Accounting**
- **Preparations and Migration of Customizing for Controlling**

For more information, see the documentation of the Customizing activity.

If you use one of the following applications, also execute the following Customizing activities:

- **Material Ledger**
  
  To do this, execute the Customizing activities in section [Preparations and Migration of Material Ledger](https://example.com).

- **Banking**
  
  To do this, execute the Customizing activities in section [Preparations for Migration of House Bank Accounts](https://example.com).
5.3.1.3.1  Preparations and Customizing Migration in the General Ledger

Before migrating you must perform the necessary preparations and corresponding activities in Customizing. For the steps involved, see Customizing in the section Migration to SAP S/4HANA Finance ➔ Preparations and Migration ➔ Customizing for the General Ledger: Preparations and Migration.

For more details on these steps, see the documentation of the individual steps in the SAP Reference IMG.

Process

Perform the steps in the specified sequence.

1. Activate in the SAP Reference IMG. For more information, see the SAP Reference IMG, section Activate the SAP Reference IMG for Financial Accounting (New).
2. Execute activity Check and Adopt Fiscal Year Variants in the SAP Reference IMG.
5. Execute activity Define Ledger for CO Version.
8. Execute activity Check and Define Standard Values for Postings in Controlling.
9. Execute activity Define Offsetting Account Determination Type.
10. Execute activity Define Source Ledger for Migration of Balances.

5.3.1.3.2  Preparations and Migration of Customizing for Controlling

The Controlling (CO) and Financial Accounting (FI) components have been merged in SAP Simple Finance, on-premise edition. The cost and revenue information in journal entries (table ACDOCA) is now always up to date and permanently reconciled with the income statement.

The new Simplified Profitability Analysis is based on journal entries as well. If you want to use Simplified Profitability Analysis in your operating concern, you need to activate account-based profitability analysis.

Costing-based profitability analysis is still available. You can use either type of profitability analysis, or both in parallel.

However, account-based profitability analysis is the default solution. With account-based profitability analysis, any revenue posting or cost of goods sold posting is updated under the relevant account and assigned to the correct market segment characteristics.
Process

Carry out the following activities in Customizing under SAP Simple Finance Add-On for SAP Business Suite powered by SAP HANA ➤ Preparations and Migration of Customizing ➤ Preparations and Migration of Customizing for Controlling:

1. Execute BW-Delta Extraction for Account-Based CO-PA
2. Adapt Settings for Profitability Segment Characteristics
3. Maintain Operating Concern
4. Maintain Operating Concern for Banking Add-On
5. Activate Account-Based Profitability Analysis
6. Transport Operating Concern

Note
Activities 1 and 2 are only required if you were using Profitability Analysis before migration. If you were not using Profitability Analysis, or are a new customer, these activities not relevant.
Activities 3 to 6 are required if you want to use Profitability Analysis. Keep in mind however that these are not the only Customizing activities you need to carry out in order to use Profitability Analysis.

Effect of the Adapt Settings for Profitability Segment Characteristics activity

The Adapt Settings for Profitability Segment Characteristics activity either migrates or deletes the summarization settings, depending on the following:

- Whether account-based or costing-based profitability analysis is active
- Whether you carry out the activity before or after you select the type of profitability analysis

There are three cases:

<table>
<thead>
<tr>
<th>Case</th>
<th>Sequence</th>
<th>Effect</th>
</tr>
</thead>
</table>
| Case 1 | 1. Costing-based but not Account-based is selected under Type of Profitability Analysis in the definition of the operating concern (transaction KEA0).  
2. You carry out the Adapt Settings for Profitability Segment Characteristics activity. | Summarization settings are migrated. |
| Case 2 | 1. Account-based is selected under Type of Profitability Analysis in the definition of the operating concern (transaction KEA0).  
2. You carry out the Adapt Settings for Profitability Segment Characteristics activity. | Summarization settings are deleted. |
| Case 3 | 1. You carry out the Adapt Settings for Profitability Segment Characteristics activity.  
2. You select Account-based under Type of Profitability Analysis in the definition of the operating concern (transaction KEA0). | Summarization settings are deleted. |
5.3.1.3.3 Customizing in the Production System

Procedure

Perform the following steps in your test system and production system.

1. Import the Customizing settings from your configuration / test system to the production system and check whether the settings have arrived completely.
2. If you have made customer-specific changes in your development or test system and have tested these successfully, then import them to the production system.

5.4 Sales

5.4.1 Order and Contract Management

5.4.1.1 Foreign Trade Replaced By Global Trade Service

Description

With the SAP S/4HANA, on-premise edition 1511, the Foreign Trade functionality of SD is replaced by SAP Global Trade Services (GTS).

For Intrastat, a customer can leverage functions within SAP S/4HANA, on-premise edition 1511. For Letter of Credit, Legal Control and Preference Management, you can use functions based on SAP GTS. SAP GTS is an external service that can be installed on an additional instance. You can integrate SAP GTS natively with SAP S/4HANA.

Additional functions for Import Management and Export Management are available with SAP GTS.

Related SAP Notes

Table 38

<table>
<thead>
<tr>
<th>Custom Code</th>
<th>SAP Note 2223144</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Check</td>
<td>SAP Note 2205202</td>
</tr>
</tbody>
</table>

Required and Recommended Action(s)

- You need to analyze all foreign trade processes currently in use.
- You need to check whether third party Foreign Trade systems are in use for Foreign Trade processes.
• Due to the replaced Foreign Trade functionality in SAP S/4 HANA, the respective third party solution/service provider may have to make adjustments to the third party Foreign Trade systems. However, you can connect SAP Global Trade Services (SAP GTS) to SAP S/4 HANA to run the respective Foreign Trade processes.

More Information

For more information, see the Simplification List [page 0], section 🗄️ Sales & Distribution 🗄️ Foreign Trade in SAP S/4HANA 🗄️

5.4.1.2 Revenue Recognition Replaced by SAP Revenue Accounting and Reporting

Description

⚠️ Note

This chapter is only relevant for customers who have already been using SD Revenue Recognition in SAP ERP. The migration activities before the transformation are mandatory.

SAP ERP SD Revenue Recognition is not available within SAP S/4HANA, on premise edition 1511. You should use the newly available SAP Revenue Accounting and Reporting functions instead. The new functions support the new revenue accounting standard as lined out in IFRS15 and adapted by local GAAP’s. The migration to the new solution is required to comply with IFRS15 even if you do not carry out an conversion to SAP S/4HANA.

Related SAP Notes

Table 39

<table>
<thead>
<tr>
<th>Custom Code</th>
<th>SAP Note 2225170</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Check</td>
<td>SAP Note 2227824</td>
</tr>
</tbody>
</table>

Required and Recommended Action(s)

Prior to the conversion to SAP S/4HANA, you need to migrate all sales order and contracts processed by SD Revenue Recognition to SAP Revenue Accounting and Reporting that are:

• Not fully delivered and invoiced
• Have deferred revenue still to be realized
• For which you expect follow-up activities such as increase quantity, create credit memo, or cancel invoice
Note

With release 1.1 of SAP Revenue Accounting and Reporting, not all functional capabilities of SD Revenue Recognition are available. Examples are:

- Revenue Recognition Type D (billing-based): Invoice cap and exchange rate per invoice are not available
- Call-off Orders: While SD contracts are supported, call-off orders are not available

If you are using SD Revenue Recognition, you need to evaluate if a migration to SAP Revenue Accounting and Reporting is possible for your business before you decide to convert to SAP S/4 HANA, on-premise edition.

For more details on the migration to SAP Revenue Accounting and Reporting, see:

- The application help on SAP Help Portal at help.sap.com/revacc_110
- The migration guide for SAP SD Integration with SAP Revenue Accounting and Reporting on the SAP Service Marketplace at service.sap.com/public/instguides

More Information

For more information, see the Simplification List [page 0], section Sales & Distribution > ERP SD Revenue Recognition.

5.4.1.3 Simplified Data Models in Sales and Distribution (SD)

Description

The following data model simplifications have been implemented for the SD area:

- Elimination of status tables VBUK, VBUP: Status fields have been moved to the corresponding header and item tables VBAK and VBAP for sales documents, LIKP, and LIPS for deliveries, VBRK for billing documents
- Simplification of document flow table VBFA
- Field length extension of SD document category: Data element VBTYP (Char1) has been replaced by data element VBTYPL (Char4), also: elimination of field VBTYP_EXT (Char4)
- Elimination of redundancies – Document Index Tables VAKPA, VAPMA, VLKPA, VLPMA, VRKPA, VRPMA
- Elimination of redundancies – Rebate Index Table VBOX

For details, see Optimization of SD Rebate Processing for Trade Promotion Management [page 126].

The key Benefits of the data model changes are:

- Reduced memory footprint (simplified Document Flow, elimination of index tables, fewer aggregates)
- Increased performance of SAP HANA queries and code pushdown (one select statement instead of two select statements, easier join for header/items including status and business data)
- Increased robustness of rebate processing (no redundancies due to aggregates)

The changes are described in more detail in the guidelines attached to the related SAP note 2198647.
Required and Recommended Action(s)

1. Adapt customer coding according to the custom code check results.
   See SAP note [2198647](#) for a detailed description.

2. If you have added an append structure to database tables VBUK or VBUP (document status header and item table) in the source release to store additional data for documents that are persistent in tables VBAP, LIKP, or VBRK, and you want to use these fields in SAP S/4 HANA, you must add the appended fields to the respective document tables.

   You must add an append field to document header status table VBUK to one or several of the document header tables VBAK, LIKP, or VBRK, depending on which of the document types the respective field is relevant for.

   You must add an append field to document item status table VBUP to one or several of the document item tables VBAP or LIPS, depending on which of the document types the respective field is relevant for.

   Each append field must have the same name and data type as in the source table, and you need to append each one to the table-specific status include structure (ODIC structures VBAK_STATUS, LIKP_STATUS, VBRK_STATUS, VBAP_STATUS, or LIPS_STATUS). Only then will the field be considered by the automatic data conversion from VBUK to VBAK/LIKP/VBRK and from VBUP to VBAP/LIPS, as well as by read function modules that can be used to replace direct SELECTs to the deprecated status tables VBUK/VBUP.

   Note
   Do not choose a different field name or data type. Do not append the field directly to the document table.

   Several append structures can exist for one status include structure.

   The following 2 cases show when you have to add the append fields to the status include structures in order to transfer the data automatically during the SAP S/4 HANA transformation:

   ○ In the development system, you have to add the fields during phase ACT_UPG when you are prompted for SPDD.

   ○ In all other systems, you can use modification adjustment transports or customer transport integration during the upgrade-like conversion.

   The append fields must be contained in one of the custom transport requests from the development system.

   The pre-check class CLS4H_CHECKS_SD_DATA_MODEL delivered with SAP note [2224436](#) provides a check for such append fields, and issues a warning if such append fields are recognized in the source release. The warning refers to the necessary action for appending fields to the status include structures.
5.4.1.4 Data Model Changes in SD Pricing

Description

Business documents within the SAP Business Suite such as the sales order or the purchase order used to store the pricing result in the database table KONV. In SAP S/4HANA, table KONV has been replaced in its data persistency role by the new table PRCD_ELEMENTS. However, KONV is and can still be used for data declaration purposes. It still defines the structure of the pricing result within the application coding. The content of KONV is transferred to PRCD_ELEMENTS when moving to SAP S/4HANA.

Within condition technique, the following DDIC changes and interface changes have been made:

- DDIC changes
  - The concatenated variable key field VAKEY of a condition table has been removed from all condition header tables, including KONH (pricing), NACH (output determination), KOND3 (campaign determination), KOND4 (free goods determination), KONHM (portfolio determination), J_3GPRLHD (CEM price list determination), and WIND (document index). The concatenated variable data field VADAT has also been removed. This has been done to avoid data migration of these tables as a result of the material number extension
  - For internal processing, long data elements VAKEY_LONG and VADAT_KO_LONG with the length CHAR255 have been introduced
  - The content of the new long VAKEY and VADAT can be determined at runtime using methods of the service class CL_COND_VAKEY_SRV

- Interface changes:
  - Batch input of price condition records (program RV14BTCI):
    - For compatibility reasons, the field VAKEY_LONG (CHAR255) was added to the batch input structures. If this field is filled or used by external programs, then the content of this field is used instead of the content of the still existing field VAKEY.
  - IDOC COND_A for price condition records:
    - For compatibility reasons, the fields MATNR_LONG (CHAR40), UPMAT_LONG (CHAR40), BOMAT_LONG (CHAR40), VAKEY_255 and VADAT_255 have been added to the COND_A IDOC segments. If these fields for the extended material number or long VAKEY/VADAT are to be filled in addition to the still existing short fields, then the content of the long fields has priority.

Several data elements have been extended, especially the key field ZAEHK in the KONV with the data element DZAEEK.

The maximum number of possible accesses in an access sequence (DTEL KOLNR) has been increased from 99 to 999. Therefore, the solution described in SAP Note 1812828 is no longer necessary nor valid. Any content from this solution will be automatically transferred to the standard tables during the conversion process to SAP S/4HANA.
Table 41

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Description</th>
<th>Former Length</th>
<th>New Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>KOLNR, EVSNR, FSELNR</td>
<td>Number of Access in Access Sequence</td>
<td>NUMC2</td>
<td>NUMC3</td>
</tr>
<tr>
<td>DZAEHK, DZAEHK_IND,</td>
<td>Condition Counter in Pricing Result</td>
<td>NUMC2</td>
<td>NUMC3</td>
</tr>
<tr>
<td>DZAEKO, BBP_ZAEHK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KOBED, KOFRM, KOFRA,</td>
<td>Pricing Formula and Requirement Number</td>
<td>NUMC3</td>
<td>NUMC7</td>
</tr>
<tr>
<td>GRLNR KOFRS</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following elements have also been changed in KONV:

Table 42

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Field is obsolete and will not be transferred to PRCD_ELEMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>STUFE</td>
<td>Level (in multi-level BOM explosions)</td>
<td></td>
</tr>
<tr>
<td>WEGXX</td>
<td>Path (for multi-level BOM explosions)</td>
<td></td>
</tr>
<tr>
<td>KOLNR3</td>
<td>Access Sequence · Access Number</td>
<td>Field is obsolete. Possible field content will be merged with content of KOLNR and moved to PRCD_ELEMENTS</td>
</tr>
</tbody>
</table>

Impact

KONV is no longer valid for reading or writing pricing result data. The access to pricing data must be done either through dedicated APIs or (for reading) through the CDS view V_KONV_CDS. Both approaches take care of the conversion between PRCD_ELEMENTS (that is data base format) and KONV (that is application internal format).

The concatenated variable fields VAKEY and VADAT have been removed from condition header tables (for example, KONH). If the content of concatenated fields VAKEY or VADAT is used in custom code, then you need to use the methods of the new service class CL_COND_VAKEY_SRV.

Related SAP Notes

Table 43

<table>
<thead>
<tr>
<th>Custom Code</th>
<th>SAP Note</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2220005</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pre-Check</th>
<th>SAP Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2188735, 2188695, 2189301</td>
</tr>
</tbody>
</table>

Required and Recommended Actions

- Follow the instructions in SAP notes 2188695, 2189301, and 2220005 carefully.
SAP provides migration reports centrally to migrate data from the old database table KONV to the new database table PRCD_ELEMENTS.

However, the document currency field WAERK of table PRCD_ELEMENTS needs to be filled with the currency of the related document header. To reduce downtime, it was decided to move this step to the post-processing phase. Within migration, the currency is filled with the technical currency '2', allowing the system to convert PRCD_ELEMENT to KONV format correctly, and vice versa. However, to fill the currency consistently in accordance with the related document, SAP recommends that you run the post-processing report PRC_MIG_POST_PROCESSING as soon as possible.

If you have added one or more append structures to database table KONV in the source release to store additional data, and you want to use these fields in SAP S/4 HANA, you need to add the appended fields to the new database tables PRCD_ELEMENTS and PRCD_ELEM_DRAFT. Each append field must have the same name and data type as it does in the source table.

The following 2 cases show when you have to add the append fields to the tables PRCD_ELEMENTS and PRCD_ELEM_DRAFT:

○ In the development system, you have to add the fields to PRCD_ELEMENTS during phase ACT_UPG, when you are prompted for SPDD.

  This is necessary to ensure that the automatic data migration transfers the field content from KONV to PRCD_ELEMENTS during the upgrade-like conversion.

  You can add the append fields to table PRCD_ELEM_DRAFT in the development system later, as this table is not relevant for the automated migration.

○ In all other systems, you can use modification adjustment transports or customer transport integration during the upgrade-like conversion for the appends to tables PRCD_ELEMENTS and PRCD_ELEM_DRAFT.

  The append fields must be contained in one of the custom transport requests from the development system.

The pre-check delivered with SAP note 2188735 provides a check for such append fields, and issues a warning if such append fields are recognized in the source release.

The warning refers to the necessary action for adding the append fields to the new database tables.

More Information

For more information, see the Simplification List [page 0], section Sales & Distribution › Data Model Changes in SD Pricing.
5.5 Supply Chain

5.5.1 Efficient Logistics and Order Fulfillment

5.5.1.1 Simplified Data Model in Inventory Management (MM-IM)

Description

The following data model simplifications have been implemented for the MM-IM area:

Introduction of the new single denormalized table MATDOC (Material Documents) instead of the following existing tables:

- MKPF (Material Document table for document header information)
- MSEG (Material Document table for document item data)

The new table MATDOC contains the header information and item data of a material document as well as additional attributes. Material document data will only be stored in MATDOC and not in the tables MKPF and MSEG. The actual stock quantity fields in the material master tables such as MARD (Storage Location Data for Material) and MCHB (Batch Stocks), are not updated. The actual stock quantities will be calculated on-the-fly from the new material document table MATDOC.

The compatibility with the data in the tables of the SAP ERP 6.0 product is ensured through compatibility Core Data Service (CDS) views. These compatibility CDS views are assigned as proxy objects for all of those tables to ensure that each read access will still return the data as in SAP ERP 6.0. This will be ensured by reading the master data attributes from the master data parts of those tables and the on-the-fly calculation of actual stock from MATDOC.

The changes and the migration prerequisites for MM-IM data to the SAP S/4HANA data model are described in SAP Note 2206980.

Related SAP Notes

Table 44

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2206980</td>
<td>Material Inventory Management: change of data model in S/4HANA</td>
</tr>
<tr>
<td>2238690</td>
<td>S/4HANA MM-IM migration by SUM</td>
</tr>
<tr>
<td>2236753</td>
<td>S/4HANA MM-IM migration: error or post-processing messages</td>
</tr>
</tbody>
</table>

Required and Recommended Action(s)

To migrate from your SAP ERP 6.0 to the simplified data model of SAP S/4HANA Supply Chain (MM - Inventory Management), check the following SAP Notes:
1. Prepare the initial system adjustment: If you have customer enhancements, modifications or your own functionalities, adjust them first.

   See SAP Note 2206980 for a procedure on how to do this.

2. Prepare for the Software Update Manager process: Enter batch processes in the SUM preparation step that the MM-IM migration programs can run in parallel to reduce the runtime.

   See SAP Note 2238690 for a detailed description.

More Information

For more information, see the Simplification List [page 0], section Logistics Material Management Inventory Management (MM-IM) > Data Model in Inventory Management (MM-IM).

5.6 Environment, Health, and Safety

Before you start the conversion to Environment, Health, and Safety, perform EHS specific pre-checks to identify activities you have to carry out before the conversion.

For general information, see Pre-Checks [page 19] in the Conversion Process section.

5.6.1 Conversion from Component Extension for SAP EHS Management

Before you start the conversion from Incident Management or from Risk Assessment of component extension for SAP EHS Management to Incident Management or to Health and Safety Management of Environment, Health, and Safety, perform the EHS-specific pre-checks.

For more information, see the following SAP Notes:

- For the pre-checks, see SAP Note 2194368.
- For information about the result of the pre-checks, see the SAP Note 2194782.

Note that some functions are not available in the SAP S/4HANA on-premise edition. If you use development objects of these functions in your custom coding, carry out the activities as described in SAP Note 2217208.

5.6.2 Conversion from EHS Management as part of SAP ERP

Before you start the conversion from Industrial Hygiene and Safety (EHS-IHS) of EHS Management as part of SAP ERP to Incident Management or to Health and Safety Management of Environment, Health, and Safety, perform the EHS-specific pre-checks.

For more information, see the following SAP Notes:

- For the pre-checks, see SAP Note 2198401.
5.7  Product Safety and Stewardship for Process Industries

Before converting from an SAP ERP system to an SAP S/4HANA system, carry out the following:

1. Check all items listed under Logistics: PSS in the Simplification List.
2. In particular, check the restrictions described in SAP Note 2221717.
3. Carry out the checks for business partners with the partner function of the MSDS recipient, as described below.

Checks for Business Partners

You use the report shipping functionality, and you have defined contact persons as safety data sheet (SDS) recipients within the customer master.

During the conversion of an ERP system to an SAP S/4 HANA system, customer master data is synchronized with SAP Business Partner data. As part of this data synchronization, contact person data in the table Customer Master Contact Partner (KNVK) is replicated to the table BP Relationship: Contact Person Relationship (BUT051). In order to ensure that contact persons with the function SDS recipient are synchronized correctly with the corresponding business partner table, additional configuration steps have to be carried out.

Prerequisites

- Within configuration for Environment Health and Safety, under Basic Data and Tools > Basic Settings > Specify Environment Parameters, you have specified a value for the environment parameter Function number for MSDS contact person (SRE_DS_SDSREC), for example the value SR.
- You have defined the same code as a function for contact persons under Sales and Distribution > Master Data > Business Partners > Contact Person > Define Contact Person Functions.
- You have maintained contacts persons with this function code in the customer master.

This SDS recipient function code must also be maintained as the contact person function within the SAP Business Partner configuration and the Master Data synchronization for Customer/Vendor Integration. SAP recommends...
you use the same function code for SDS contact persons in the customer master and for the corresponding function for SAP business partner contact persons. To do so, carry out the following:

1. Define an SAP business partner function for SDS recipients.

   The corresponding setting for the contact person function can be found in Customizing under [Cross-Application Components > SAP Business Partner > Business Partner Relationships > Contact Person > Define Functions].

2. Link the customer master contact person function for SDS recipients to the corresponding business partner contact person function.

   The corresponding settings for master data synchronization can be found in Customizing under [Cross-Application Components > Master Data Synchronization > Customer/Vendor Integration > Business Partner Settings > Settings for Customer Integration > Field Assignment for Customer Integration > Assign Attributes > Contact Person > Assign Functions of Contact Person].

### 5.8 Business Network Integration

SAP S/4HANA currently supports integration scenarios with the Ariba Network for purchase order and invoice collaboration.

#### 5.8.1 Conversion from Ariba Network Integration for SAP Business Suite

When preparing the conversion from the SAP ERP add-on Ariba Network Integration for SAP Business Suite to SAP S/4HANA, you have to perform the activities described below:

**Unschedule Reports**

You have to unschedule all reports that you have been using in the add-on Ariba Network Integration for SAP Business Suite.

**Safeguard Customizing Settings**

All relevant Customizing settings are converted automatically. We recommend that you keep a record of all settings that exist in Customizing for SAP Business Suite Integration Component for Ariba. This allows you to compare the settings after the conversion and make adaptations, if necessary.
6  Performing Follow-Up Activities

In the following sections, you will find manual activities you have to carry out after the Software Update Manager has finished the automated conversion steps successfully. This is a subset of all activities that might be required to adapt your system to SAP S/4HANA, on-premise edition. For information about further adaptations for other capabilities of SAP S/4HANA, see the simplification list.

More Information

Review the Simplification List [page 0 ]

6.1  Cross-Application Follow-Up Activities

6.1.1  Adapting Database Extensions to SAP S/4HANA

When you convert your system from SAP Suite on HANA to SAP S/4HANA, modifications to the SAP HANA database remain unchanged. However, to make your modifications visible on the UI, manual steps can be required in different content layers.

Procedure

1. If required for your modifications, adapt the relevant CDS views in the SAP Business Suite layer. You can extend CDS views by using ABAP development tools. For more information, see help.sap.com/abapdocu_740/en/index.htm ➔ ABAP Dictionary ➔ ABAP CDS in ABAP Dictionary ➔ ABAP CDS - Views ➔ ABAP CDS - EXTEND VIEW ➔.

2. If required for your modifications, adapt the OData services for your CDS views in the SAP NetWeaver Gateway layer:
   ○ For OData services that are included in a CDS view definition as an annotation, the relevant artifacts are generated automatically. No modifications are required in the SAP NetWeaver Gateway layer. For more information, see help.sap.com/s4hana_op_1511_001 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ Application Server ➔ Application Server ABAP ➔ Application Development on AS ABAP ➔ ABAP Development Tools - Eclipse ➔ ABAP CDS Development User Guide ➔ Exposing CDS view as OData Service ➔.
   ○ OData services that are not included in a CDS view definition must be redefined in Service Builder. For more information, see help.sap.com/s4hana_op_1511_001 ➔ SAP NetWeaver for SAP S/4HANA ➔ Function-Oriented View ➔ SAP Gateway Foundation (SAP_GWFND) ➔ SAP Gateway Foundation Developer Guide ➔ SAP Gateway Service Builder ➔ Data Modeling Basics ➔ Data Modeling Options ➔ Redefining Services ➔.

3. If available for your app, you can use runtime adaptation to add, move, or remove view fields in the UI layer.
   For more information, see Adapting the User Interface [external document]. As an alternative, you can extend...
views by using SAP UI5 extension points. For more information, see help.sap.com/s4hana_op_1511_001
SAP NetWeaver for SAP S/4HANA > Function-Oriented View > UI Technologies in SAP NetWeaver > SAPUI5: UI Development Toolkit for HTML5 > Extending Apps > View Extension.

6.2 Finance

6.2.1 Data Migration

Prerequisites

- You have performed all activities and preparatory steps that are explained in the following:
  - Prior to Installing [page 38]
  - Consistency Checks Before Installation and Migration [page 40]
  - Check Customer-Defined Coding [page 40]
  - Handling Customer-Defined Fields and Interfaces [page 41]
  - Period-End Closing Activities [page 42]
  - Business Reconciliation Before Migration [page 43]
  - Customizing Import into the Production System [page 62]

- You have removed all inconsistencies and errors.

- You have successfully installed SAP S/4HANA Finance. For more information about installation, see the Installation Guide under help.sap.com/sfin300 > Installation and Upgrade Information > Administrators Guide

- You have copied your Customizing settings from the configuration/test system to your production system.

- You have tested your customer-specific changes in the test or development system and corrected any errors. You then copied the changes to your production system.

Activities

You can now execute the migration. After installing SAP S/4HANA Finance, you will find all migration steps listed in Customizing in the section Migration to SAP S/4HANA Finance > Migration.

1. Partition the table for the journal entry. To do so, execute the Customizing activity Partitioning of Universal Journal Entry Line Items Table. For more information, see the documentation of the activity.

2. Execute activity Regenerate CDS Views and Field Mapping.

3. Execute the activity Analyze Transactional Data.

4. Execute the activity Display Status of Analysis of Transaction Data.

5. Now execute all activities in the order they are listed in the following sections.
6.2.1.1 Migration to Asset Accounting: Execution

6.2.1.1.1 Migration from Classic to New Asset Accounting: Execution

6.2.1.1.1.1 Customizing Settings

To migrate to new Asset Accounting in SAP Accounting 1503 powered by SAP HANA, you have to migrate your Customizing data. The following sections describe how to do this.

Before migrating your Customizing data for new Asset Accounting, you must have checked the prerequisites and have executed the preparatory steps. For more information, see Migration Flow [page 49] and Preparation [page 57].

Depending on what your starting situation is as regards Asset Accounting before the installation of SAP Simple Finance, different steps, which are to be executed manually or automatically, may be necessary. One of the following starting scenarios can be in your system:

- **I.** Classic General Ledger Accounting and classic Asset Accounting with accounts approach
- **II.** New General Ledger Accounting and classic Asset Accounting with accounts approach
- **III.** New General Ledger Accounting and classic Asset Accounting with ledger approach

The migration is divided into the steps outlines below. The steps that are relevant for you depend on which starting scenario you begin with.

**Process**

The following are the steps for the migration of new Asset Accounting in your Customizing system:

- a. You migrate the Customizing settings for your charts of depreciation automatically (or manually).
- b. You make additional Customizing settings manually.
- c. You check the prerequisites for activating new Asset Accounting.
- d. You activate new Asset Accounting.

Then you start with the migration of transaction data. After the migration has been successfully completed, postings can be made in the system again.

The following are the steps for the migration of new Asset Accounting in your downstream systems (test system or production system):

- a. Manual tasks: You create G/L account master data if this data is not transported; you create number ranges, if necessary.
- b. You import all settings to the system.
- c. You check whether the transport was successful, including the import of the activated Customizing switch.

For subsequent systems, the following also applies: Then you start with the migration of transaction data. After the migration has been successfully completed, postings can be made in the system again.
6.2.1.1.1.1 Automatic Migration of Active Charts of Depreciation

The following table shows an overview of the steps that you can/have to follow, in all three start scenarios:

Here are the start situations:

- I. Classic General Ledger Accounting and classic Asset Accounting with accounts approach
- II. New General Ledger Accounting and classic Asset Accounting with accounts approach
- III. New General Ledger Accounting and classic Asset Accounting with ledger approach

<table>
<thead>
<tr>
<th>Table 45</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
</tr>
<tr>
<td>1. Determine chart of depreciations to be migrated</td>
</tr>
<tr>
<td>2. Check accounting principle.</td>
</tr>
<tr>
<td>3. Check Ledger Group</td>
</tr>
<tr>
<td>4. Assign accounting principle to ledger group</td>
</tr>
<tr>
<td>5. Check settings for the ledger of the journal entry</td>
</tr>
<tr>
<td>6. Migrate active charts of depreciation.</td>
</tr>
<tr>
<td>7. Display migration log.</td>
</tr>
<tr>
<td>8. Migrate non-active charts of depreciation</td>
</tr>
</tbody>
</table>

Process

The individual steps of the migration are described in detail in the following.

Regarding 1) Determine charts of depreciation to be migrated

You must migrate all active charts of depreciation in your system, that is, charts of depreciation that are assigned to a company code. You can use the following activity to check which charts of depreciation are active in your system.

Customizing activity: [Asset Accounting (New) > Organizational Structures > Assign Chart of Depreciation to Company Code]

You must make a distinction between company codes that are still being used actively and ones that are only being used for subsequent reporting purposes (and as such are not active).

- Active company code (status 0, 1, 2): You can migrate the chart of depreciation automatically using the migration program.
- Non-active company code (status 3 company code deactive - subsequent reporting allowed): You must migrate the chart of depreciation manually. The chart of depreciation must only be migrated if it still has data. If all data on the assigned company codes is archived, then it is not necessary to migrate the chart of depreciation.

Background: Documents can only be migrated when the chart of depreciation is migrated. Archived documents are not migrated.

Customizing activity: [Asset Accounting (New) > Asset Data Transfer > Set Company Code Status]
Regarding 2) Check accounting principle.

In new Asset Accounting, the system posts a separate document for each valuation. It is necessary for you to have created an accounting principle for each valuation. Check if the necessary accounting principles exist for your valuations.


Regarding 3) Check Ledger Group

Check whether ledger groups with the corresponding representative ledgers exist in the system for the relevant valuations of your company codes.

The following applies to the ledger approach: Each valuation (so each leading and also each parallel valuation) is stored in a separate book (ledger) in General Ledger Accounting. You post to ledgers by means of the ledger group. (The ledger group contains one or more ledgers.) For recording the leading valuation in the system, SAP provides ledger group OL with the leading ledger for example. For parallel valuations, you have to create further ledgers (and ledger groups).

Customizing activity:

Example

Example for the ledger approach:

<table>
<thead>
<tr>
<th>Valuation</th>
<th>Ledger Group</th>
<th>Ledger</th>
<th>Ledger is representative ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leading valuation</td>
<td>OL</td>
<td>OL</td>
<td>X</td>
</tr>
<tr>
<td>Parallel valuation I</td>
<td>N1 (1)</td>
<td>N1</td>
<td>X</td>
</tr>
</tbody>
</table>

Explanation:
(1) You can freely assign the key for the ledger group.

The following applies for the accounts approach: Each (leading and parallel) valuation is represented using a set of G/L accounts. In the general ledger, all balances are updated in one ledger, regardless of the valuation. Technically this is the ledger that is flagged as the leading ledger in your system.

In order for it to be possible to group the depreciation areas according to the type of valuation, it is necessary (for technical reasons) that a ledger group exists in the system for each accounting principle (valuation). This ledger group must always contain the leading ledger.

SAP provides the leading ledger OL with the same named ledger group OL by default. The ledger group OL contains the ledger OL as the representative ledger. For each of your parallel valuations, you have to create a (new) ledger group that contains the leading ledger.

Example

Example for the accounts approach:
Table 47

<table>
<thead>
<tr>
<th>Valuation</th>
<th>Ledger Group</th>
<th>Ledger</th>
<th>Ledger is representative ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leading valuation</td>
<td>OL</td>
<td>OL</td>
<td>x</td>
</tr>
<tr>
<td>Parallel valuation I</td>
<td>&amp;30&amp; (1), (2)</td>
<td>OL</td>
<td>x</td>
</tr>
</tbody>
</table>

Explanation:
- (1) If you create the ledger group manually, you can choose any name for the key.
- (2) As another option, you can have the system generate the ledger group for the parallel valuation. Start the migration program for this (in Customizing for Asset Accounting (New) under Migration from Classic to New Asset Accounting > Migration for New Asset Accounting > Migrate Charts of Depreciation).

The migration cannot take place due to the missing ledger group for parallel valuation and the missing assignment of this ledger group to an accounting principle. However, the system generates a ledger group. Its name consists of the following parts:

&<Number of the leading depreciation area of the parallel valuation>&.

Adjust the name of the ledger group. You must execute the migration program again later to migrate the chart of depreciation.

Regarding 4) Assign accounting principle to ledger group.

One ledger group is always assigned uniquely to one accounting principle. Check whether an appropriate ledger group is assigned to the accounting principles that represent the valuations you need. If not, assign the needed accounting principles.


Recommendation

To ensure a unique assignment of one ledger group to an accounting principle, a ledger group that is used in Asset Accounting is only allowed to be assigned to one accounting principle. If a ledger group is assigned to more than one accounting principle, the migration program cannot assign the accounting principle automatically. You have to assign the accounting principles manually.

Customizing activity: Asset Accounting (New) > Integration with General Ledger Accounting > Define How Depreciation Areas Post to General Ledger.

Note

The ledger group assigned to the accounting principle is not allowed to contain the so-called appendix ledger as Asset Accounting is not integrated with the appendix ledger.

Regarding 5) Check settings for the ledger of the journal entry

For the relevant valuations, check in the company code settings of the ledger whether the accounting principle is assigned.

Regarding 6) Migrate active charts of depreciation.

The migration program migrates your existing charts of depreciation in accordance with the requirements of new Asset Accounting. The prerequisite for this is that the starting scenario represented in your chart of depreciation is known to the migration program. The migration program distinguishes between the accounts approach and the ledger approach.

The migration program migrates the active charts of depreciation that were not yet migrated, either automatically or manually, or were not created as new in SAP Accounting powered by SAP HANA.

You can perform it either in a test run or in an update run.

Both in a test run and an update run, the system creates a log for the migration. You can call this as follows:

- In the Customizing activity Migration for New Asset Accounting by choosing the Job Log pushbutton
- In the Customizing activity Display Migration Log

The following describes how the charts of depreciation are converted during the migration (for the accounts approach and the ledger approach). If it is not possible for the system to convert a chart of depreciation automatically during the migration, you have to make the adjustments manually.

In addition, the migration program determines if the ledger approach or accounts approach applies, and sets an internal indicator to this effect. If your chart of depreciation had only one posting depreciation area (that is, only one valuation that posts to the general ledger), the system sets the indicator for the accounts approach.

The chart of depreciation is migrated in such a way that there is no longer any area that posts periodically. Both areas that represent a parallel valuation as well as reserve for special depreciation areas post in real-time.

Starting scenario: Classic Asset Accounting with accounts approach

Example

<table>
<thead>
<tr>
<th>Area</th>
<th>Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
<td></td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td>(0) Area Does Not Post</td>
<td>01</td>
<td></td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>(2) Periodic or (4) Direct posting</td>
<td>01</td>
<td></td>
</tr>
<tr>
<td>31 Area in parallel currency of (parallel) valuation II</td>
<td>(0) Area Does Not Post</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

The following applies for a chart of depreciation for new Asset Accounting with the accounts approach:

- Definition of depreciation area: Assignment to an accounting principle:
  - All areas have to be assigned to an accounting principle.
  - All areas that represent the same valuation have to be assigned to the same accounting principle.
  - The system automatically assigns the ledger group assigned to the accounting principle.

- Definition of depreciation area: Posting in G/L:
○ *Area Posts in Realtime* is set for the leading area of the leading valuation.

○ *Area Posts APC Immediately, Depreciation Periodically* is also set for the leading area of the parallel valuation.

○ A derived area (for example, for reserve for special depreciation) that posts to the general ledger has the indicator *Area Posts APC Immediately, Depreciation Periodically*.

- Transfer of APC values:
  ○ The leading area of a valuation always has the entry 00, meaning that it *never* adopts values from another area.
  ○ The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.
  ○ Exception: Depreciation areas for investment support shown on the liabilities side always have the entry 00.

- Specify transfer of depreciation terms:
  The same applies here as for the adoption of APC values.

---

### Example

Migrated chart of depreciation for new Asset Accounting with the accounts approach:

Table 49

<table>
<thead>
<tr>
<th>Area</th>
<th>Accounting Principle (AP) -&gt; Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values (2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>API -&gt; 0L</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td>API -&gt; 0L</td>
<td>(0) Area Does Not Post</td>
<td>01</td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>APII -&gt; &amp;30&amp;</td>
<td>(4) Area Posts APC Immediately, Depreciation Periodically(1)</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>31 Area in parallel currency of (parallel) valuation II (2)</td>
<td>APII -&gt; &amp;30&amp;</td>
<td>(0) Area Does Not Post</td>
<td>30</td>
</tr>
</tbody>
</table>

**Explanation:**

(1) *Area Posts APC Immediately, Depreciation Periodically:* With this option, the postings in the general ledger are now made at the same time (immediately). It is **no longer** possible for the update to terminate for only one area (as in classic Asset Accounting with posting option 4 (direct update); subsequent postings with the APC posting program are therefore **no longer** necessary and **no longer** possible.

(2) The requirements for the adoption of depreciation terms are essentially the same as those for the transfer of APC values.

(3) For parallel valuation, it is **not** absolutely necessary that there has to be an area in the parallel currency.
Starting scenario: Classic Asset Accounting with ledger approach

Example

Starting scenario: Classic Asset Accounting with ledger approach

Table 50

<table>
<thead>
<tr>
<th>Area</th>
<th>Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>OL</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (initial)</td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td></td>
<td>(0) Area Does Not Post</td>
<td>01</td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>N1</td>
<td>(3) Area Posts Depreciation Only</td>
<td>01</td>
</tr>
<tr>
<td>31 Area in parallel currency of (parallel) valuation II</td>
<td></td>
<td>(0) Area Does Not Post</td>
<td>30</td>
</tr>
<tr>
<td>60 Delta area in local currency (30-01)</td>
<td>N1</td>
<td>(6) Area Posts Only APC Directly</td>
<td>(Not definable)</td>
</tr>
<tr>
<td>61 Delta area in parallel currency (31-02)</td>
<td></td>
<td>(0) Area Does Not Post</td>
<td>(Not definable)</td>
</tr>
</tbody>
</table>

Explanation:

(1) Note: If there are no areas for parallel currencies in the chart of depreciation, but parallel currencies are assigned for the company code to parallel (non-leading) ledgers in new General Ledger Accounting, then you have to create these parallel depreciation areas in classic Asset Accounting first before you install SAP Simple Finance.

The following applies for a chart of depreciation for new Asset Accounting with the ledger approach:

- Definition of depreciation area: Assignment to an accounting principle:
  - All areas have to be assigned to an accounting principle.
  - All areas that represent the same valuation have to be assigned to the same accounting principle.
  - The system automatically assigns the ledger group assigned to the accounting principle.

Definition of depreciation area: Posting in G/L:

- Area Posts in Realtime is set for the leading area of the leading valuation.
- Area Posts in Realtime is also set for the leading area of the parallel valuation.
- A delta area is no longer needed. The system sets the indicator to (0) Area Does Not Post.
- A derived area (for example, for reserve for special depreciation) that posts to the general ledger has the indicator Area Posts APC Immediately, Depreciation Periodically

- Definition of depreciation area: Delta areas for reporting
  - For delta areas used until now, the migration program automatically sets Area for reporting purposes only.
  - You can continue to use these areas for reports.

- Transfer of APC values:
For the transfer of APC values, the leading areas of a valuation always has the entry 00 (initial), that is, it does not adopt any values from another depreciation area.

The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.

Exception: Depreciation areas for investment support shown on the liabilities side always have the entry 00.

Specify transfer of depreciation terms:
The same applies here as for the adoption of APC values.

---

**Example**

Migrated chart of depreciation for new Asset Accounting with the ledger approach:

<table>
<thead>
<tr>
<th>Area</th>
<th>AP -&gt; Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>API -&gt; 0L</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td>API -&gt; 0L</td>
<td>(0) Area Does Not Post</td>
<td>01</td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>APII -&gt; N1</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>31 Area in parallel currency of (parallel) valuation II</td>
<td>APII -&gt; N1</td>
<td>(0) Area Does Not Post</td>
<td>30</td>
</tr>
<tr>
<td>60 Delta area in local currency (30-01)</td>
<td>APII -&gt; N1</td>
<td>(0) Area Does Not Post</td>
<td>(Not definable)</td>
</tr>
<tr>
<td>61 Delta area in parallel currency (31-02)</td>
<td>APII -&gt; N1</td>
<td>(0) Area Does Not Post</td>
<td>(Not definable)</td>
</tr>
</tbody>
</table>

---

**Executing the Migration Program**

**Recommendation**

We recommend that you execute the migration program as a test run first. Check the log of the test run and correct the errors before you start the program as an update run.


**Regarding 7) Display migration log**

Both in a test run and in an update run, the system creates a log for the migration, which you can call at any time. The log shows the processing of the charts of depreciation. As soon as the value for an indicator or field in the depreciation area definition of the chart of depreciation changes, this is displayed as a message in the log.

The migration program issues a message for each chart of depreciation. The message informs you if the chart of depreciation was migrated successfully.
Regarding 8) Migrate non-active charts of depreciation manually

You have charts of depreciation in your system that are assigned to a non-active company code. This means they are assigned to a company code that only allows subsequent reporting. The data of this non-active company code is still not archived; it must therefore be migrated with the document migration. You must therefore definitely migrate this chart of depreciation manually.

For more information, see Manual Migration of Charts of Depreciation and Checking of Settings [page 83].

6.2.1.1.1.1.2 Manual Migration of Charts of Depreciation and Checking of Settings

The steps outlined below are relevant for you in the following cases:

- You want to again check the Customizing settings that were changed by the automatic migration of the chart of depreciation.
- The starting scenario that underlies your chart of depreciation does not allow automatic migration using the migration program.
  In that case you have to migrate the chart of depreciation manually.
- You want to migrate the chart of depreciation manually from the outset.
- You have charts of depreciation in your system that are assigned to a non-active company code. This means they are assigned to a company code that only allows subsequent reporting. The data of this company code is not yet archived.

Process

1) Determine active charts of depreciation.

For more information, see Automatic Migration of Active Charts of Depreciation [page 76].

2) Check accounting principle

For more information, see Automatic Migration of Active Charts of Depreciation [page 76].

3) Check Ledger Group

For more information, see Automatic Migration of Active Charts of Depreciation [page 76].

4) Assign accounting principle to ledger group.

For more information, see Automatic Migration of Active Charts of Depreciation [page 76].

5) Check settings for the ledger of the journal entry

For more information, see Automatic Migration of Active Charts of Depreciation [page 76].

6) Change definitions of depreciation areas.

1. Assign an accounting principle to each depreciation area. The system automatically assigns the related ledger group to the depreciation area. The following information applies to this assignment:
   ○ All areas have to be assigned to an accounting principle.
All areas that represent the same valuation have to be assigned to the same accounting principle.

The system automatically assigns the ledger group assigned to the accounting principle.

2. You have to modify the setting for Posting in G/L. Using these indicators, you specify whether and how APC and depreciation from the depreciation area are posted to the general ledger.

The following applies for the accounts approach:
- **Area Posts in Realtime** is set for the leading area of the leading valuation.
- **Area Posts APC Immediately, Depreciation Periodically** is also set for the leading area of the parallel valuation.

The following applies to the ledger approach:
- **Area Posts in Realtime** is set for the leading area of the leading valuation.
- **Area Posts in Realtime** is also set for the leading area of the parallel valuation.
- Delta depreciation areas are **no longer** needed in Asset Accounting. For former delta depreciation areas, set the indicator to **Area Does Not Post**. In addition, set the **Area for reporting purposes only** indicator. In this way, you can continue to use these areas for reports.

The following applies for the accounts approach and the ledger approach:

Customizing activity: [Asset Accounting (New) > Valuation > Depreciation Areas > Define Depreciation Areas](#)

7) Define transfer rules for the posting values of a depreciation area.

The following applies for the transfer of APC values for the accounts approach:
- The leading area of a valuation always has the entry **Initial** (00), meaning that it **never** adopts values from another area.
- The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.
- Exception: Depreciation areas for investment support shown on the liabilities side always have the entry **Initial** (00).

The following applies for the transfer of APC values for the ledger approach:
- The leading area of a valuation always has the entry **Initial** (00), meaning that it **never** adopts values from another area.
- The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.
- Exception: Depreciation areas for investment support shown on the liabilities side always have the entry **Initial** (00).

Customizing activity: [Asset Accounting (New) > Valuation > Depreciation Areas > Specify Transfer of APC Values](#)

8) Specify transfer rules for depreciation terms of a depreciation area.

The same applies for the transfer rules for depreciation terms of a depreciation area as for the transfer of APC values.
9) Parallel Currencies: Check Currency Type of Depreciation Area

If you had to create a new depreciation area for parallel currencies before you installed the SAP Simple Finance, you can check the entered currency types in the Customizing activity Specify the Use of Parallel Currencies and assign this currency type. It is only possible to assign a currency type when your company code does not have the status O legacy data transfer completed. Check this; it may be necessary to switch the status temporarily.

Customizing activity: ↪ Asset Accounting (New) ↪ Asset Data Transfer ↪ Set Company Code Status

In the Customizing activity you can also again check the transfer rules for the APC values of a depreciation area and the transfer rules for depreciation terms of a depreciation area.

Customizing activity: ↪ Asset Accounting (New) ↪ Valuation ↪ Currencies ↪ Specify the Use of Parallel Currencies

6.2.1.1.1.3 Additional Manual Customizing Settings

The following table provides an overview of the manual adjustments you need to make dependent on the settings in your source system.

<table>
<thead>
<tr>
<th>I. Classic General Ledger Accounting, classic Asset Accounting, accounts approach</th>
<th>II. New General Ledger Accounting, classic Asset Accounting, accounts approach</th>
<th>III. New General Ledger Accounting, classic Asset Accounting, ledger approach</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Define Asset Balance Sheet Accounts of Parallel Valuation as Reconciliation Accounts (1)</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>2. Define Depreciation Area for Quantity Update</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>3. Define Technical Clearing Account for Integrated Asset Acquisition (2)</td>
<td>Required (2)</td>
<td>Required (2)</td>
</tr>
<tr>
<td>4. Specify Alternative Document Type for Accounting-Principle-Specific Documents</td>
<td>Optional</td>
<td>Optional (3)</td>
</tr>
<tr>
<td>5. Define Clearing Accounts for Non-Integrated Asset Acquisition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Specify Revenue Distribution for Asset Retirement</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
### Process

#### Regarding 1) Define Asset Balance Sheet Accounts of Parallel Valuation as Reconciliation Accounts

This step is only necessary if you are using the accounts approach. This step is not necessary if you are using the ledger approach.

Up to now, you have (as part of the accounts approach) represented one or more additional valuations using separate periodic-posting or direct-posting depreciation areas that post to separate accounts in the general ledger. These asset balance sheet accounts were posted directly in Financial Accounting up to now.

In the future, both the leading valuation and parallel valuations post asset values directly in Asset Accounting. The asset balance sheet accounts are only allowed to be posted by means of Asset Accounting, and therefore have to be defined as reconciliation accounts.

There are various possibilities.

**Option 1:**

You define the asset balance sheet accounts you used up to now (normal balance sheet accounts that can be posted directly) of the parallel valuation as reconciliation accounts for the future.


or

Customizing activity: [Asset Accounting (New) > Preparations for Production Operation > Production Start > Account Approach: Set/Reset Reconciliation Accounts for Parallel Valuations](#) (If you are using the account approach and have lots of asset balance sheet accounts that are to be defined as reconciliation accounts, you can...
set all asset balance sheet accounts of one or more company codes as reconciliation accounts using program

*Convert Accounts Posted to Periodically to Reconciliation Accounts* (RASFIN_SET_SKB1_RECONACCOUNT).

**OR: Option 2:**

You create new asset balance sheet accounts in your chart of accounts and define them as reconciliation accounts of Asset Accounting.

1. Create the new asset balance sheet accounts as reconciliation accounts in the general ledger.
   
   SAP Easy Access screen:
   ```
   Accounting ➔ Financial Accounting ➔ General Ledger ➔ Master Records ➔ G/L Accounts ➔ Individual Processing ➔ FS00 Centrally
   ```
   
2. Enter these balance sheet accounts in the account determination for Asset Accounting. For the posting depreciation area that represents the parallel valuation, you have to enter the newly created reconciliation accounts (for example, as balance sheet account for acquisition and production costs, or accumulated depreciation account for ordinary depreciation).
   
   Customizing activity:
   ```
   Asset Accounting (New) ➔ Integration with General Ledger Accounting ➔ Assign G/L Accounts
   ```
   
3. Assign the newly created balance sheet accounts to your balance sheet structure.
   
   Customizing activity:
   ```
   ```
   
If you are certain that the balance sheet accounts were *never* posted manually in Financial Accounting in the past, then you can convert these accounts into reconciliation accounts. If it is *not* possible to ascertain this, then we recommend that you create new balance sheet accounts (reconciliation accounts) to make reconciliation between Financial Accounting and Asset Accounting possible for the future.

**Recommendation**

In any case, we recommend that you reconcile the balance sheet values of Asset Accounting with General Ledger Accounting, especially for parallel valuations, as part of closing operations and before SAP Simple Finance is installed. To do so, use the report for asset lists in Asset Accounting. In Financial Accounting, you can use the corresponding balance list.

**Regarding 2) Define Depreciation Area for Quantity Update**

In this step, you can specify, for each chart of depreciation, the depreciation area you want to use for the quantity update. This setting is especially relevant if you are using collective low-value assets. The quantities in the asset master record are only updated if postings are made to the area specified here.

For each chart of depreciation, the system displays a selection of depreciation areas that are allowed to manage quantities. The depreciation areas are always the leading/posting area for the given valuation.

This is an optional activity. In the standard system (that is, as long as you do *not* make any settings to the contrary), the system uses depreciation area 01 for the quantity update.

Customizing activity:
```
Asset Accounting (New) ➔ Valuation ➔ Depreciation Areas ➔ Define Depreciation Area for Quantity Update
```

**Regarding 3) Define Technical Clearing Account for Integrated Asset Acquisition**

This step is always necessary if you want to post an integrated asset acquisition. You enter the business transaction for the vendor invoice and the asset acquisition in one step; you enter the accounts for the liability and the capitalization of the asset and post to them.

It might be the case that you always post your asset acquisitions without integration. That means, as the first step, you enter the incoming invoice in Accounts Payable and post against a clearing account for asset acquisitions. In the later, second step, you enter a separate transaction in Asset Accounting and thereby capitalize
the asset and post against a clearing account for asset acquisitions. In that case, you do not have to enter this account.

For an integrated asset acquisition posting, the system divides the business transaction into an operational part and a valuating part:

- For the operational part (vendor invoice), the system posts a document valid for all accounting principles against the technical clearing account for integrated asset acquisitions. From a technical perspective, the system generates a ledger-group-independent document.
- For each valuating part (asset posting with capitalization of the asset), the system generates a separate document that is valid only for the given accounting principle. This document is also posted against the technical clearing account for integrated asset acquisitions. From a technical perspective, the system generates ledger-group-specific documents.

Procedure:

1. Create a new G/L account called technical clearing account for integrated asset acquisitions as a reconciliation account for asset accounts in the chart of accounts and in the company code. SAP Easy Access screen: [Accounting > Financial Accounting > General Ledger > Master Records > G/L Accounts > Individual Processing > FS00 Centrally]

2. You have to enter this G/L account in the account determination of Asset Accounting for your chart of accounts.

   Customizing activity: [Asset Accounting (New) > Integration with General Ledger Accounting > Technical Clearing Account for Integrated Asset Acquisition > Define Technical Clearing Account for Integrated Asset Acquisition]

3. Assign the newly created G/L accounts to your balance sheet structure.


   Note

   Check if you want a different field control, depending on the asset balance sheet account to be posted or on the given transaction (such as APC or investment support). If this is the case, you need different technical clearing accounts for integrated asset acquisitions. Proceed as follows:

1. Create additional G/L accounts called technical clearing account for integrated asset acquisitions as reconciliation accounts for asset accounts in the chart of accounts and in the company code. You have to define the field status variant for this account differently than the first account.

   SAP Easy Access screen: [Accounting > Financial Accounting > General Ledger > Master Records > G/L Accounts > Individual Processing > FS00 Centrally]

2. You have to enter this G/L account in the account determination of Asset Accounting for your chart of accounts.

   Customizing activity: [Asset Accounting (New) > Integration with General Ledger Accounting > Technical Clearing Account for Integrated Asset Acquisition > Define Different Technical Clearing Account for Required Field Control]

3. Assign these G/L accounts to your balance sheet structure.


Regarding 4) Specify Alternative Document Type for Accounting-Principle-Specific Documents

This step can be necessary, if you use document splitting. In that case, you have to enter an alternative document type for the valuating document, if you want the document splitting rules to be different for the business.
transaction variant of the valuating document (asset acquisition) and the operative document (Accounts Payable).

This step could also be necessary, if your organization requires that the valuating documents are posted with a different document type than the operational documents.

When you enter a business transaction, for instance for an integrated asset acquisition, a down payment to an asset, or an integrated asset retirement, the system splits the business transaction into an operational part and a valuating part.

Procedure:

Check whether you need alternative document types for posting the valuating document, either due to the definition of the business transaction variant of document splitting or due to requirements in your organization. If this is necessary, proceed as follows:

1. Check whether you can use a document type that already exists in the system, or whether you need a new document type. In the second case, create the document type.


2. Check whether you can use an existing number range for the newly created document type, or whether you have to create a new number range.


3. Assign the alternative document type for the posting of your valuating document.


4. If you need to use other alternative document types for the valuating document for individual company codes, you can differentiate them further.


Regarding 5) Define Clearing Accounts for Non-integrated Asset Acquisition

For non-integrated asset acquisition, the clearing account is no longer allowed to be managed with open items. This means, it is no longer possible to clear the open items on the account Clearing Account for Non-Integrated Asset Acquisition.

For more information, see Customizing for Asset Accounting (New) under Migration: Asset Accounting (New) ➔ Migrating from Classic to New Asset Accounting ➔ Migration for New Asset Accounting ➔ Perform Additional Manual Activities ➔

Regarding 6) Specify Revenue Distribution for Asset Retirement

In this step, you specify at company code level how the system is to distribute revenues arising from asset retirements: either based on the net book value or on APC. In the standard system, the distribution is based on the net book value.

Check the distribution of revenue for your company codes, and adjust the distribution to meet your requirements.

Customizing activity: Asset Accounting (New) ➔ Transactions ➔ Retirements ➔ Gain/Loss Posting ➔ Define Revenue Distribution for Fixed Asset Retirement ➔
Regarding 7) Post Net Book Value Instead of Gain/Loss

In this step, you specify at company code level how the system posts during an asset retirement due to sale or scrapping. In the standard system, the system posts a gain or loss posting. As another option, you can choose to post the net book value of the assets instead for a depreciation area. In that case, the system posts the net book value to the account for clearing of revenue from asset sales or for clearing of revenue from asset sales to affiliated companies.

**Note**
This posting variant is **not** allowed in most countries. In some countries, such as France, however, it is a legal requirement.

Check whether it is a legal requirement to post the net book value for individual areas, and adjust your settings accordingly.

Customizing activity: [Asset Accounting (New)](##) > Transactions > Retirements > Gain/Loss Posting > Post Net Book Value Instead of Gain/Loss, subactivity Specify Depreciation Areas for Net Book Value Posting

**Note**
If up to now you have been using the "Post Net Book Value at Retirement" logic, note the following: The restriction of posting logic to certain depreciation areas was done in classic Asset Accounting using area types (as set out in SAP Note 1069166).

Regarding 8) Check Transaction Types

In new Asset Accounting, it is **not** possible and also **not** necessary to restrict transaction types to depreciation areas. This is not necessary since, when you enter a transaction, you can restrict it to a depreciation area or accounting principle. In addition, in a posting transaction, you can select the depreciation areas to be posted.

If you were using transaction types that were restricted to certain depreciation areas, then you can **no longer** use these transaction types. Check whether your existing transaction types that are **not** restricted to depreciation areas are sufficient. Otherwise you have to create new transaction types (that correspond to the previous restricted ones) that do not have restrictions to depreciation areas. Set existing transaction types that are restricted to depreciation areas as obsolete. This has the following consequences:

- You can **no longer** use the transaction type for future postings.
- The transaction type is then **no longer** proposed in the input help of the transaction types.

Investment support and also revaluation and new valuation are an exception:

- The transaction types for investment support and revaluation are automatically generated by the system when you create a corresponding measure, and therefore are restricted to the depreciation area to be posted to.
- The transaction types for revaluation and new valuation that relate to transaction type group 81/82/89 can continue to be restricted to depreciation areas.

Customizing activity: [Asset Accounting (New)](##) > Overview for Experts > Check Transaction Types

**More Information**

The cost element (also those with cost element type 90) have to be migrated or created.

See the corresponding Customizing activities and documentation under [SAP Simple Finance > Migration > Migration of Cost Elements and Customizing](##).
6.2.1.1.1.4 Checking the Prerequisites for Activating New Asset Accounting

After you have migrated the charts of depreciation that you use (which are assigned to company codes) and have made additional manual Customizing settings, you can check if the prerequisites for activating new Asset Accounting are met.

**Process**

To do so, execute the Customizing activity for this and check the log. You cannot activate new Asset Accounting until the log indicates there are no errors.

Customizing activity: [Asset Accounting (New) ➤ Migration: Asset Accounting (New) ➤ Migration for New Asset Accounting ➤ Check Prerequisites for Activating Asset Accounting (New)]

6.2.1.1.1.5 Activation of New Asset Accounting

The following table provides an overview of the steps you need to perform dependent on the settings in your source system.

<table>
<thead>
<tr>
<th>Table 53</th>
<th>I. Classic General Ledger Accounting, classic Asset Accounting, accounts approach</th>
<th>II. New General Ledger Accounting, classic Asset Accounting, accounts approach</th>
<th>III. New General Ledger Accounting, classic Asset Accounting, ledger approach</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing System</td>
<td>Activate new Asset Accounting Required</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Downstream Systems (Test System, Production System)</td>
<td>1. Manual creation of G/L account master data and number ranges Optional (1)</td>
<td>Optional (1)</td>
<td>Optional (1)</td>
</tr>
<tr>
<td></td>
<td>2. Perform transport of settings and check them Required</td>
<td>Required</td>
<td>Required</td>
</tr>
</tbody>
</table>

**Explanation:**

- (1) In case this data is not transported
- The following starting situations are not shown in the table:
  - You are currently not using any Accounting components from SAP ERP and are now setting up your system completely new for SAP Simple Finance;
  - You have been using classic or new General Ledger Accounting so far, but neither classic nor new Asset Accounting. You now want to implement new Asset Accounting
In both cases, you have to make all settings relevant for you in Customizing for Asset Accounting (New). You must then execute Customizing activity Activate New Asset Accounting (which can also be found in Customizing for Asset Accounting (New) under Preparations for Going Live ➤ Production Startup).

Process

Customizing System

Activate new Asset Accounting

In the Activate New Asset Accounting Customizing activity, set the Active indicator and save your setting.


You can now proceed with more steps of the migration, especially with the document migration.

Downstream Systems

Regarding 1) Manual creation of G/L accounts and number ranges

If the following objects were created in your Customizing system and are not transported, you have to create them manually in the downstream systems:

- New G/L account master data for reconciliation accounts used for parallel valuation in conjunction with the accounts approach
- New G/L account master data for the Technical Clearing Account for Integrated Asset Acquisition
- New number ranges for alternative document types for accounting-principle-specific documents

Regarding 2) Perform transport of settings and check them

As part of the migration, you have made various settings in your Customizing system. You now have to transport these settings to your downstream systems.

Check whether the transport, including the import of the active Customizing switch (for activating new Asset Accounting), was successful. To do so, call the Activate New Asset Accounting Customizing activity, and check if the Customizing switch is set to Active.


You can then proceed with more steps of the migration, especially with the document migration.

6.2.1.1.2 Master Data

It is not necessary to migrate master data for new Asset Accounting in SAP Accounting powered by SAP HANA.
6.2.1.1.3 Transaction Data: Documents, Balances, Depreciation Values

Before you migrate the documents, it is essential that you have migrated the Customizing settings of Asset Accounting.

The migration of documents takes place as part of the document migration for the universal journal entry.

Calculation of Depreciation and Total Values

After the migration of balances, you must initially build the planned depreciation values for Asset Accounting and calculate the total values.

The following prerequisites must be met: You have migrated the Customizing data of Asset Accounting and, if you have been using classic Asset Accounting until now, have activated new Asset Accounting. You have migrated the transaction data of General Ledger Accounting and Asset Accounting.

In Customizing under Migrating from SAP ERP to SAP Accounting powered by SAP HANA ➤ Migration ➤ Calculation of Depreciation and Total Values, you must perform the following activities:

- **Calculate Initial Depreciation Values** (transaction FINS_MIG_AFA)
- **Display status of “Calculate Initial Depreciation Values”** (transaction FINS_MIG_MONITOR_AFA)
- **Check Initial Depreciation and Total Values** (transaction FINS_RECON_RC5)
- **Display status of “Check Initial Depreciation and Total Values”** (transaction FINS_MIG_MONITOR_RC5)

More Information

Information about migrating documents can be found in the corresponding migration guide.

6.2.1.1.2 Adjustments in New Asset Accounting: Execution

6.2.1.1.2.1 Customizing Settings

In SAP Accounting 1503 powered by SAP HANA you must adjust the Customizing data of new Asset Accounting and migrate documents. The adjustment of Customizing data is explained in the following sections.

Depending on what your starting situation is as regards Asset Accounting before the installation of SAP Simple Finance, different steps, which are to be executed manually or automatically, may be necessary. The starting scenario in your system can be one of the following:

- **SAP ERP 6.0, Enhancement package 7, SPS 02 or higher**
  - with active business function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL);
  - this means, new General Ledger Accounting and new Asset Accounting with ledger approach
- **SAP Simple Finance Add-on 1.0**
  - this means, new General Ledger Accounting and new Asset Accounting with ledger approach or accounts approach
The migration is divided into the steps outlined below. The steps that are relevant for you depend on which starting scenario you begin with (see above).

Process

The following are the steps for the migration of new Asset Accounting in your Customizing system:

- a. You adjust the Customizing settings for your charts of depreciation automatically (or manually).
- b. You make additional Customizing settings manually.
- c. You allow postings in your system again.

The following are the steps for the migration of new Asset Accounting in your downstream systems (test system or production system):

- a. You import all settings to the system.
- b. You allow postings in your system again.

6.2.1.2.1.1 Automatic Adjustments to Parameters in Active Charts of Depreciation

The following table contains an overview of the steps that you can follow or must follow, depending on the start scenario:

<table>
<thead>
<tr>
<th>Step</th>
<th>I. SAP ERP 6.0, enhancement package 7, SPS 02 with active business function <em>FI-AA, Parallel Valuation</em> (<em>FIN_AA_PARALLEL_VAL</em>), new Asset Accounting with ledger approach</th>
<th>II. SAP Simple Finance add-on 1.0; new Asset Accounting with ledger approach or accounts approach</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Determine chart of depreciations to be migrated</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>2. Check accounting principle.</td>
<td>Required</td>
<td>Not Relevant (1)</td>
</tr>
<tr>
<td>3. Check Ledger Group</td>
<td>Optional (2)</td>
<td>Not Relevant (1)</td>
</tr>
<tr>
<td>4. Assign accounting principle to ledger group</td>
<td>Required</td>
<td>Not Relevant (1)</td>
</tr>
<tr>
<td>5. Check settings for the ledger of the journal entry</td>
<td>Required (3)</td>
<td>Required (3)</td>
</tr>
<tr>
<td>6. Adjust the parameters in the active charts of depreciation</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>7. Display log</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Step</td>
<td>I. SAP ERP 6.0, enhancement package 7, SPS 02 with active business function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL), new Asset Accounting with ledger approach</td>
<td>II. SAP Simple Finance add-on 1.0; new Asset Accounting with ledger approach or accounts approach</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8. Manually adjust the parameters in the non-active charts of depreciation</td>
<td>Required</td>
<td>Required</td>
</tr>
</tbody>
</table>

**Explanation:**

1. Not relevant because the assignment already exists
2. Already exists and assigned in the chart of depreciation
3. Preparatory step for the migration to *SAP Accounting 1503 powered by SAP HANA*

**Process**

The individual steps are described in detail in the following.

**Regarding 1) Determine charts of depreciation to be migrated**

You must adjust all active charts of depreciation in your system, that is, all charts of depreciation that are assigned to a company code. You can use the following activity to check which charts of depreciation are active in your system.

Customizing activity: [Asset Accounting (New) > Organizational Structures > Assign Chart of Depreciation to Company Code](#)

You must make a distinction between company codes that are still being used actively and ones that are only being used for subsequent reporting purposes (and as such are not active).

- **Active company code (status 0, 1, 2):** You can adjust the chart of depreciation **automatically** using the migration program.
- **Non-active company code (status 3 company code deactive - subsequent reporting allowed):** You need to adjust the chart of depreciation manually. The chart of depreciation needs to be adjusted only if data still exists. If all data for the assigned company codes has been archived, then it is **not** necessary to adjust the chart of depreciation.

**Background:** Documents can only be migrated when the chart of depreciation is migrated. Archived documents are **not** migrated.

Customizing activity: [Asset Accounting (New) > Asset Data Transfer > Set Company Code Status](#)

**Regarding 2) Check accounting principle.**

In new Asset Accounting, the system posts a separate document for each valuation. It is necessary for you to have created an accounting principle for each valuation. Check if the necessary accounting principles exist for your valuations.

Regarding 3) Check Ledger Group

Check which ledger groups with the corresponding representative ledgers exist in the system and which valuations the representative ledgers represent.

The following applies to the ledger approach: Each valuation (leading and parallel) is stored in a separate ledger in General Ledger Accounting. You post to ledgers by means of the ledger group. (The ledger group contains one or more ledgers.)

Example

Example for the ledger approach:

Table 55

<table>
<thead>
<tr>
<th>Valuation</th>
<th>Ledger Group</th>
<th>Ledger</th>
<th>Ledger is representative ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leading valuation</td>
<td>OL</td>
<td>OL</td>
<td>X</td>
</tr>
<tr>
<td>Parallel valuation</td>
<td>N1</td>
<td>N1</td>
<td>X</td>
</tr>
</tbody>
</table>

The following applies for the accounts approach: Each valuation (leading and parallel) is represented using a set of G/L accounts. In the general ledger, all balances are updated in one ledger, regardlesss of the valuation. Technically this is the ledger that is flagged as the leading ledger in your system.

In order for it to be possible to group the depreciation areas according to the type of valuation, it is necessary (for technical reasons) that a ledger group exists in the system for each accounting principle (valuation). This ledger group must always contain the leading ledger.

In the standard system, SAP provides the leading ledger OL with the identically-named ledger group OL. The ledger group OL contains the ledger OL as the representative ledger. For each of your parallel valuations, there is another (new) ledger group containing the leading ledger.

Example

Example for the accounts approach:

Table 56

<table>
<thead>
<tr>
<th>Valuation</th>
<th>Ledger Group</th>
<th>Ledger</th>
<th>Ledger is representative ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leading valuation</td>
<td>OL</td>
<td>OL</td>
<td>x</td>
</tr>
<tr>
<td>Parallel valuation</td>
<td>&amp;30&amp; (1), (2) OL</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

Explanation:

(1) If you created the ledger groups manually when you implemented new Asset Accounting, you were able to release the key.

(2) Alternatively, you had the option when implementing new Asset Accounting of using the migration program to automatically generate the ledger group for the parallel valuation.

In this example, the migration cannot be performed successfully due to the missing ledger group for parallel valuation and the missing assignment of this ledger group to an accounting principle. However, the system generates a ledger group. Its name consists of the following parts:

&<Number of the leading depreciation area of the parallel valuation>&. The name of the ledger group can be adjusted.
Regarding 4) Assign accounting principle to ledger group.

One ledger group is always assigned uniquely to one accounting principle. Check whether an appropriate ledger group is assigned to the accounting principles that represent the valuations you need. If not, assign the needed accounting principles.


**Recommendation**

To ensure a unique assignment of one ledger group to an accounting principle, a ledger group that is used in Asset Accounting is only allowed to be assigned to one accounting principle. If a ledger group is assigned to more than one accounting principle, the migration program *cannot* assign the accounting principle automatically; it needs to be assigned manually.

Customizing activity: [Asset Accounting (New) ➤ Integration with General Ledger Accounting ➤ Define How Depreciation Areas Post to General Ledger]

**Note**

The ledger group assigned to the accounting principle is *not* allowed to contain the so-called appendix ledger as Asset Accounting is *not* integrated with the appendix ledger.

Regarding 5) Check settings for the ledger of the journal entry

For the relevant valuations, check in the company code settings of the ledger whether the accounting principle is assigned.


Regarding 6) Adjust the parameters in the active charts of depreciation

Charts of depreciation in your system can be defined to reflect either the accounts approach or the ledger approach. The program adjusts the parameters in your previous charts of depreciation to the requirements of *SAP Accounting 1503 powered by SAP HANA*. It adjusts the active charts of depreciation that had *not* previously been adjusted, either automatically or manually, and that were *not* created as new in *SAP Accounting 1503 powered by SAP HANA*.

You can run the program as a test run or an update run. It creates a log in both cases.

The following describes how the charts of depreciation are adjusted during the migration (for the accounts approach and the ledger approach). If it is *not* possible for the system to convert a chart of depreciation automatically during the migration, you have to make the adjustments manually.

- If you have previously been using *SAP Accounting 1.0 powered by SAP HANA*, the following adjustments are made:

  All depreciation areas that previously posted to the general ledger will in future post simultaneously with the *Area Posts APC Immediately, Depreciation Periodically* indicator. This applies to reserves for special depreciation areas.

- If you have previously used SAP ERP 6.0, enhancement package 7, SPS 02 with the activated business function *FI-AA, Parallel Valuation (FIN_AA_PARALLEL VAL)*, the indicators for posting to the general ledger are also converted. In addition, the following adjustments are also made in the chart of depreciation:
An accounting principle is assigned to each depreciation area and is derived from the ledger group assignment. In addition, the program determines whether the ledger approach or the accounts approach applies and sets an internal indicator to this effect. If your chart of depreciation had only one posting depreciation area (that is, only one valuation that posts to the general ledger), the system sets the indicator for the accounts approach.

New Asset Accounting with accounts approach

The following applies for a chart of depreciation for new Asset Accounting with the accounts approach:

- **Definition of depreciation area**: Assignment to an accounting principle:
  - All areas have to be assigned to an accounting principle.
  - All areas that represent the same valuation have to be assigned to the same accounting principle.
  - The system automatically assigns the ledger group assigned to the accounting principle.

- **Definition of depreciation area**: **Posting in G/L**:
  - **Area Posts in Realtime** is set for the leading area of the leading valuation.
  - **Area Posts APC Immediately, Depreciation Periodically** is also set for the leading area of the parallel valuation.
  - A derived area (for example, for reserve for special depreciation) that posts to the general ledger has the indicator **Area Posts APC Immediately, Depreciation Periodically**

- **Transfer of APC values**:
  - The leading area of a valuation always has the indicator 00, meaning that it never adopts values from another area.
  - The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.
  - Exception: Depreciation areas for investment support shown on the liabilities side always have indicator 00.

- **Specify transfer of depreciation terms**: The same applies here as for the adoption of APC values.

---

### Example

Migrated chart of depreciation for new Asset Accounting with the accounts approach:

<table>
<thead>
<tr>
<th>Area</th>
<th>Accounting Principle (AP) -&gt; Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values (2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>APII -&gt; 0L</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td>APII -&gt; 0L</td>
<td>(0) Area Does Not Post</td>
<td>01</td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>APII -&gt; &amp;30&amp;</td>
<td>(4) Area Posts APC Immediately, Depreciation Periodically(1)</td>
<td>00 (Initial)</td>
</tr>
</tbody>
</table>
Area in parallel currency of (parallel) valuation II (3) | Accounting Principle (AP) -> Ledger Group | Posting in G/L | Transfer of APC values (2) |
---|---|---|---|
31 | APII -> &30& | (0) Area Does Not Post | 30 |

Explanation:

1. **Area Posts APC Immediately, Depreciation Periodically**: With this option, the postings in the general ledger are always made at the same time (immediately); this also applies in the case of special depreciation areas. Consequently, it is **no longer necessary and no longer possible** to make subsequent postings using the APC posting program.

2. The requirements for the adoption of depreciation terms are essentially the same as those for the transfer of APC values.

3. For parallel valuation, it is **not** absolutely necessary that there has to be an area in the parallel currency.

### New Asset Accounting with ledger approach

The following applies for a chart of depreciation for new Asset Accounting with the ledger approach:

- **Definition of depreciation area**: Assignment to an accounting principle:
  - All areas have to be assigned to an accounting principle.
  - All areas that represent the same valuation have to be assigned to the same accounting principle.
  - The system automatically assigns the ledger group assigned to the accounting principle.

- **Definition of depreciation area**: Posting in G/L:
  - **Area Posts in Realtime** is set for the leading area of the leading valuation.
  - **Area Posts in Realtime** is also set for the leading area of the parallel valuation.
  - A derived area (for example, for reserve for special depreciation) that posts to the general ledger has the indicator **Area Posts APC Immediately, Depreciation Periodically**

- **Transfer of APC values**:
  - For the transfer of APC values, the leading areas of a valuation always has the key **00** (initial), that is, it does **not** adopt any values from another depreciation area.
  - The non-leading areas of a valuation always adopt their values from an area that is assigned to the same accounting principle.
  - Exception: Depreciation areas for investment support shown on the liabilities side always have the key **00**.

- **Specify transfer of depreciation terms**:
  - The same applies here as for the adoption of APC values.

**Example**

Migrated chart of depreciation for new Asset Accounting with the ledger approach:
Table 58

<table>
<thead>
<tr>
<th>Area</th>
<th>AP -&gt; Ledger Group</th>
<th>Posting in G/L</th>
<th>Transfer of APC values</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Leading area in LC in (leading) valuation I</td>
<td>API -&gt; OL</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>02 Area in parallel currency of (leading) valuation I</td>
<td>API -&gt; OL</td>
<td>(0) Area Does Not Post</td>
<td>01</td>
</tr>
<tr>
<td>30 Leading area in LC of (parallel) valuation II</td>
<td>APII -&gt; N1</td>
<td>(1) Area Posts in Realtime</td>
<td>00 (Initial)</td>
</tr>
<tr>
<td>31 Area in parallel currency of (parallel) valuation II</td>
<td>APII -&gt; N1</td>
<td>(0) Area Does Not Post</td>
<td>30</td>
</tr>
</tbody>
</table>

Executing the Program

**Recommendation**

We recommend that you execute the migration program as a test run first. Check the log of the test run and correct the errors before you start the program as an update run.


**Regarding 7) Display log**

Both in a test run and in an update run, the system creates a log, which you can display at any time.

The log shows the processing of the charts of depreciation. As soon as the value for an indicator or field in the depreciation area definition of the chart of depreciation changes, this is displayed as a message in the log.

The program issues a message for each chart of depreciation, telling you whether the chart of depreciation has been adjusted successfully.

You can call the log as follows:

- In the Customizing activity *Adjust Parameters in Chart of Depreciation* by choosing the *Job Log* pushbutton
- In the Customizing activity *Display Migration Log*

**Regarding 8) Migrate non-active charts of depreciation**

You have charts of depreciation in your system that are assigned to a non-active company code. This means they are assigned to a company code that only allows subsequent reporting. The data of this non-active company code is still not archived; it must therefore be migrated with the document migration. Consequently, you must adjust this chart of depreciation manually.

For more information, see *Manual Adjustment of Charts of Depreciation and Checking of Settings*[page 101].
6.2.1.1.2.1.2 Manual Adjustment of Charts of Depreciation and Checking of Settings

The steps outlined below are relevant for you in the following cases:

- You would like to check the parameters of the chart of depreciation that have been adjusted automatically by the program.
- The starting scenario that underlies your chart of depreciation does not allow automatic adjustment using the program.
  In this case, you have to make the adjustments to the parameters of the chart of depreciation manually.
- You want to adjust the parameters of the chart of depreciation manually from the outset.
- You have charts of depreciation in your system that are assigned to a non-active company code. This means they are assigned to a company code that only allows subsequent reporting. The data of this non-active company code is not yet archived.

Process

1) Determine active charts of depreciation.
   For more information, see Automatic Adjustment of the Parameters in Active Charts of Depreciation [page 94].

2) Check accounting principle
   For more information, see Automatic Adjustment of the Parameters in Active Charts of Depreciation [page 94].

3) Check Ledger Group
   For more information, see Automatic Adjustment of the Parameters in Active Charts of Depreciation [page 94].

4) Assign accounting principle to ledger group.
   For more information, see Automatic Adjustment of the Parameters in Active Charts of Depreciation [page 94].

5) Check settings for the ledger of the journal entry
   For more information, see Automatic Adjustment of the Parameters in Active Charts of Depreciation [page 94].

6.) Change definitions of depreciation areas
   If you have previously used SAP Simple Finance add-on 1.0 and have now upgraded to SAP Simple Finance 1503, you need to perform the following step:
   You have to change the indicator settings for posting in the general ledger. Using these indicators, you specify whether and how APC and depreciation from the depreciation area are posted to the general ledger.
   - The following applies for the accounts approach:
     The "Area Posts APC Immediately, Depreciation Periodically" indicator is set for the leading area of the parallel valuation.
   - The following applies for the accounts approach and the ledger approach:
     A derived area (for example, reserve for special depreciation) that posts to the general ledger has the indicator Area Posts APC Immediately, Depreciation Periodically.
If you previously used SAP ERP 6.0, enhancement pack 7, SPS 02 or higher and you had activated the business function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL) as well as the Customizing switch for new Asset Accounting, you additionally need to perform the following step:

Assign an accounting principle to each depreciation area. The following information applies to this assignment:

- All areas have to be assigned to an accounting principle.
- All areas that represent the same valuation have to be assigned to the same accounting principle.
- The accounting principle must be assigned to the ledger group already assigned to the depreciation area.

The parameters of the chart of depreciation is adjusted in such a way so that there is no longer any area that posts periodically; all areas post immediately to the general ledger. This also applies for reserves for special depreciation areas. The indicator for posting to the general ledger that you were able to use until now for posting areas to the general ledger periodically is no longer available.

Customizing activity: Asset Accounting (New) > Valuation > Depreciation Areas > Define Depreciation Areas

### 6.2.1.2.1.3 Additional Manual Customizing Settings

If you have used SAP ERP 6.0, enhancement package 7, SPS 02 with active Business Function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL), you must check your transaction data and adjust it, if necessary.

You must also migrate the cost elements relevant for Asset Accounting, irrespective of your source release.

#### Process

**Check Transaction Types**

This activity is only relevant if you have been using SAP ERP 6.0, enhancement package 7, SPS 02 with active Business Function FI-AA, Parallel Valuation (FIN_AA_PARALLEL_VAL).

In enhancement package 7, it was possible to use the Business Add-In (BAdI) Restrict Transaction Types to Depreciation Areas and to post using transaction types restricted to depreciation areas. This Business Add-In can no longer be used in SAP Simple Finance.

It is not possible in SAP Simple Finance in new Asset Accounting and also not necessary to restrict transaction types to depreciation areas. This is not necessary since, when you enter a transaction, you can restrict it to a depreciation area or accounting principle. In addition, in a posting transaction, you can select the depreciation areas to be posted.

If you had restricted transaction types to depreciation areas until now, you must check these transaction types and, if necessary, adjust them manually.

You perform this step in Customizing only. You need to transport the settings to your downstream systems.

Check whether your existing transaction types that are not restricted to depreciation areas are sufficient. If this is not the case, you must create new transaction types (in accordance with your hitherto existing restrictions, however without restrictions to depreciation areas). Set the obsolete indicator for existing transaction types that are restricted to depreciation areas. This has the following consequences:

- You can no longer use the affected transaction types for future postings.
- The transaction types are no longer proposed in the input help when you make postings.

Investment support as well as revaluation and new valuation remain exceptions to this:
The transaction types for investment support and revaluation are automatically generated by the system when you create a corresponding measure, and therefore are restricted to the depreciation area to be posted to.

The transaction types for revaluation and new valuation that relate to transaction type group 81/82/89 can continue to be restricted to depreciation areas.

Customizing activity: [Asset Accounting (New) > Overview for Experts > Check Transaction Types](#)

**Migrating Cost Elements**

The cost element (also those with cost element type 90) have to be migrated or created.

See the corresponding Customizing activities and documentation under [SAP Simple Finance > Migration > Migration of Cost Elements and Customizing](#)

### 6.2.1.2.1.4 Transporting Customizing Settings to Downstream Systems

You must now transport the parameter adjustments of your chart of depreciation to downstream systems.

**Process**

**Customizing System**

In the Customizing system, you can now continue with the other steps of the migration, especially with the migration of the transaction data (documents).

**Downstream Systems: Perform a transport of Customizing settings and check them.**

As part of the migration, you have made various settings in your Customizing system. You now have to transport these settings to your downstream systems.

Check whether the transport was successful. To do this, check the transported changes in your charts of depreciation.

You can then continue with the other steps of the migration, especially with the migration of the transaction data (documents).
6.2.1.2 Migration to Asset Accounting: Postprocessing

6.2.1.2.1 Migration from Classic to New Asset Accounting: Postprocessing

6.2.1.2.1.1 Postprocessing

Creating a Chart of Depreciation Subsequently

If you have already activated new Asset Accounting and you create a new chart of depreciation after that, you can check that chart of depreciation to see if it meets the requirements for new Asset Accounting.

Customizing activity: [Asset Accounting (New) ➤ Overview for Experts ➤ Check Active Charts of Depreciation for Asset Accounting (New)]

Note

After completing the migration, make sure that no fiscal year that is before the migration is reopened in Asset Accounting.

6.2.1.2.2 Adjustments in New Asset Accounting: Postprocessing

6.2.1.2.2.1 Postprocessing

Creating a Chart of Depreciation Subsequently

If you have already activated new Asset Accounting and you create a new chart of depreciation after that, you can check that chart of depreciation to see if it meets the requirements for new Asset Accounting.

Customizing activity: [Asset Accounting (New) ➤ Overview for Experts ➤ Check Active Charts of Depreciation for Asset Accounting (New)]

Note

After completing the migration, make sure that no fiscal year that is before the migration is reopened in Asset Accounting.

6.2.1.3 Material Ledger Migration

Note

The material ledger is required if you are using Materials Management - Inventory Management in SAP S/4HANA, on-premise edition.
You need to migrate the material ledger even if you are already using Finance (that is, you are migrating from Finance to Inventory Management in SAP S/4HANA, on-premise edition).

You need to migrate the material ledger even if you are already using the material ledger in your source system.

Migrate the material ledger by carrying out the Customizing activities under Migration from SAP ERP to SAP Accounting powered by SAP HANA > Migration > Material Ledger Migration.

Prerequisites

You need to have migrated the material ledger Customizing settings with the activity Preparations and Migration of Customizing for Material Ledger > Migrate Material Ledger Customizing.

You need to have performed the following activities under Data Migration:

- Partitioning of Universal Journal Entry Line Items Table
- Regenerate CDS Views and Field Mapping
- Migration of Cost Elements (all activities)
- Technical Check of Transaction Data (all activities)

Process

Execute the following activities in the specified sequence:

1. Migrate Material Ledger
2. Display Status of Material Ledger Migration
3. Check Migration of Material Ledger
4. Display Status of Material Ledger Migration Check

For more information on each activity, see the IMG documentation for the activity.

6.2.1.3.1 Migrate Material Ledger

Note

This migration step uses dialog processes with parallel processing. Please make sure that a high number of dialog processes is available before starting this step.

Note

- The material ledger is required if you are using Materials Management - Inventory Management in SAP S/4HANA, on-premise edition.
- You need to migrate the material ledger even if you are already using Finance (that is, you are migrating from Finance to Inventory Management in SAP S/4HANA, on-premise edition).
- You need to migrate the material ledger even if you are already using the material ledger in your source system.
This activity activates the material ledger for all valuation areas. This creates material ledger master data and converts inventory values and material prices into the material ledger currencies (local, group, and an additional currency). In addition, production and purchase order history entries are converted into group currency and an additional currency.

If the material ledger is already active in the source system for all valuation areas, post-migration takes place. In post-migration, missing history table entries (tables: EBEWH, MBEWH, QBEWH, and OBEWH) are migrated to the material ledger, and any material ledger inconsistencies are resolved.

Prerequisites

Perform this activity after the following Customizing activities under Migration from SAP ERP to SAP Accounting powered by SAP HANA have been successfully completed.

Under Preparations and Migration of Customizing:

- Preparations and Migration of Customizing for Material Ledger
- Migrate Material Ledger Customizing

Under Data Migration:

- Partitioning of Universal Journal Entry Line Items Table
- Regenerate CDS Views and Field Mapping
- Migration of Cost Elements (all activities)
- Technical Check of Transaction Data (all activities)

Process

1. Select all valuation areas by entering an asterisk (*) in the plant/company field.
2. Select the processing options.
   - If you want a detailed log, or if the data volume is large, it is best to run the program in the background by selecting Background Processing.
   - For test purposes, you may run the program in test mode by selecting Test run.
   - The program will be executed in parallel mode. In order to control the parallel execution, you may specify a specific server group or change the package size.
3. Choose Execute.
4. Check the results in the log with System > Own Jobs

You can also see the migration status with the Display Status of Material Ledger Migration activity.

Result

Effects on Material Master Data

- The material ledger is activated in all material master records of the plant, provided that value updating is defined in table T134M.
- Price determination is set to 2 in all material master records.

If you want to use price determination 3 instead, see the following documentation in the SAP Help Portal under Actual Costing/Material Ledger (CO-PC-ACT):
Setting Material Price Determination
- Performing Single-Level Material Price Determination
- Performing Multilevel Price Determination

- Material ledger master data is created for all periods.
- Prices are calculated in the other currencies for the material ledger data.

Effects on Transaction Data
- Inventory quantities, inventory values, and prices are transferred from material master records to the material ledger data for all periods.
- Inventory values and prices are calculated in the currencies of the material ledger for the current date using the standard exchange rate type.
- Purchase and production order histories are converted into the second and third material ledger currencies.

6.2.1.3.2 Display Status of Material Ledger Migration

This activity allows you to check the current status of material ledger migration if you executed the Migrate Material Ledger activity in the background.

Material ledger migration has been executed successfully if one of the following information statuses is shown for all valuation areas in the client:
- **ML live since S/4 HANA migration**
- **ML live before S/4HANA migration and post-migration took place**

Material ledger migration is still in process if the following status is shown:
- **ML not live**
- **ML live before S/4HANA migration. However, post-migration missing**

Process

Use the **Refresh** button to retrieve new migration status data.

Check the **Logs ML Migration for Client** tab regularly to determine whether errors occurred. If there were any errors, contact SAP support.

6.2.1.3.3 Check Migration of Material Ledger

This activity checks whether the material ledger is active in all valuation areas and performs various technical checks.

**Prerequisites**

Perform this activity **after** the Migrate Material Ledger activity has been completed successfully.
Perform this activity **only if all valuation areas are active in the client** as determined by the *Display Status of Material Ledger Migration* activity.

**Process**

Execute the program.

**Recommendation**

Background processing is recommended. Choose **Program > Execute in Background**

**Result**

The following information is listed:

- Any valuation areas in which the material ledger is not active
  
  If a valuation area is not active, no material ledger entries were created and no goods movements are possible for that valuation area.

- Any master records which do not have a corresponding MARA table entry
  
  If a master record does not have a corresponding MARA table entry, no material ledger entries were created and no goods movements are possible for that material.

- Any master segments as part of split valuation that do not have an entry in table CKMLPR
  
  Inconsistencies will arise if any such master segments exist.

- Any records for which the MLMAA flag was not set properly
  
  If any such records exist, material ledger entries might not have been created. This would mean that the material cannot be used in goods movements, or the material valuation record will not be shown by $\times$BEW ($EBEW$, $EBEWH$, $MBEW$, $MBEWH$, $OBEW$, $OBEWH$, $QBEW$, and $QBEWH$) proxy CDS views.

- Any cases where the number of records is not the same in the old and new $\times$BEW ($H$) table
  
  If the number of records differs in the old and new table, the material valuation record is not shown by $\times$BEW ($H$) proxy CDS views.

- Any cases where the record and the corresponding field values are not the same in the old and new $\times$BEW ($H$) table.
  
  This represents a check of the migration of the $\times$BEW ($H$) local currency entries to the material ledger. Any inconsistencies mean that the material valuation record might not be shown by $\times$BEW ($H$) proxy CDS views.

- Any production order histories that were not converted into the required currencies

- Any purchase order histories that were not converted into the required currencies

Warning messages and error messages may be issued.

If any **error** messages are listed, contact SAP support.

---

**6.2.1.3.4 Display Status of Material Ledger Migration Check**

This activity displays the results of the *Check Migration of Material Ledger* activity.
Process

Execute the program for the required client.
If any errors are listed, contact SAP support.

6.2.1.4 Documentation of Data Migration

SAP Customizing contains information about what data is converted and how during migration. To do this, in Customizing, choose ➔ Migration to SAP S/4HANA Finance ➔ Migration ➔ Documentation of Data Migration. The Documentation of Data Migration contains the following sections:

- Migration of Cost Elements
- Technical Check of Transaction Data
- Enrichment of Data
- Migration of Line Items
- Migration of Balances
- Calculation of Depreciation and Totals Values

Before you execute the migration, read these sections. You execute the migration in the Start and Monitor Data Migration Customizing activity.

6.2.1.5 Start and Monitor Data Migration

The central steps for data migration are executed in the Customizing activity Start and Monitor Data Migration.

Prerequisites

You have successfully installed SAP S/4HANA Finance.
You have executed all activities listed in Customizing, in the Preparations and Migration of Customizing section.
You have resolved all errors and inconsistencies in your data.
In Customizing, you have read the documents in the Documentation of Data Migration section.

Features

The single steps of a migration, called mass data activities, are collected in a migration run. In a migration run, the data is always migrated for the client in which you logged on.
You can see the status of the currently running migration run as well as all migration runs that ran to date. If necessary, you can reset individual steps and, under certain circumstances, reschedule them.

The activity **Start and Monitor Data Migration** consists of the following elements:

- **Overview Tab Page**:
  - **Migration Runs**:
    The system displays a list of all migration runs in the client in which you are logged on. The migration runs are numbered. The first run is number 1.
    Additionally, the system displays whether a run was started manually, whether a run has finished, and whether the migration is a full migration or a delta migration.
  - **Migration Run Status**:
    To see detailed information about a migration run, select one of the migration runs from the list above by double-clicking it. The information is now displayed in the **Migration Run Status** group box. You see which mass data activities were executed in the run, and their status.
    - Green traffic light: The mass data activity was executed completely and without errors. The system then started the next mass data activity.
    - Red traffic light: The mass data activity was not executed completely or contained errors. The system stopped the migration run and subsequent mass data activities were not started. Correct the errors or set them to accepted. After you have done this, you can continue with the migration.
  - The arrow in the **Next Step** column marks the mass activity the system executes next.
  - The stop sign in the **Next Step** column marks the activity where the system aborted the migration run.
  - To accept errors that occurred in the mass data activity, do the following:
    1. Double-click the mass data activity in which the error occurred.
       The system displays the status screen.
    2. Navigate to the current migration run and double-click the line that is marked by the red traffic light.
       The system displays all work packages in a list.
    3. Double-click the package in which you want to accept errors.
       The system displays the detailed application log for the work package.
    4. Select the error you want to accept, and choose **Accept Error**.

- **Control Tab Page**
  On the **Control** tab page, you can start a migration run. Here, the system also displays the data for the migration run running currently.
  - **Process Control**
    In this group box, you can see which activity the system is executing currently and the one it will execute next. You can also see when a migration run was halted.
    The system also displays whether an activity was selected and run by a user. If no user name is displayed, no manual changes were made and the system executes the activities automatically in the predefined sequence.
  - **Load Balancing**
Here, you see the technical data for the current run. The figures for **Active Jobs** and **Current CPU Utilization** are filled automatically by the system.

- **Status of the Current Migration Run**
  Information for the current migration run is displayed here. From here, you can start or halt an activity, repeat check activities, and reschedule activities. You can also navigate to a detailed application log for each activity.

- **Tables Tab Page**
  Here, the system displays the number of entries in the most important tables that play a role in data migration.

⚠️ **Caution**
If you accept errors, this does not mean that the errors were corrected. Errors continue to exist in the data. SAP recommends that you use this function only after careful analysis and consideration of the consequences. For example, you can accept errors that occurred in fiscal years long past and that are no longer relevant for you.

### Activities

1. To start the data migration, in Customizing, select **Migration to SAPS/4HANA Finance Migration Start and Monitor Data Migration**.
2. Select the **Control** tab page and click **Start**.
   The system starts the migration run.
   - To halt the migration run, select **Set Halt**.
   - To continue the migration run, select **Start**.
   - To reset a mass activity, select the activity, and then select **Next Activity**. The system resets the activity and all affected activities, and sets the status to **To Be Repeated**.

### 6.2.1.6 Migrate General Ledger Allocations

#### Procedure

To migrate general ledger allocations, in Customizing, choose **Migration to SAP S/4HANA Finance Migration Migrate general Ledger Allocations**.
For more information, see the documentation for the Customizing activity.

### 6.2.1.7 Completing the Migration

In Customizing, you perform all activities in the section **Migration to SAP Accounting powered by SAP HANA Migration Migration of Balances**. For more information, see the documentation of the Customizing activity.
Note
You perform all of the steps in your test system and production system.
You perform all of the steps if you are using classic Asset Accounting, new Asset Accounting, classic General
Ledger Accounting, new General Ledger Accounting, or the SAP Simple Finance add-on 1.0.

Process
You perform all of the activities if you are using classic Asset Accounting, new Asset Accounting, classic General
Ledger Accounting, new General Ledger Accounting, or the SAP Simple Finance add-on 1.0.
You perform all the following activities in your test system and production system.

1. Execute the activity Calculate Initial Depreciation Values.
2. Execute the activity Reconcile Depreciation Values and Totals Values in Asset Accounting.
3. Execute the activity Reconcile and Compare Migrated Data.
4. Execute the activity Set Migration to Completed.

6.2.1.8 Migration of House Bank Accounts

Note

- If you do not use SAP Cash Management
  Perform the following steps in your test system and production system.
- If you use SAP Cash Management
  You can skip this topic and follow the instructions in the Data Setup Guide for SAP Cash Management to
  migrate house bank accounts and set up the bank account master data. The guide is available at SAP
  Service Marketplace at service.sap.com/erp-inst ➔ SAP ERP Add-Ons ➔ SAP S/4HANA Finance, On-

House bank accounts have been merged into bank account master data. As a consequence, you need to migrate
house bank accounts originally stored in database table T012K to table FCLM_BAM_ACLINK2. After the migration,
you can use the house bank accounts as usual. However, to create and maintain house bank accounts, you must
do so by editing the bank account master data.

After you migrate existing house bank accounts, you can create new house banks and house bank accounts, if
necessary.

To create house banks, you can use transaction FI12_HBANK.

To create house bank accounts, you can do so by editing the connectivity path for bank accounts.

Note

After the migration, you can only work with house bank accounts using the Web Dynpro user interfaces. To be
able to use the Web Dynpro user interfaces, the following must be configured in the back-end server:

- Set up the SAP NetWeaver Business Client (NWBC).
Prerequisites

Make sure you have configured the following Customizing activities before you migrate house bank accounts. You can find them under [Financial Supply Chain Management > Cash and Liquidity Management > Bank Account Management > Basic Settings].

- Number ranges for bank account IDs
  In bank account master data, each bank account is assigned with a technical ID when created. To define the technical ID assignment rules, configure the following Customizing activities:
  1. In the Customizing activity Define Number Ranges for Bank Account Technical IDs, define number ranges for bank account technical IDs.
  2. In the Customizing activity Define Settings for Bank Account Master Data, on the Bank Account Master Data Setting tab, specify a number range for the Tech. ID No. Rang field.

- Number ranges for change requests
  The system automatically assigns a number to a change request once it is created in Bank Account Management. To configure the change request ID assignment rules, configure the following Customizing activities:
  1. In the Customizing activity Define Number Ranges for Workflow Change Requests, define number ranges for change requests.
  2. In the Customizing activity Define Settings for Bank Account Master Data, on the Bank Account Master Data Setting tab, specify a number range for the Req. No. Rang field.

- Bank account types
  Bank account type is one of the attributes in bank account master data. You can define different types of accounts to suit different business purposes. Account types can be used as an analysis dimension in reporting and planning.
  To maintain bank account types, in Customizing activity Define Settings for Bank Account Master Data, define account types on the Account Type Definition tab.

Activities

To migrate the house bank accounts, you can use transaction FCLM_BAM_MIGRATION. It migrates your house bank accounts to Bank Account Management Lite and creates bank account master data based on existing house bank accounts, with the most essential business data including:

- Key information such as bank account number, bank key, bank country, and bank name.
- The connectivity between bank accounts and house bank accounts.
During the implementation phase, you may work with several systems such as the development system, the testing system, and the production system. You can perform the migration in either of the following ways.

- If the systems you work with store the same set of house bank accounts, proceed as follows:
  1. In one of your systems, perform the migration.
  2. If necessary, create new bank account master data (including house bank accounts).
  3. Transfer all the bank account master data to other systems.

- If the systems you work with store different sets of house bank accounts, proceed as follows:
  1. In each of your systems, perform the migration.
  2. If necessary, in one of the systems, create new bank account master data (including house bank accounts).
  3. Transfer the bank account master data selectively from the system in step 2 to other systems, according to your business needs.

**Note**

- Creating or modifying bank account master data (including house bank accounts) does not trigger transport to other systems. To massively transfer the bank account master data, you can use the tool *Import and Export Bank Accounts*.

- After the go-live, you are recommended to maintain your bank account master data in your production system. You can transfer the master data to other systems, such as testing or development systems, if necessary.

For more information on how to use this tool, see the program documentation of transaction *FCIM_BAM_MIGRATION*.

### 6.2.2 Activities to be Executed After the Migration

In Customizing, you perform all activities in the section *Migration to SAP Accounting powered by SAP HANA > Migration > Activities After Migration*. For more information, see the documentation of the Customizing activity.

**Process**

**Note**

You perform the following steps in your test system and production system.

You perform the following activities if you are using classic Asset Accounting, new Asset Accounting, classic General Ledger Accounting or new General Ledger Accounting.

1. Execute the activity *Transfer Application Indexes*.
2. Execute the activity *Display Status of Transfer of Application Indexes*.
3. Execute the activity *Fill Due Dates in FI Documents*.
4. Execute the activity *Display Status of Filling in Due Dates into FI Documents*.
Note
You perform all of the following activities if you are using classic Asset Accounting, new Asset Accounting, classic General Ledger Accounting, new General Ledger Accounting, or the SAP Simple Finance add-on 1.0. You perform all the following activities in your test system and production system.

1. Execute the activity Fill the Offsetting Account in FI Documents.
2. Execute the activity Display Status of Filling the Offsetting Account in FI Documents.
3. Execute the activity Migrate House Bank Accounts.

6.2.2.1 Activities and Business Reconciliation After Migration

After the migration, perform the activities in Customizing under Migration to SAP Accounting powered by SAP HANA Migration Activities After Migration. These steps are not absolutely necessary to ensure the data is both complete and correct, and can be performed as needed and within the uptime.

Process

1. To complete the migration of the data to the universal journal entry structure, and to check the migration is correct, execute the reports again that you executed prior to the migration to compare the FI data, and compare this data with the results you had before the migration. This involves the following steps:
   ○ Perform closing for periodic asset postings (with program RAPERB2000).
   ○ Execute the periodic depreciation posting run (with program RAPOST2000).
   ○ Check for update terminations in your system and correct any you find.
   ○ Lock the periods in Financial Accounting and Controlling (Plan/Actual).
   ○ For customers who are already using account-based profitability analysis: Perform a delta upload for all of your account-based CO-PA DataSources for which you use the delta method.
   ○ Make sure that all of the balances carried forward to the current fiscal year are transferred.
   Document the results.
2. Once the comparison of the data does not produce any errors, you have completed the migration successfully. Set the Migration Complete indicator in Customizing under Migration to SAP Accounting powered by SAP HANA Complete Migration Set Migration to Complete.

6.2.2.2 Preparation for Productive Start

Procedure

You need to perform the following activities before you use the system again live.
Note
You perform the following steps in your test system and production system.
You perform the following activities if you are using classic Asset Accounting, new Asset Accounting, classic General Ledger Accounting or new General Ledger Accounting, or the SAP Simple Finance add-on 1.0.

1. Unblock all users in the system
2. Open the periods in Financial Accounting and in Controlling (Plan/Actual).

6.2.3 SAP Credit Management: Migrate Data

Context

FI-AR-CR Credit Management is not available in SAP S/4HANA, on-premise edition 1511. It has been replaced by SAP Credit Management (FIN-FSCM-CR) for Financials and Sales and Distribution (SD). If you were using FI-AR-CR Credit Management, you have to perform the following steps to migrate the following data to SAP Credit Management (FIN-FSCM-CR):

- Configuration data
- Master Data
- Credit Exposure Data
- Credit Decision Data

You need to perform the necessary migration steps, after the technical downtime of the conversion.


Prerequisites

- You have finished the migration for Accounting.
  For more information, see Migration to SAP S/4 HANA Finance [page 32].
- If you are running on your own code, you have eliminated the usage of SAP objects in your own code.
  For details on how to adapt user-defined customer code that relies on the changed objects, see the following SAP Notes:
  ○ 2227014 (Financials)
  ○ 2217124 (SD)
- You have converted your master data (vendor or customer data) to business partner data.
  For details on how to do this, see Preparation for Master Data for Business Partner [page 24].
- You have configured your system for credit management.
  For more information, perform the steps in the sections mentioned below in the Configuration Guide SAP Credit Management on SAP Help Portal for SAP S/4HANA at SAP S/4HANA, on-premise edition > SAP.
Steps

The migration steps are available as Customizing activities (transaction SPRO, SAP Reference IMG). Please carry out the steps one after the other, by choosing:

- Migration from SAP ERP to SAP Accounting powered by SAP HANA \> Preparations and Migration of Customizing \> Preparatory Activities and Migration of Customizing for Credit Management

For more information about data migration, see the documentation of the individual steps in the SAP Reference IMG (Implementation Guide) in the system.

More Information

- Review the Simplification List [page 0]
- Sections Sales & Distribution \> Credit Management or Financials \> Credit Management in the SAP S/4 HANA Simplification List

You can access the Simplification List at the SAP Help Portal help.sap.com/s4hana_op_1511_001.

6.2.4 SAP Cash Management: Migrate Data

The classic SAP Cash and Liquidity Management (FIN-FSCM-CM and FIN-FSCM-LP) is not available in SAP S/4HANA, on premise edition. Instead, you can use the new SAP Cash Management (FIN-FSCM-CLM) with SAP S/4HANA, on premise edition. If you have been using the classic SAP Cash and Liquidity Management, you can migrate relevant master data and transactional data to the new SAP Cash Management.
This chapter introduces the activities that you need to perform to migrate and set up data before you go live with SAP Cash Management.

This chapter is applicable to the following customers:

- Customers who have been using the classic SAP Cash and Liquidity Management and would like to migrate relevant master data and transactional data to the new SAP Cash Management.
- Customers who want to transfer cash management relevant information stored in remote systems (either SAP systems or non-SAP systems) to the SAP Cash Management system.

**Prerequisites**

You have fulfilled the following prerequisites before you continue with the migration activities:

- You have installed SAP S/4HANA 1511 FPS01.
  
  For more information, see the Installation Guide for SAP S/4HANA 1511 FPS01 at help.sap.com/s4hana_op_1511_001.

- You have finished the migration for Accounting.
  
  For more information, see Migration of Accounting Data [page 32].

- You have switched on the business function FIN_FSCM_CLM.

- Make sure you apply all the mentioned notes in SAP Note 2214054 (Release Information Note: SAP Cash Management) according to your product version.

- Your user is configured with the required back-end authorization and front-end authorization.

### 6.2.4.1 Create Bank Account Master Data

Before you start to use SAP Cash Management, you must set up the bank account master data. Each bank account master record contains the following attribute categories.
### 6.2.4.1.1 Prerequisites

Before you work with bank account master data, make sure you have properly configured the following settings:

- Number ranges for bank account technical IDs
- Banks and house banks
- Business partners for banks
- Business partners for external contacts (optional)

#### 6.2.4.1.1.1 Number Ranges for Bank Account Technical IDs

In bank account master data, each bank account is assigned with a technical ID when created. To define the technical ID assignment rules, configure the following Customizing activities under [Financial Supply Chain Management > Cash and Liquidity Management > Bank Account Management > Basic Settings](#):

1. In the Customizing activity [Define Number Ranges for Bank Account Technical IDs](#), define number ranges for bank account technical IDs.
2. In the Customizing activity [Define Settings for Bank Account Master Data Settings](#) tab, specify a number range for the **Tech. ID No. Rang** field.

#### 6.2.4.1.1.2 Banks and House Banks

- Before you migrate bank account master data, maintain banks in your cash management system.

You can either create banks manually in transaction [FI01](#), or use a bank upload tool in [SAP Customizing Implementation Guide > Cross-Application Components > Bank Directory > Bank Directory Data Transfer](#).
• For bank accounts used by payments, bank statements, or bank transfers in your central SAP Cash Management system, their corresponding house bank and house bank accounts must be configured.

You can use transaction **FI12_HBANK** to maintain the house banks.

### 6.2.4.1.1.3 Business Partners for Banks

With Bank Account Management, each bank in use must be represented by a business partner instance and with a linkage maintained between the bank (entry in table BNKA) and the business partner instance. To define the business partners for banks, we recommend that you define the bank hierarchy first. After you define the position of a bank in the bank hierarchy, the system automatically assigns or creates a business partner, and establish the linkage between the business partner and the bank.

1. Open the Manage Bank Account app. In the bank hierarchy view, choose the **Edit** button.
2. In the bank hierarchy view, choose the **Edit** button.
3. From the list, select a node under which you want to add the bank.
4. Choose the **Add Existing Bank** button and specify the **Bank Country** and **Bank Key** of the bank to be added.
5. After the bank is added to the hierarchy, the system checks whether the bank has a corresponding business partner instance with role TR0703:
   - If yes, the system assigns the business partner instance to the bank.
   - If the bank has a corresponding business partner without role TR0703, the system adds the role TR0703 to the existing business partner
   - If the bank does not have any corresponding business partners, the system creates a business partner instance for the bank, with role TR0703 assigned.
6. To check the created business partners and the established linkages, check the entries in transaction **FCLM_BAM_BNKA_BP**.

### 6.2.4.1.1.4 Business Partners for External Contacts (Optional)

**Note**

This activity is only required if you plan to import Contact at Bank and Bank Relationship Manager using the Import and Export Bank Accounts tool.

In the bank account import file, you may maintain the Contact at Bank and Bank Relationship Manager fields. After the file is imported, the specified contact persons can be assigned to the bank account automatically and also assigned to the bank’s business partner automatically. As the two contact persons are external to the company, they can only be represented by a business partner instance with the BP Role of BUPO01 Contact Person.

To use these two fields for external contacts, you must create business partner for external contacts and configure the relationship between contact business partners and bank business partners. To do so, choose either of the following two methods:
Note down the IDs of business partners for external contacts. Later when you specify the **Contact at Bank** and the **Bank Relationship Manager** field in the Excel, make sure you use the ID of business partners.

- Import business partners and configure business partner relationship using a Microsoft Excel file.
  
  For more information on how to use the tool, see SAP Library at [help.sap.com](http://help.sap.com), under **Financial Management > SAP Strategic Enterprise Management > SAP SEM 6.0 > SEM - Strategic Enterprise Management > Business Consolidation (SEM-BCS) > Master Data and Hierarchies > Organizational Unit > Consolidation Unit > Business Partner Data > Uploading Business Partner Data with a Microsoft Excel File**.

- Create business partners manually using the program **Maintain Business Partner** (transaction **BP**).
  
  To assign a contact person to a bank, in transaction **BP**, find the business partner of this bank, and then assign the business partner that represents the contact person to this bank by using relationship **FBUR001 Has Contact Person**.

### 6.2.4.1.2 Migrate House Bank Accounts

House bank accounts have been merged into bank account master data. As a consequence, you need to migrate house bank accounts originally stored in database table **T012K** to table **FCLM_BAM_ACLINK2**. After the migration, you can use the house bank accounts as usual. However, to create and maintain house bank accounts, you must do so by editing the bank account master data.

To do so, you can use transaction **FCLM_BAM_MIGRATION** to migrate your house bank accounts to Bank Account Management and create bank account master data based on house bank account data. It enables you to generate bank account master data from house bank accounts with the most essential business data including:

- Key information such as bank account number, bank key, bank country, and bank name.
- House bank accounts
- The connectivity between bank accounts and house bank accounts

For more information on how to use this tool, see the program documentation of transaction **FCLM_BAM_MIGRATION** by choosing the blue information button.

### 6.2.4.1.3 Import and Export Bank Accounts

If your bank account data is stored in remote systems, you are recommended to use this tool to migrate your data from either SAP systems or non-SAP systems to the system where SAP Cash Management is installed.

With this tool, you can download a template XML file in spreadsheet format, with which you may prepare the bank account master data and attributes from your remote systems. Once you have finished preparing the file, you may import it to SAP Cash Management.

The tool helps you migrate the following data:

- General data
- Payment signatories
- Overdraft limits
Connectivity path
You can build the connectivity between a bank account and a house bank account or other account records in either the SAP Cash Management system or other remote systems.

Additional data

Prerequisites

- You use Microsoft Office 2010 or higher that contains Microsoft Excel.
- To enable the Developer tab in Microsoft Excel, go to File > Options > Customize Ribbon.
  From Customize the Ribbon, select the Developer checkbox and choose OK.

Procedure

For information on how to use this tool, see the application help for SAP Cash Management.

1. In the Manage Bank Accounts app, switch to the Account List view.
2. Choose Import and Export Bank Accounts.
3. To prepare bank account data to be migrated, download the template by choosing Download XML Spreadsheet Template.
4. Save and open the file XML_SpreadSheet_Template.xml.
5. The template contains the follow sheets. You may choose to maintain information that is essential to your business operations either by manual entering data or by copying and pasting data to the corresponding sheets.
   ○ General Data
     If you want to import data for the following two fields, enter the corresponding business partner IDs.
     ○ Contact at Bank
     ○ Bank Relationship Manager
     ○ Payment Signatories
     ○ Overdraft Limits
     ○ Additional Data
     ○ Connectivity Path
6. On the Developer tab, choose Export to export the data as an XML file.
7. To import the bank accounts, specify the import path of the XML source data file generated in the previous step and then choose Import to upload the file.

Note

- Before you export data Microsoft Excel, check the data and make sure the following:
  ○ All the bank account entries you want to import are inside the blue frame.
  The application does not import data outside of the frame.
  ○ There are no empty rows between bank account entries.
  The application treats empty rows as incorrect entries.
We recommend that you first choose *Import with Test Run* to simulate the import and check potential issues.

8. If you encounter errors, select an entry and then choose the *Details* button to check the details.

### 6.2.4.2 Set Up Cash Management Data

This activity is to set up transactional data that will be used by Cash Management applications, for example apps of SAP Cash Management.

SAP Cash Management consumes data from the following applications:

- Memo records (database table FDES)
- One Exposure from Operations (database table FQM_FLOW) for data from other components like accounting, end-of-day bank statements, TRM, CML, FI-CA, and integrated data from remote systems.

To use SAP Cash Management, perform the following data setup activities:

- **Build Key Information in Accounting Documents** [external document] (database table BSEG)
- **Load Data into One Exposure from Operations Hub** [external document]
  
  Load data from Treasury and Risk Management (TRM), Loans Management (FS-CML), Contract Accounts Receivable and Payable (FI-CA), and integrated remote systems, into the One Exposure from Operations hub.

### 6.2.4.2.1 Prerequisites

You have configured the following:

- One Exposure from Operations
- Source applications
- Flow types
- Liquidity items and liquidity item hierarchies
- Planning levels and planning groups
- Field status

### 6.2.4.2.2 Build Key Information in Accounting Documents

Data such as liquidity items, flow types, house banks, and house bank accounts are key to the calculation of Cash Management. To build key information in accounting documents that are already posted to ledgers, perform the following Customizing activities under *

**Financial Supply Chain Management**  
**Cash and Liquidity Management**  
**Data Setup**

- **Rebuild Planning Levels, Groups, Dates in Accounting Documents**

  This activity is to populate attributes or attribute changes to customers and vendors master data in one shot.

  With the *Data Setup* function, you can rebuild the *Planning Level* and *Planning Group* fields in database table...
BSEG. When you change the assignment of planning levels to G/L accounts, or the assignment of planning groups to customers or vendors, you can execute the Data Setup function to fill in the updated planning level and planning group information into the existing BSEG records.

- Rebuild Flow Types in Accounting Documents
- Rebuild Liquidity Items in Accounting Documents
- Insert House Bank and House Bank Account Data to Accounting Documents

### 6.2.4.2.3 Load Data into One Exposure from Operations Hub

The One Exposure from Operations hub is a central storage location for operational data that is relevant for managing cash and liquidity. The provision of the data in the One Exposure from Operations hub facilitates funds planning and risk management across multiple companies. Currently, SAP Cash Management uses One Exposure from Operations to acquire the following data:

- **Transaction data from source applications in the central SAP Cash Management system:**
  - Financial Operations
  - Treasury and Risk Management (TRM)
  - Consumer and Mortgage Loans (FS-CML)
  - Contract Accounts Receivable and Payable (FI-CA)
  - Materials Management (MM)
  - Sales and Distribution (SD)

To upload existing data from these source applications, perform the activity **Load Transaction Data from Source Applications into One Exposure from Operations Hub**. You can find this in the SAP Reference IMG under **Financial Supply Chain Management > Cash and Liquidity Management > Cash Management > Data Setup**.

- **Data from integrated remote systems:**
  - Bank account balances via Microsoft Excel upload
    - To upload bank account balances (derived from external sources), in the central system, perform the activity **Import Bank Cash Balances**, in the SAP menu under **Accounting > Financial Supply Chain Management > Cash and Liquidity Management > Tools > One Exposure from Operations**.
  - Expected cash flows from classic SAP Cash Management via IDoc
    - To transfer classic Cash Management data to the One Exposure from Operations hub, in the remote systems, perform the activity **Send TR-CM Data**, in the SAP menu under **Accounting > Financial Supply Chain Management > Cash and Liquidity Management > Tools > Distribution > TR-CM Subsystems**.
    - The transfer of the classic Cash Management data is triggered by a request of the central system. To do this, in the central system, perform the activity **Retrieve CM Data**, in the SAP menu under **Accounting > Financial Supply Chain Management > Tools > Distribution**.
  - SAP Liquidity Planner actuals via Web Service
    - To transfer data from SAP Liquidity Planner into the One Exposure from Operations hub, in the remote systems, perform the activity **Initial and Periodic Update**, in the SAP menu under **Accounting > Financial Supply Chain Management > Cash and Liquidity Management > Liquidity Planner > One Exposure Update**.
6.3  Sales

6.3.1  Order and Contract Management

6.3.1.1  Data Model Changes in SD Pricing

For details on preparation steps for data model changes in SD pricing, see Data Model Changes in SD Pricing [page 66].

**Note**

As a follow-up activity, SAP recommends that you run the post-processing report `PRC_MIG_POST_PROCESSING` as soon as possible.

For further details, see the chapter linked to above.

6.3.1.2  SD Rebate Processing Replaced by Settlement Management

**Description**

In general, SD Rebate Processing is not available in SAP S/4HANA, on-premise edition 1511. The successor of SD Rebate Processing is Settlement Management.

**Note**

However, there is one exception: SAP CRM Trade Promotion Management (TPM) customers can still use SD Rebate Processing for their business processes, but have to adapt to an SAP S/4 HANA-optimized solution. For details, see Optimization of SD Rebate Processing for Trade Promotion Management [page 126].

Existing rebate agreements can only be processed up until the end of the validity date of the agreement, and must then be closed by a final settlement. New agreements can only be created based on condition contracts. Therefore, the corresponding transaction codes VBO1 resp. VBD for the creation of rebate agreements are not available any more.

**Related SAP Notes**

<table>
<thead>
<tr>
<th>Table 60</th>
<th>Custom Code</th>
<th>SAP note</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>2226380</td>
</tr>
</tbody>
</table>
More Information

For more information, see the Simplification List [page 0], section Sales & Distribution > SD Rebate Processing replaced by Settlement Management.

6.3.1.3 Optimization of SD Rebate Processing for Trade Promotion Management (TPM) Customers

Description

Customers who will integrate their existing CRM TPM scenario with S/4HANA, on-premise edition, still have to use SD Rebate Processing, even though a successor is already being provided by Settlement Management. For details, see SD Rebates Replaced by Settlement Management [page 125].

For those customers, the existing SD Rebate functionality is optimized with regard to the database footprint. For this purpose, from a technical standpoint, the rebate index table VBOX is no longer used.

Note

Please note that TPM customers are also not able to create new rebate agreements in SAP S/4HANA or extend existing ones (as described in SD Rebates Replaced by Settlement Management [page 125]). However, this is not necessary for the TPM process, since rebate agreements are created by CRM TPM for this business process.

Related SAP Notes

Table 61

<table>
<thead>
<tr>
<th>Custom Code</th>
<th>SAP Note2200691</th>
</tr>
</thead>
</table>

Required and Recommended Action(s)

- If you use extended SD rebate processing, a rebuild of the $469 content is required after the conversion.
- You have to maintain new Customizing settings.

More Information

For more information, see the Simplification List [page 0], section Sales & Distribution > Optimization of SD Rebate Processing for Trade Promotion Management (TPM) Customers.
6.3.1.4 SAP Credit Management: Migrate Data

Context

*FI-AR-CR Credit Management* is not available in SAP S/4HANA, on-premise edition 1511. It has been replaced by *SAP Credit Management* (FIN-FSCM-CR) for Financials and Sales and Distribution (SD). If you were using *FI-AR-CR Credit Management*, you have to perform the following steps to migrate the following data to *SAP Credit Management* (FIN-FSCM-CR):

- Configuration data
- Master Data
- Credit Exposure Data
- Credit Decision Data

You need to perform the necessary migration steps, after the technical downtime of the conversion.


Prerequisites

- You have finished the migration for Accounting.
  
  For more information, see Migration to SAP S/4 HANA Finance [page 32].

- If you are running on your own code, you have eliminated the usage of SAP objects in your own code.
  
  For details on how to adapt user-defined customer code that relies on the changed objects, see the following SAP Notes:
  
  - 2227014 (Financials)
  - 2217124 (SD)

- You have converted your master data (vendor or customer data) to business partner data.
  
  For details on how to do this, see Preparation for Master Data for Business Partner [page 24].

- You have configured your system for credit management.
  

  - System and Component Landscape
  - Business Customizing > Settings in SAP Credit Management (FIN-FSCM-CR)

- You have configured the Web service runtime (bgRFC supervisor destination, ICF nodes activation, IDP settings) as described in SAP Note 1043195.

- An entry for the logical system must be setup correctly in table T000.
Steps

The migration steps are available as Customizing activities (transaction SPRO, SAP Reference IMG).

Please carry out the steps **one after the other**, by choosing:

- **Migration from SAP ERP to SAP Accounting powered by SAP HANA**
- **Preparations and Migration of Customizing**
- **Preparatory Activities and Migration of Customizing for Credit Management**

and

- **Migration**
- **Credit Management Migration**

For more details on these steps, see the documentation of the individual steps in the SAP Reference IMG (Implementation Guide) in the system.


More Information

- Review the Simplification List [page 0]
- Sections Sales & Distribution > Credit Management or Financials > Credit Management in the SAP S/4 HANA Simplification List

You can access the Simplification List at the SAP Help Portal help.sap.com/s4hana_op_1511_001 Additional Information.

6.4 Sourcing and Procurement

6.4.1 Activities in Purchasing

After converting from SAP ERP to SAP S/4HANA, you have to perform the activities described below for the purchasing area.

Customize Output Management

With SAP S/4HANA, a new output management approach is in place. The new architecture is based on Adobe Document Server and Adobe Forms only. For all purchase orders created in SAP S/4HANA, the new output management is used.

Purchase orders that were created in SAP ERP are still processed using the NAST-based output control after the conversion. You can check the relevant settings in Customizing for Materials Management under Purchasing > Messages > Output Control.

For purchase orders that were created after the conversion, you have to customize the new output management in Customizing for Cross-Application Components under Output Control.
For detailed information, see SAP Note 2228611.

**Customize Attachment Handling**

The attachments of purchase orders are stored in GOS (Generic Object Services), therefore you must make the following new entry: EKKO in the field SAP object and BUS2012 in the field Object Type.

You make these settings in Customizing for Cross-Application Components under [Document Management](#) > Additional Settings - Simplification > Attachment Service - Object Type Mapping.

### 6.5 Environment, Health, and Safety

You can convert from releases 1.0 to 6.0 for component extensions for SAP EHS Management to Environment, Health, and Safety. The following sections provide information about EHS-specific follow-up activities after converting to Incident Management and Health and Safety Management.

#### 6.5.1 Activities After Converting to Incident Management

#### 6.5.1.1 Conversion from Component Extension 1.0 for SAP EHS Management

If you convert Incident Management from component extension 1.0 for SAP EHS Management to Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under [Environment, Health and, Safety](#) > Foundation for EHS > Process Foundation > Basic Settings.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion.
  - The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- Adjust all Customizing settings and classes for field control from client 000. Using old Customizing settings or classes can lead to short dumps.
- The authorization object EHHSS_INC1 (access to incidents) has an additional activity C5 (Reopen).
  - If you have already been granted authorizations to your roles/profiles using this authorization object, you may need to check whether it is also necessary to grant this new activity for reopening closed incidents. The following new authorization objects are available:
    - EHHSS_INC2
You should additionally configure these authorization objects. If authorization objects EHHSS_INC3 and EHHSS_INC5 are not applicable for your use case, you can deactivate the objects by deactivating the corresponding BAdI in Customizing for Environment, Health, and Safety under \Incident Management\ Business Add-Ins \Business Add-Ins for Authorization\ BAdI: Extended Authorization Checks.

- See SAP Note 1970106 for details regarding the changed usages of the fatality flag.
- See SAP Note 1970313 for details regarding the deletion of class CL_EHHSS_INC_INVDET_UI_FRM and component configuration EHHSS_INC_REC_OIF_V3_INVDETA_FRM.
- Run the report R_EHHSS_INC_ADJUST_LINK_TBL.

The database table EHHSSD_INC_LINKI was enhanced with an additional field LINK_CATEGORY that specifies whether a link links to a risk assessment or an incident.

The report fills the table with default values (specifying the link as a link to an incident).

- Add Personnel Number field to customer-specific versions of offline forms for initial near miss and safety observation.

The forms in the standard system are delivered with the new field for the personnel number. If you copied this form in an earlier release, you may want to add this new field and its logic to the copy.

- Select the attached document, the notice of violation (NOV), in existing incident records.

In the previous version, you could indicate that the NOV was attached. Now, you can also choose which of the attached documents the NOV is. It appears linked on the tab for notice of violations in incident management.

\begin{itemize}
\item Note
\end{itemize}

Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

### 6.5.1.2 Conversion from Component Extension 2.0 for SAP EHS Management

If you convert Incident Management from component extension 2.0 for SAP EHS Management to Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under \Environment, Health and, Safety\ \Foundation for EHS\ \Process Foundation\ \Basic Settings\.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion.

The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.

- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
• Adjust all Customizing settings and classes for field control from client 000. Using old Customizing settings or classes can lead to short dumps.

• The authorization object EHHSS_INC1 (access to incidents) has an additional activity C5 (Reopen).

If you have already been granted authorizations to your roles/profiles using this authorization object, you may need to check whether it is also necessary to grant this new activity for reopening closed incidents. The following new authorization objects are available:
  ○ EHHSS_INC2
  ○ EHHSS_INC3
  ○ EHHSS_INC5

You should additionally configure these authorization objects. If authorization objects EHHSS_INC3 and EHHSS_INC5 are not applicable for your use case, you can deactivate the objects by deactivating the corresponding BAdI in Customizing for Environment, Health, and Safety under Incident Management Business Add-Ins Business Add-Ins for Authorization BAdI: Extended Authorization Checks.

• See SAP Note 1970106 for details regarding the changed usages of the fatality flag.

• See SAP Note 1970313 for details regarding the deletion of class CL_EHHSS_INC_INV_DET_UI_FRM and component configuration EHHSS_INC_REC_OIF_V3_INVDETA_FRM.

Note
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

6.5.1.3 Conversion from Component Extension 3.0 for SAP EHS Management

If you convert Incident Management from component extension 3.0 for SAP EHS Management to Environment, Health, and Safety, carry out the following activities:

• Clear POWL caches according to SAP Note 1916079.

• Carry out the Customizing activity Perform Automatic Workflow Customizing under Environment, Health and Safety Foundation for EHS Process Foundation Basic Settings.

• Run report R_EHFND_LHR_BUILD_PATH after the conversion.

The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.

• If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.

• Adjust all Customizing settings and classes for field control from client 000. Using old Customizing settings or classes can lead to short dumps.
Note
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

6.5.1.4 Conversion from Component Extension 4.0 for SAP EHS Management

If you convert Incident Management from component extension 4.0 for SAP EHS Management to Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under Environment, Health and Safety → Foundation for EHS → Process Foundation → Basic Settings.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion.

The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.

- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.

Note
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

6.5.1.5 Conversion from Component Extension 5.0 for SAP EHS Management

If you convert Incident Management from component extension 5.0 for SAP EHS Management to Environment, Health, and Safety, carry out the following activity:

- Clear POWL caches according to SAP Note 1916079.
6.5.1.6 Conversion from Component Extension 6.0 for SAP EHS Management

If you convert Incident Management from component extension 6.0 for SAP EHS Management to Environment, Health, and Safety, no further activities are required.

**Note**

Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

6.5.1.7 Conversion from EHS Management as part of SAP ERP

If you convert Industrial Hygiene and Safety (EHS-IHS) of EHS Management as part of SAP ERP to Incident Management of Environment, Health, and Safety, carry out the following activities:

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  - All EHFND* and EHHSS* services
  - POWL
  - IBO_WDA_INBOX
  - WDR_CHIP_PAGE
- Also activate the following services
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5 and on the path /default_host/sap/public/bc/ui5_ui5.
- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for Environment, Health, and Safety under Foundation for EHS and under Incident Management.
- Import the data that you have exported before the conversion into your SAP S/4HANA system and carry out the necessary activities as described in the data migration information in SAP Note 2198406.
6.5.2 Activities After Converting to Health and Safety Management

6.5.2.1 Conversion from Component Extension 2.0 for SAP EHS Management

If you convert Risk Assessment from component extension 2.0 for SAP EHS Management to Health and Safety Management of Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under Environment, Health and Safety Foundation for EHS Process Foundation Basic Settings.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion.
  The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- In Health and Safety Management, you can use a workplace sampling process. This process supports the gathering of workplace sampling data that replaces the amounts of data series. For more information, see SAP Note 2065178.
  With workplace sampling data, the menu item Amounts and the corresponding service Create Data Series is no longer required. For this reason, remove the menu items for Amounts and Data Series from your PFCG roles and replace them with the corresponding menu entries for workplace sampling.
  Note that the delivered PFCG roles (for example SAP_EHSM_MASTER) contain the corresponding menu entries and services for workplace sampling under Health and Safety Overview Workplace Sampling.
- With workplace sampling, the feature to request amounts as a separate step in the risk assessment has been replaced. For this reason, the Customizing activity Specify Assessment Steps and Analysis Methods under Environment, Health, and Safety Health and Safety Management Risks Analysis no longer contains step EHHSS_RAS_STEP15.
  If you included this step in your Customizing, remove it for each risk assessment type in the Customizing view Assign Assessment Steps.
- Run report R_EHHSS_UPGRADE_JHA to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.
- Run report R_EHHSS_RAS_CASE_INSENS_SEARCH after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.
- If you have used agents for risk assessment in component extension 2.0 for SAP EHS Management to store rudimentary data for chemicals you may need to manually move the data into the chemical business object.
6.5.2.2 Conversion from Component Extension 3.0 for SAP EHS Management

If you convert Risk Assessment from component extension 3.0 for SAP EHS Management to Health and Safety Management of Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under Environment, Health and Safety > Foundation for EHS > Process Foundation > Basic Settings.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion. The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will not work.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- In Health and Safety Management, you can use a workplace sampling process. This process supports the gathering of workplace sampling data that replaces the amounts of data series. For more information, see SAP Note 2065178.

With workplace sampling data, the menu item Amounts and the corresponding service Create Data Series is no longer required. For this reason, remove the menu items for Amounts and Data Series from your PFCG roles and replace them with the corresponding menu entries for workplace sampling.

Note that the delivered PFCG roles (for example SAP_EHSM_MASTER) contain the corresponding menu entries and services for workplace sampling under Health and Safety > Overview > Workplace Sampling.

- With workplace sampling, the feature to request amounts as a separate step in the risk assessment has been replaced. For this reason, the Customizing activity Specify Assessment Steps and Analysis Methods under Environment, Health, and Safety > Health and Safety Management > Risks Analysis no longer contains step EHHSS_RAS_STEP15.

If you included this step in your Customizing, remove it for each risk assessment type in the Customizing view Assign Assessment Steps.

- Run report R_EHHSS_UPGRADE_JHA to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.

- Run report R_EHHSS_RAS_CASE_INSENS_SEARCH after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.

- If you have used chemical agents for risk assessment, run the report R_EHFND_MIGRATE_CHM after the conversion. The business object and database structure of EHFND_CHEMICAL has been changed. This report...
will update existing chemicals from the old structure to the new structure. If you have extended the
Customizing for hazard classification or hazard statements, you will need to make some further adjustments.
For more details, see the report documentation.

- The Customizing activity Configure Report to Transfer Listed Substances and OELs is obsolete. You can
check your entries in the view EHFNDV_REGL_FILL using transaction SM30 (Call View Maintenance).
For the new report R_EHFND_FILL_REGL_BY_EHS_SUBST, you have to use BAdI BAdI: Transfer of Chemicals
(BADI_EHFND_CHM_TRANSFER) under [Environment, Health and Safety] Health and Safety Management
 Master Data Configuration > Chemicals > Data Transfer from EHS Specification Database]. For more
details, see the BAdI documentation.

Note
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note
2217208.

6.5.2.3 Conversion from Component Extension 4.0 for SAP EHS Management

If you convert Risk Assessment from component extension 4.0 for SAP EHS Management to Health and Safety
Management of Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- Carry out the Customizing activity Perform Automatic Workflow Customizing under [Environment, Health
and, Safety] Foundation for EHS > Process Foundation > Basic Settings.
- Run report R_EHFND_LHR_BUILD_PATH after the conversion.

The BO and database structure of EHFND_LOCATION_STRUCTURE has been extended. This report will
initialize the new path node. If you do not run this report, some CHIPs on the home pages and side panels will
not work.

- If you have created customer roles, check if the provided template roles contain new menu entries needed to
be integrated into your customer roles. After integration, regenerate the corresponding authorization
profiles.
- In Health and Safety Management, you can use a workplace sampling process. This process supports the
gathering of workplace sampling data that replaces the amounts of data series. For more information, see
SAP Note 2065178.

With workplace sampling data, the menu item Amounts and the corresponding service Create Data Series is
no longer required. For this reason, remove the menu items for Amounts and Data Series from your PFCG
roles and replace them with the corresponding menu entries for workplace sampling.

Note that the delivered PFCG roles (for example SAP_EHSM_MASTER) contain the corresponding menu
entries and services for workplace sampling.

- With workplace sampling, the feature to request amounts as a separate step in the risk assessment has been
replaced. For this reason, the Customizing activity Specify Assessment Steps and Analysis Methods under
step EHSS_RAS_STEP15.

If you included this step in your Customizing, remove it for each risk assessment type in the Customizing
view Assign Assessment Steps.
- Run report `R_EHHSS_UPGRADE_JHA` to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.
- Run report `R_EHHSS_RAS_CASE_INSENS_SEARCH` after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.
- Run report `R_EHHSS_RAS_FIX_CHM_KEY_REF` after the conversion. The report corrects keys for chemical revisions (`CHM_REV_KEY`) in table `EHSSD_RSK_REV`. If you do not run this report, you may have inconsistent data. For more information, see SAP Note 2076880.
- Run report `R_EHFND_CHM_UPGRADE_WPCP` after the conversion. The business object and database structure of `EHFND_CHEMICAL` has been changed. This report will remove duplicate entries in the list of workplace control parameters. If you do not run this report, existing chemicals can show duplicate entries.
- In `Health and Safety Management`, you can use quantitative exposure assessments. The changes in the data model for the quantitative exposure assessment affects the triggering criteria of health surveillance protocols (HSP). Due to the change, some triggering criteria that were created in the component extension for `SAP EHS Management` that contain exposure ratings could now be inconsistent. For more information, see SAP Note 2095991.

Note

Some functions are not available in the `SAP S/4HANA` on-premise edition. For more information, see SAP Note 2217208.

### 6.5.2.4 Conversion from Component Extension 5.0 for SAP EHS Management

#### Conversion from SP00 of Component Extension 5.0 for SAP EHS Management

If you convert `Risk Assessment` from component extension 5.0 for `SAP EHS Management` to `Health and Safety Management` of `Environment, Health, and Safety`, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- In `Health and Safety Management`, you can use a workplace sampling process. This process supports the gathering of workplace sampling data that replaces the amounts of data series. For more information, see SAP Note 2065178.

With workplace sampling data, the menu item `Amounts` and the corresponding service `Create Data Series` is no longer required. For this reason, remove the menu items for `Amounts` and `Data Series` from your PFCG roles and replace them with the corresponding menu entries for workplace sampling.

Note that the delivered PFCG roles (for example `SAP_EHSM_MASTER`) contain the corresponding menu entries and services for workplace sampling under `Health and Safety` » `Overview` » `Workplace Sampling`.

- With workplace sampling, the feature to request amounts as a separate step in the risk assessment has been replaced. For this reason, the Customizing activity `Specify Assessment Steps and Analysis Methods` under...

If you included this step in your Customizing, remove it for each risk assessment type in the Customizing view Assign Assessment Steps.

- Run report R_EHHSS_UPGRADE_JHA to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.
- Run report R_EHHSS_RAS_CASE_INSENS_SEARCH after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.
- Run report R_EHHSS_RAS_FIX_CHM_KEY_REF after the conversion. The report corrects keys for chemical revisions (CHM_REV_KEY) in table EHHSSD_RSK_REV. If you do not run this report, you may have inconsistent data. For more information, see SAP Note 2076880.
- Run report R_EHFND_CHM_UPGRADE_WPCP after the conversion. The business object and database structure of EHFND_CHEMICAL has been changed. This report will remove duplicate entries in the list of workplace control parameters. If you do not run this report, existing chemicals can show duplicate entries.
- In Health and Safety Management, you can use quantitative exposure assessments. The changes in the data model for the quantitative exposure assessment affects the triggering criteria of health surveillance protocols (HSP). Due to the change, some triggering criteria that were created in the component extension for SAP EHS Management that contain exposure ratings could now be inconsistent. For more information, see SAP Note 2095991.

Note

Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

Conversion from FP01 of Component Extension 5.0 for SAP EHS Management

If you convert Risk Assessment from Feature Package 01 of component extension 5.0 for SAP EHS Management to Health and Safety Management of Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- Run report R_EHHSS_RAS_FIX_CHM_KEY_REF after the conversion. The report corrects keys for chemical revisions (CHM_REV_KEY) in table EHHSSD_RSK_REV. If you do not run this report, you may have inconsistent data. For more information, see SAP Note 2076880.
- Run report R_EHFND_CHM_UPGRADE_WPCP after the conversion. The business object and database structure of EHFND_CHEMICAL has been changed. This report will remove duplicate entries in the list of workplace control parameters. If you do not run this report, existing chemicals can show duplicate entries.
- Run report R_EHHSS_UPGRADE_JHA to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.
Run report `R_EHHSS_RAS_CASE_INSENS_SEARCH` after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.

Run report `R_EHHSS_RAS_FIX_ABAGT_KEY_REF` after the conversion. The report corrects keys for airborne agent revisions (`ABAGT_REV_KEY`) in table `EHHSSD_RSK_REV`. If you do not run this report, you may have inconsistent data. For more information, see SAP Note 2077301.

Run report `R_EHHSS_SPLCP_INITIALIZE_ATF` after the conversion. The sampling campaign business object has been extended. This report will initialize the attachment folders for existing sampling campaigns.

Run report `R_EHFND_SPLMT_UPGRADE_TYPE` after the conversion. The configuration table `EHFNDC_SPLMT` has been extended. This report will initialize the new field `EHSM_COMPONENT`. If you do not run this report, some previously created sampling methods will not be visible.

**Note**
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.

### 6.5.2.5 Conversion from Component Extension 6.0 for SAP EHS Management

If you convert Risk Assessment from component extension 6.0 for SAP EHS Management to Health and Safety Management of Environment, Health, and Safety, carry out the following activities:

- Clear POWL caches according to SAP Note 1916079.
- If you have created customer roles, check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration, regenerate the corresponding authorization profiles.
- Run report `R_EHHSS_UPGRADE_JHA` to update job-based risk assessments after the conversion. This report initializes the location and the operational status by copying them from the risks that are assigned to the risk assessment.
- Run report `R_EHHSS_RAS_CASE_INSENS_SEARCH` after the conversion. The report fills a new column that contains the normalized text of the risk assessment title. This new column is used for searching risk assessment title case-insensitively. For more information see SAP Note 2224524. If you do not run this report, the search for risk assessment titles will not work for risk assessments created before the conversion.

**Note**
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2217208.
6.5.2.6  Conversion from EHS Management as part of SAP ERP

If you convert Industrial Hygiene and Safety (EHS-IHS) of EHS Management as part of SAP ERP to Health and Safety Management of Environment, Health, and Safety, carry out the following activities:

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  - All EHFN* and EHHSS* services
  - POWL
  - IBO_WDA_INBOX
  - WDR_CHIP_PAGE
- Also activate the following services
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5 and on the path /default_host/sap/public/bc/ui5_ui5.
- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for Environment, Health, and Safety under Foundation for EHS and under Health and Safety Management.
- Import the data that you have exported before the conversion into your SAP S/4HANA system and perform the necessary activities as described in the data migration information in SAP Note 2198406.

6.6  Product Safety and Stewardship

6.6.1  Activities After Converting Product Compliance

6.6.1.1  Conversion from Component Extension 3.0 for SAP EHS Management

If you convert Product Compliance from component extension 3.0 for SAP EHS Management to Product Compliance for Discrete Industries, carry out the following activities:

**General Follow-Up Activities**

- Note

  Verify the Customizing activities as described in the Installation Guide under Installation Follow-Up Activities -> Follow-Up Activities for Product Safety and Stewardship -> Follow-Up Activities for Product Compliance.

- Clear POWL caches according to SAP Note 1916079.
- Run the report R_EHPRC_REV_PROC_STATUS_INIT after the conversion. A new field processing status has been introduced in the ROOT node of the business object EHPRC_COMPILANCE_DATA: This report will update...
existing compliance data objects and fill the correct processing status value. Since the migration is client-dependent, you must execute the report in all clients that contain compliance data. Make sure that the user account that is used for executing the report has sufficient authorizations to modify compliance data. As the report can run into errors (for example, locking errors), we recommend that you run the report at a time when the system is not used by end users. The report can be re-executed any number of times and will try to migrate only those records which have not been migrated yet.

- Execute Customizing activity **Perform Automatic Workflow Customizing** under **Environment, Health and Safety > Foundation for EHS > Process Foundation > Basic Settings**.
- If you have created customer roles, you need to check if the provided template roles contain new menu entries needed to be integrated into your customer roles. After integration you will need to regenerate the corresponding authorization profiles.

**Follow-Up Activities for Simplified Import of Material Declarations**

*Product Compliance for Discrete Industries* contains a simplified **Import of Material Declarations**. With this import, you can import the IPC 1752-A Class C XML files in an alternative way. If you want to use the simplified **Import of Material Declarations** as the default import for IPC XML files, you have to remove the old **Template and Documents Customizing** for the template `IPC_XML_C` and replace them with the new **Template and Documents Customizing** for the new template `IPC_XML` that is covered by the BC sets.

- Carry out Customizing activity **Specify Outgoing and Incoming Templates**. The old template ID `IPC_XML_C` is no longer used, but you should not delete the template definition because the template name is still used for existing documents. As an option, you can change the name of the template. The new template `IPC_XML` from the BC set must be available.
- Carry out Customizing activity **Specify Incoming Templates**.
- To replace the old **IPC 1752-A Class C import** with the simplified **Import of Material Declarations**, you have to remove the old `IPC_XML_C` template from the incoming templates, including all entries in the substructure. The new template `IPC_XML` from the BC set must be available.
- Carry out Customizing activity **Specify Outgoing Templates**.
- New generated IPC XML files should also use the new template `IPC_XML`. Therefore you have to remove the old template `IPC_XML_C` from the outgoing templates. The new template `IPC_XML` from the BC set must be available and all values must be identical between the two templates before you remove the old template.
- Carry out Customizing activity **Define Templates for the Compliance Object**.
- To import the compliance documents in the **Compliance Workbench** with the simplified **Import for Material Declarations**, you have to remove the old document settings based on the template `IPC_XML_C` in the subdialog structures **Define Incoming Documents** and **Define Outgoing Documents**. The new document settings based on the new template `IPC_XML` from the BC set must be available and all values must be identical between the two documents before you remove the old document settings.
- Carry out Customizing activity **Specify Checks for Compliance Requirement and Check Criteria**.
- To import the compliance requirement revision documents in the **Compliance Workbench** with the simplified **Import for Material Declarations**, copy the settings for the old document settings based on the template `IPC_XML_C` in the subdialog structures **Define Incoming Documents** and **Define Outgoing Documents** to the new document settings of the template `IPC_XML` for all relevant compliance requirements. When the new document settings of the template `IPC_XML` exist, remove the old document settings based on the template `IPC_XML_C`. The new document settings based on the new template `IPC_XML` from the BC set or depending on manual entries must be available and all values must be identical between the two documents before you remove the old document settings. Only the document settings for the compliance requirements **ROHS**, **Conversion Guide for SAP S/4HANA, on-premise edition 1511**

Conversion Guide for SAP S/4HANA, on-premise edition 1511

Performing Follow-Up Activities

CUSTOMER

© Copyright 2016 SAP SE or an SAP affiliate company.

All rights reserved.
CHINA-ROHS, JIG and REACH_SVHC are available in the BC set. For all other compliance requirements, you have to create the settings manually.

6.6.1.2 Conversion from Component Extension 4.0 for SAP EHS Management

If you convert Product Compliance from component extension 4.0 for SAP EHS Management to Product Compliance for Discrete Industries, carry out the following activities:

General Follow-Up Activities

Note
Verify the Customizing activities as described in the Installation Guide under Installation Follow-Up Activities -> Follow-Up Activities for Product Safety and Stewardship -> Follow-Up Activities for Product Compliance.

- Clear POWL caches according to SAP Note 1916079.

Follow-Up Activities for Simplified Import of Material Declarations

Product Compliance for Discrete Industries contains a simplified Import of Material Declarations. With this import, you can import the IPC 1752-A Class C XML files in an alternative way. If you want to use the simplified Import of Material Declarations as the default import for IPC XML files, you have to remove the old Template and Documents Customizing for the template IPC.XML.C and replace them with the new Template and Documents Customizing for the new template IPC.XML that is covered by the BC sets.

- Carry out Customizing activity Specify Outgoing and Incoming Templates. The old template ID IPC.XML.C is no longer used, but you should not delete the template definition because the template name is still used for existing documents. As an option, you can change the name of the template. The new template IPC.XML from the BC set must be available.
- Carry out Customizing activity Specify Incoming Templates.
- To replace the old IPC 1752-A Class C import with the simplified Import of Material Declarations, you have to remove the old IPC.XML.C template from the incoming templates, including all entries in the substructure. The new template IPC.XML from the BC set must be available
- Carry out Customizing activity Specify Outgoing Templates.
- New generated IPC XML files should also use the new template IPC.XML. Therefore you have to remove the old template IPC.XML.C from the outgoing templates. The new template IPC.XML from the BC set must be available and all values must be identical between the two templates before you remove the old template.
- Carry out Customizing activity Define Templates for the Compliance Object.
- To import the compliance documents in the Compliance Workbench with the simplified Import for Material Declarations, you have to remove the old document settings based on the template IPC.XML.C in the subdialog structures Define Incoming Documents and Define Outgoing Documents.
The new document settings based on the new template `IPC_XML` from the BC set must be available and all values must be identical between the two documents before you remove the old document settings.

- Carry out Customizing activity **Specify Checks for Compliance Requirement and Check Criteria**.
- To import the compliance requirement revision documents in the Compliance Workbench with the simplified Import for Material Declarations, copy the settings for the old document settings based on the template `IPC_XML_C` in the sub dialog structures Define Incoming Documents and Define Outgoing Documents to the new document settings of the template `IPC_XML` for all relevant compliance requirements. When the new document settings of the template `IPC_XML` exist, remove the old document settings based on the template `IPC_XML_C`. The new document settings based on the new template `IPC_XML` from the BC set or depending on manual entries must be available and all values must be identical between the two documents before you remove the old document settings. Only the document settings for the compliance requirements `ROHS`, `CHINA-ROHS`, `JIG` and `REACH_SVHC` are available in the BC set. For all other compliance requirements, you have to create the settings manually.

### 6.6.1.3 Conversion from Component Extension 5.0 for SAP EHS Management

If you convert **Product Compliance** from component extension 5.0 for **SAP EHS Management** to **Product Safety and Stewardship**, carry out the following activities:

#### General Follow-Up Activities

**Note**

Verify the Customizing activities as described in the Installation Guide under Installation Follow-Up Activities -> Follow-Up Activities for Product Safety and Stewardship -> Follow-Up Activities for Product Compliance.

- Clear POWL caches according to SAP Note [1916079](https://support.sap.com/).

#### Follow-Up Activities for Simplified Import of Material Declarations

**Product Compliance for Discrete Industries** contains a simplified Import of Material Declarations. With this import, you can import the IPC 1752-A Class C XML files in an alternative way. If you want to use the simplified Import of Material Declarations as the default import for IPC XML files, you have to remove the old Template and Documents Customizing for the template `IPC_XML_C` and replace them with the new Template and Documents Customizing for the new template `IPC_XML` that is covered by the BC sets.

- Carry out Customizing activity **Specify Outgoing and Incoming Templates**. The old template ID `IPC_XML_C` is no longer used, but you should not delete the template definition because the template name is still used for existing documents. As an option, you can change the name of the template. The new template `IPC_XML` from the BC set must be available.
- Carry out Customizing activity **Specify Incoming Templates**.
To replace the old IPC 1752-A Class C import with the simplified Import of Material Declarations, you have to remove the old IPC_XML_C template from the incoming templates, including all entries in the sub structure. The new template IPC_XML from the BC set must be available.

- Carry out Customizing activity Specify Outgoing Templates.
- New generated IPC XML files should also use the new template IPC_XML. Therefore you have to remove the old template IPC_XML_C from the outgoing templates. The new template IPC_XML from the BC set must be available and all values must be identical between the two templates before you remove the old template.
- Carry out Customizing activity Define Templates for the Compliance Object.
- To import the compliance documents in the Compliance Workbench with the simplified Import of Material Declarations, you have to remove the old document settings based on the template IPC_XML_C in the sub dialog structures Define Incoming Documents and Define Outgoing Documents. The new document settings based on the new template IPC_XML from the BC set must be available and all values must be identical between the two documents before you remove the old document settings.
- Carry out Customizing activity Specify Checks for Compliance Requirement and Check Criteria.
- To import the compliance requirement revision documents in the Compliance Workbench with the simplified Import for Material Declarations, copy the settings for the old document settings based on the template IPC_XML_C in the sub dialog structures Define Incoming Documents and Define Outgoing Documents to the new document settings of the template IPC_XML for all relevant compliance requirements. When the new document settings of the template IPC_XML exist, remove the old document settings based on the template IPC_XML_C. The new document settings based on the new template IPC_XML from the BC set or depending on manual entries must be available and all values must be identical between the two documents before you remove the old document settings. Only the document settings for the compliance requirements ROHS, CHINA-ROHS, JIG and REACH_SVHC are available in the BC set. For all other compliance requirements, you have to create the settings manually.

### 6.6.1.4 Conversion from Component Extension 6.0 for SAP EHS Management

If you convert Product Compliance from component extension 6.0 for SAP EHS Management to Product Compliance for Discrete Industries, no further activities are required.

**Note**
Some functions are not available in the SAP S/4HANA on-premise edition. For more information, see SAP Note 2230140.

### 6.6.2 Activities After Converting Product Safety and Stewardship for Process Industries

Once you have converted from an SAP ERP system to an SAP S/4 Hana system, ensure that you have implemented the most recent versions of Expert / Open Content Connector (OCC) and Windows Wordprocessor Integration (WWI) in your system landscape.
For information regarding installation instructions for WWI and Expert / OCC, see SAP Note 568302.

6.7 Business Network Integration

SAP S/4HANA currently supports integration scenarios with the Ariba Network for purchase order and invoice collaboration.

6.7.1 Activities After Converting Ariba Network Integration

After converting from the SAP ERP add-on Ariba Network Integration for SAP Business Suite to SAP S/4HANA, you have to perform the activities described below:

Schedule Polling Agent

To transfer cXML messages from the Ariba Network to SAP S/4HANA, you have to schedule the Polling Agent (report ARBFND_FETCH_CXML_MESSAGES_NEW). Depending on which edition of SAP S/4HANA you are using, this report may not yet be available in your system. In this case, you have to implement SAP Note 2267601 first.

Perform Settings for Invoice Status Updates

To ensure that invoice status updates are transferred to the Ariba Network, perform the steps described below:

Define Basic Message Settings

After the conversion, the message types that you exchange with the Ariba Network are already listed in Customizing for Integration Component for Ariba Network under Framework Settings Define Basic Message Settings. However, the job for extracting invoice status updates from the SAP S/4HANA system is not yet automatically scheduled. To schedule it, perform the following manual steps for the object type BUS2081 and message type StatusUpdateRequest:

1. Deselect the Active checkbox, and save your settings.
2. Select the Active checkbox again, and save your settings.

Schedule Job for Supplier Invoice Output

Use the Schedule Supplier Invoice Jobs app to transfer invoice status update messages to the Ariba Network. In this app, select the job template Schedule Supplier Invoice Output.

Customize Output Management

With SAP S/4HANA, a new output management approach is in place. For the purchasing documents created in SAP S/4HANA, the new output management is used.
Purchasing documents that were created in SAP ERP and were already transferred to the Ariba Network before the conversion are still processed using the NAST-based output control. You can check the relevant settings in *Customizing for Integration Component for Ariba Network* under ‹*Application-Specific Settings* › *Define Message Output Control* › *Map Application and Output Type to cXML Message (For Converted Objects)*.

For purchasing documents that were created after the conversion, you have to customize the new output management. Under *Define Message Output Control*, the following subactivities are relevant:

1. *Define Business Rules for Output Determination*
2. *Map Application and Output Type to cXML Message (Output Management)*
3. *Activate Business Transaction Event to Trigger Invoice Status Message*

For detailed information, see the documentation that is available in *Customizing* for the activity *Define Message Output Control*. 
## Typographic Conventions

Table 62

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;Example&gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td><img src="Example" alt="Example" /> <img src="Example" alt="Example" /></td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td><img src="www.sap.com" alt="www.sap.com" /></td>
<td>Textual cross-references to an internet address</td>
</tr>
<tr>
<td><code>/example</code></td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td><img src="123456" alt="123456" /></td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>• Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options. • Cross-references to other documentation or published works</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>• Output on the screen following a user action, for example, messages • Source code or syntax quoted directly from a program • File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard</td>
</tr>
</tbody>
</table>